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Configuração de hardware 
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Objetivo:  Conectar seu sistema CompactDAQ ao PC. 

 Usar o Measurement & Automation Explorer para configurar seu hardware e verificar 
conexões. 

 Criar um dispositivo NI-DAQmx simulado (Opcional). 
 

Parte A Configuração e conexão de hardware 
Tempo estimado: 5 minutos 
 
O hardware para esse seminário inclui diversos módulos de medição para lhe 
proporcionar o melhor entendimento possível do valor das plataformas de aquisição de 
dados.  Hoje, você pode explorar a medição de temperatura, deformação, vibração, 
entrada digital e tensão analógica bem como a geração de tensão e saída digital. Para 
obter mais informações sobre os módulos que você vê no chassi ou para saber mais 
sobre o CompactDAQ, acesse ni.com/compactdaq. 
 

1. Antes de iniciar os exercícios a seguir, confira se seu chassi está conectado ao 
seu PC via cabo USB e se o PC e o chassi CompactDAQ têm fonte de 
alimentação. As luzes do LED Power e LED Ready, verde e amarela 
respectivamente, devem estar acesas antes de você configurar seu chassi no 
software.   
  

2. Reserve um tempo para verificar as conexões na demo box.  Confira se todos os 
módulos estão bem encaixados no chassi. Além disso, se quaisquer fios 
estiverem soltos ou parecer que há algo danificado ou faltando, informe seu 
instrutor. 

 
3. Após confirmar que tudo está conectado e ligado, prossiga para parte B. 

 
 

Parte B Configuração do software 
Tempo estimado: 20 minutos 
 
De maneira similar ao Windows Device Manager, que gerencia todos os periféricos 
conectados a um PC Windows, o MAX gerencia todos os dispositivos de hardware e 
software da National Instruments. Essa aplicação é instalada com a maior parte dos 
pacotes de software da NI. Neste exercício, você observará a maioria dos recursos 
utilizados do MAX incluindo software, dispositivos e interfaces. 
 
Observação: Você pode acessar dois sistemas no MAX: o hardware e o software 
instalados localmente no My System e Remote Systems, que contêm todos os targets 
remotos detectados na sua rede, como o hardware NI CompactRIO ou sistema PXI de 
tempo real.  Hoje, você trabalhará apenas com o PC local e o chassi USB, então tudo 
estará no My System. 
 

1. Quando seu hardware estiver conectado e ligado, abra o MAX clicando duas 
vezes no ícone no desktop ou navegando para Start » All Programs » National 
Instruments » Measurement & Automation Explorer. 
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2. Após a inicialização do MAX, expanda o My System » Devices and Interfaces.  
Você deve conseguir ver qualquer hardware acoplado a sua máquina local: 

 

 
Figura 1. Expanda o menu drop down do chassi para exibir os módulos 

acoplados. 
 
Dentro do MAX, você pode confirmar se seu hardware está conectado 
adequadamente, verificar as conexões externas, renomear seus arquivos e até 
mesmo simular dispositivos para desenvolver seu código sem o hardware 
acoplado.    
 

3. Além do hardware, você pode ver todo o software instalado na máquina 
expandindo o My System » Software.  Aqui você pode verificar as versões do 
software e do driver: 
 

 
Figura 2. Verifique se os drivers e software corretos estão instalados expandindo 

a seção do sotware no MAX. 
 
Sob a seção do software, você deve observar que o LabVIEW e o NI-DAQmx 
estão instalados - o NI-DAQmx é o driver que permite que seu PC se comunique 
com seu hardware, e o LabVIEW é o ambiente de programação gráfica que você 
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usará para programar durante os exercícios de hoje. 
 

4. Agora que você navegou e entende os conceitos básicos do MAX, você pode 
testar a conectividade do chassi CompactDAQ. Clique com o botão direito no 
chassi sob a seção Devices and Interfaces e selecione Self-Test.  
 

 
Figura 3. O Autoteste é um utilitário básico para verificar a conectividade com 

seu hardware. 
 
Se seu chassi estiver conectado adequadamente e puder se comunicar com seu 
PC, você verá a seguinte caixa de diálogo: 
 

 
 

Fazer o autoteste do chassi é sempre um bom primeiro passo após instalar seu 
hardware ou software.   
 

5. Para verificar as conexões do chassi NI CompactDAQ, você usará os painéis de 
teste NI-DAQmx. Como exemplo, verificaremos a conectividade de sinais do 
módulo termopar NI 9213.   
 

a. Clique com o botão direito no NI 9213 e selecione Test Panels…: 
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Figura 4. Os painéis de teste permitem que você verifique as conexões sem 

escrever nenhum código. 
 

b. Selecionar os painéis de teste exibe um utilitário simples para verificar os 
sinais em cada um dos canais do módulo. Quando você clicar em Start, 
deve ser exibida a seguinte tela para o painel de teste do módulo NI 9213: 
 

 
Figura 5. O painel de teste do módulo NI 9213 permite que você leia os sinais 

em cada um dos canais do dispositivo.  Os valores de CJC e escala são incluídos 
para simplificar o teste. 

 
c. Segure a ponta do termopar e observe que a temperatura aumenta. 

 
d. Reserve um tempo para praticar com esses painéis de teste e outros 

módulos no chassi. Observe que os painéis de teste são um pouco 
diferentes, cada um oferece as entradas para as medições suportadas 
pelo módulo. 
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e. Quando concluir, feche qualquer janela do painel de teste que estiver 
aberta selecionando Close. 

 
6. Para muitas aplicações, apenas usar o nome padrão atribuído não é suficiente.  

Dentro do MAX, você pode renomear com facilidade seus módulos para que 
correspondam ao tipo do módulo ou medição.  
 

a. Para renomear o módulo, clique com o botão direito nele e selecione 
Rename. 

 
Figura 6. Selecione Rename para adicionar novos nomes descritivos. 

 
b. Renomeie cada um dos tipos de canais com nomes descritivos. 

 
c. Use os seguintes nomes descritivos para identificar seus módulos: 

 

 
 

Parte C Crie um dispositivo simulado (Opcional) 
Tempo estimado: 10 minutos 
 
Ao desenvolver sua aplicação de aquisição de dados, muitas vezes você pode não ter 
acesso imediato ao hardware nos estágios iniciais de escrita do software. Para situações 
como essa você pode criar dispositivos simulados no MAX.  
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1. Para criar um dispositivo simulado, clique com o botão direito em Devices and 

Interfaces e selecione Create New….  
 

 
Figura 1. Criar um dispositivo simulado permite que você avalie um dispositivo 

sem ter o hardware real em mãos. 
 

2. Quando a tela ‘Create New…’ for inicializada, selecione Simulated NI-DAQmx 
Device or Modular Instrument e clique em Finish.  
 

 
Figura 2. Dentro do MAX, você pode simular qualquer dispositivo NI-DAQmx e 

muitos instrumentos modulares.  
 

3. Para esse exercício, selecione NI cDAQ-9174.  Essa é uma versão do chassi 
CompactDAQ de 4 slots que você irá utilizar para os exercícios nesta apostila. 
Clique em OK para adicionar um dispositivo simulado. 
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Figura 3. O NI cDAQ-9174 é apenas umas das várias opções de dispositivos 

simulados. 
 

4. O novo chassi simulado será exibido sob Devices and Interfaces da mesma 
forma que os dispositivos reais conectados ao sistema, mas estarão coloridos 
em amarelo.  Veja que os módulos não estão incluídos. Para adicionar módulos 
ao chassi, selecione Configure Simulated cDAQ Chassis… 
 

 
Figura 4. O NI cDAQ-9174 simulado é exibido sob Devices and Interfaces da 

mesma forma que um dispositivo real, mas o símbolo é amarelo. 
 

5. Para 1 slot, selecione o módulo NI 9201 – esse é um módulo com entrada de 
tensão de 12 bits que não está incluído em seu chassi. Clique em OK para 
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adicionar um módulo ao chassi.  
 

 
Figura 5. O NI 9201 é um módulo básico de entrada de tensão, mas você pode 

configurar seu chassi simulado para qualquer módulo que o NI cDAQ-9174 
suportar. 

 
6. Quando o módulo estiver adicionado ao chassi simulado, você pode executar 

ações da mesma forma que em um dispositivo real. Para ver uma ilustração, 
clique com o botão direito no NI 9201 e selecione Test Panels… 
 

 
Figure 6. Selecione Test Panels… para obter as medições do seu dispositivo 

simulado. 
 

7. Quando o painel de teste do dispositivo simulado aparecer, clique em Start para 
começar a visualizar os dados simulados. Observe que os dados são uma forma 
de onda senoidal simples.  É importante observar que essa configuração de 
dados é criada no driver NI-DAQmx e na verdade não constitui dados reais; no 
entanto, você pode interagir exatamente da mesma forma que interagiria com 
dados reais.  Por exemplo, você poderia escrever um código para analisar os 
valores mínimo e máximo e escrever esses valores em um arquivo de planilha.  
 



ni.com/daq  12 

 
Figura 7. Os dados exibidos no painel de teste do dispositivo simulado são uma 

forma de onda senoidal simples que está incluída no driver NI-DAQmx. 
 

8. Feche qualquer janela aberta do painel de teste selecionando Close. 
 

9. Exclua o dispositivo simulado clicando no NI cDAQ-9174 e selecionando Delete 
no menu de contexto. 

 

 
Figura 8. Remova o dispositivo simulado do sistema. 

 
 

<Fim do exercício> 



Explore o Example Finder 
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Objetivo:  Familiarizar-se com os exemplos do NI-DAQmx. 

 Executar um programa de exemplo pré-criado para adquirir sua primeira 
medição. 
 

Parte A Abra o LabVIEW e explore o Example Finder 
Tempo estimado: 10 minutos 
 
Instalado com o NI-DAQmx, os exemplos do NI-DAQmx oferecem um ponto de partida 
de uso comprovado para criar aplicações de aquisição de dados.  Com esse programa 
de exemplo, você pode eliminar diversas fontes de erros e economizar tempo utilizando 
o código existente.  
 

1. Para acessar os exemplos, abra o LabVIEW navegando em Start » All Programs 
» National Instruments » LabVIEW 2014.  Ao inicializar, você verá a seguinte tela 
de inicialização: 
 

 
Figura 1. A tela de inicialização do LabVIEW oferece diversos caminhos para 

aprendizagem, suporte e desenvolvimento. 
 

2. A tela de abertura oferece caminhos para desenvolver o código, chamar 
novamente programas abertos anteriormente e localizar recursos de ajuda ou 
suporte.  
 

a. Create Project – Selecionar Create Project inicializará uma tela com três 
opções para criar um novo código a partir de exemplos e templates de 
projetos existentes.   Arquiteturas de código, como a Máquina de 
Estados e Actor Framework, estão incluídas nos templates e você pode 
organizar e executar rapidamente criando-as a partir desta caixa de 
diálogo. Os exemplos de projetos são códigos prontos para serem 
executados usando as melhores práticas para desenvolvimento 
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escalável.  Utilizando os exemplos e templates de projetos, você nunca 
precisará iniciar do zero a aplicação do LabVIEW. 

 
Figura 2. Os templates e exemplos de projetos podem ajudá-lo a criar aplicações 

escaláveis mais rápido com um código e técnicas de uso comprovado. 
 

b. Open Existing – Como hoje você trabalha com programas, você pode 
recuperar rapidamente os projetos com os quais você trabalhou dentro 
da seção Open Existing, bastando clicar no botão Open Existing para 
navegar no seu código.  
 

c. Find Drivers and Add-ons – Para a maioria dos dispositivos de hardware 
conectados ao seu PC, você precisará usar um driver de hardware.  Hoje, 
usaremos o CompactDAQ, que utiliza o driver NI-DAQmx.  Esse mesmo 
driver funciona para centenas de dispositivos de aquisição de dados, 
permitindo que você reutilize o código de dispositivo a dispositivo e de 
aplicação a aplicação. 

 
d. Comunidade e Suporte – Para aqueles momentos em que você tiver 

dúvidas, a NI tem uma comunidade ativa de desenvolvedores de 
LabVIEW e especialistas em aquisição de dados.  Os fóruns são um 
recurso de suporte gratuito que é monitorado por usuários e engenheiros 
de aplicação da NI para garantir que você tenha o suporte que precisa.  
Para ter um suporte mais imediato, você pode entrar em contato ou 
enviar um e-mail diretamente para os engenheiros de aplicação da NI 
como um dos muitos benefícios do programa padrão de serviços do 
LabVIEW (SSP). 

 
e. Welcome to LabVIEW – Após a atividade de hoje, você ficará 

familiarizado com o uso do ambiente LabVIEW. Para ir além das tarefas 
simples de programação e acessar treinamentos de proficiência mais 
detalhados, consulte os recursos de suporte e treinamento no link 
Welcome to LabVIEW. 
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3. Hoje, usaremos diversos exemplos como ponto de partida para nosso código. 

Para abrir o diretório de exemplos do NI-DAQmx, selecione Help » Find 
Examples na tela Getting Started do LabVIEW.   
 

4. Quando o NI Example Finder inicializar, navegue até Hardware Input and Output 
» DAQmx. 

5. Navegue no diretório DAQmx e leia alguns dos recursos dos exemplos. Cada 
exemplo tem um nome descritivo, mas você pode encontrar mais recursos do 
programa lendo a seção de descrições e informações.  

 
Figura 3. O NI Example Finder é uma ferramenta útil para navegar nos exemplos 

instalados da NI. 
 
Cada seção do diretório inclui exemplos para executar determinadas tarefas. Por 
exemplo, a entrada analógica inclui exemplos para medição de tensão simples, 
corrente, deformação e temperatura, ao passo que a seção da saída analógica 
inclui exemplos para controlar a tensão ou a corrente.  
 

Parte B Execute um exemplo pré-criado  
Tempo estimado: 10 minutos 
 
Agora que você está familiarizado com os diferentes tipos de medição oferecidos pelos 
exemplos do NI-DAQmx, você pode abrir e executar diversas medições que usam 
alguns dos dispositivos de hardware do seu kit prático. Começaremos com uma 
medição de tensão simples.  
 

1. No NI Example Finder, navegue até Hardware Input and Output » DAQmx » 
Analog Input e clique duas vezes no Voltage – Continuous Input.vi. Isso 
inicializará um VI para medir continuamente um canal de tensão. 
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2. Quando o VI inicializar, o painel frontal será exibido. Essa é a interface de usuário 

e inclui controles e indicadores para interagir com seu código. Neste exemplo 
em particular, observe as caixas de controle para selecionar o canal, as faixas de 
tensão de entrada, os parâmetros de temporização e o local de registro. Além 
disso, o painel frontal inclui um indicador gráfico para visualização instantânea 
dos dados nos canais de tensão.  

 
Figura 4. O painel frontal é a interface de usuário e contém controles e 

indicadores para interagir com seu código do LabVIEW. 
 

3. Para visualizar o código desse painel frontal, selecione Window » Show Block 
Diagram ou seu o atalho do teclado <Ctrl+E>.  
 

4. Expanda a janela do diagrama de blocos para que você possa ver mais do código 
fonte.  
 
Você verá uma série de VIs usados para programar seu dispositivo de aquisição 
de dados para adquirir um sinal de tensão.  O LabVIEW usa um fluxo de dados 
para passar informações pelos fios para os VIs. Esse paradigma de programação 
permite que você programe melhor aquilo que tem em mente. 
 

 
Figura 5. O LabVIEW usa uma linguagem de programação gráfica e passa os 

dados através do código pelos fios que conectam os nós.  
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5. O diagrama de blocos é organizado nas seções a seguir: 
 

1. Configurações de canais – Nesta seção, o VI DAQmx Create Channel  
configura o canal no dispositivo de aquisição de dados que você pretende 
usar.  Neste exemplo, você pode configurar a faixa do dispositivo e a 
configuração do terminal (single ended ou diferencial).  
 

2. Configurações de temporização – Na seção Timing Settings, o VI DAQmx 
Timing  é usado para configurar o clock de amostragem no dispositivo 
DAQ. Usando esse VI, você pode configurar a taxa de amostragem, fonte 
do clock de amostragem e o modo de amostragem que você pretende 
usar.  Neste exemplo, as configurações padrão usam o clock on-board 
para amostrar continuamente a 1000 Hz. 

 
3. Configurações de registro – O VI DAQmx Configure Logging  é usado 

para configurar o local do arquivo de dados registrados bem como o 
modo de registro.   

 
4. Aquisição de Dados – Nesta seção, o VI DAQmx Read  é chamado dentro 

de um loop While, permitindo que esse código adquira dados 
continuamente a partir de um dispositivo de aquisição de dados até que o 
botão Stop seja pressionado.  

 
A maioria das aplicações de aquisição de dados seguirá esse fluxo  –  

 
Figura 6. Os VIs mais comuns para cada seção estão ilustrados na figura acima. 

 
6. Compare o diagrama de blocos do programa de exemplo ao VI ilustrado na figura 

6. Se você abrir os programas de exemplo do DAQmx, observe que a maioria 
segue exatamente esse fluxo.  
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7. Para obter mais informações sobre os elementos no seu diagrama de blocos e 

painel frontal, pressione <Ctrl+H> para exibir a janela Context Help. Ao colocar o 
cursor do mouse sobre os elementos no seu código, você pode ver uma breve 
descrição e as entradas e saídas de cada VI. Os rótulos das entradas requeridas 
são exibidos em negrito na janela Context Help. Para ver descrições mais 
detalhadas, você pode pressionar o link Detailed help. Tente colocar o mouse 
sobre alguns elementos em seu diagrama de blocos. 
 

 
Figura 7. A janela Context Help pode fornecer uma breve descrição dos 

elementos no seu painel frontal ou diagrama de blocos. 
 

8. Agora que você está familiarizado com essas partes de um programa básico, 
você está pronto para adquirir dados usando esse exemplo.  Para fazer isso, 
volte ao painel frontal selecionando Window » Show Front Panel ou 
pressionando <Ctrl+E>. 
 

9. Altere o Physical Channel para Voltage_in/ai0.  
 



ni.com/daq  20 

 
Figura 8. Use os controles no painel frontal para selecionar o canal, as 

configurações de temporização e de registro. 
 

10. Altere o controle Sample Rate para 10000 e pressione a seta de execução ( ) 
para começar a adquirir dados.  
 
Como seu sinal está conectado ao sensor de luz no quadro, você verá a saída do 
sensor de luz.  Esse sinal apresentará alguns ruídos das fontes na sala, mas você 
deve poder ver os efeitos de colocar suas mãos sobre o sensor. Você está 
fazendo uma amostragem de sinal com ruído na sala a 10 kHz - o que poderia 
ser fontes de ruído na sala ao seu redor? O que você poderia fazer para obter 
uma melhor ideia do que está acontecendo ao sinal de interesse?   
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Figura 9. Com esse programa, você está fazendo uma amostragem de um canal 

a 10 kHz. Durante esse seminário, você irá modificar e customizar alguns 
exemplos para executar várias tarefas. 

 
11. Clique em Stop para parar a aquisição de dados.  

 
12. Feche o programa sem salvar nada. 

 
  



ni.com/daq  22 

Parte C  Experimento com outros programas de exemplo (Opcional) 
Tempo estimado: 10 minutos 
 
Tente explorar outros programas de exemplo.  Os exemplos que podem ser importantes 
observar incluem:  

1. Analog Input / Thermocouple - Continuous Input.vi 
Observação:  

 Selecione Temperature/ai0 no controle Physical Channel. 
 

2. Analog Input / Strain - Continuous Input.vi  
Observação:  

 Selecione Strain/ai0 no controle Physical Channel. 
 Selecione Quarter Bridge I no controle Strain Configuration. 

 Use 3.3 como valor da tensão de excitação. 
 

3. Digital Input / Digital -  Continuous Output.vi 
Observação:  

 Selecione Digital_out/port0/line0:7 no controle das Linha(s). 
 Selecione OnboardClock no controle Sample Clock Source. 

 
4. Analog Output / Voltage (non-regeneration) - Continuous Output.vi 

Observação:  

 Selecione Voltage_out/ao1 no controle Physical Channel(s). 

 Selecione 1.00 no controle Waveform Settings Frequency. 
 Selecione 3.00 no controle Waveform Settings Amplitude. 
 Verifique se você alterou a chave do controle Fan Speed no Sound and 

Vibration Signal Simulator na sua demo box para BNC.  
 

 Se a ventoinha continuar a operar após a interrupção do programa de 
exemplo, navegue até o MAX e reinicie o NI 9263 clicando com o botão 
direito em Voltage_out e escolhendo Reset Device.  

 

 
Figura 10. Você pode reiniciar qualquer dispositivo de hardware para seu estado 

padrão no MAX. 
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<Fim do exercício>



Medição de Temperatura e Data Logging 
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Objetivo:  O primeiro objetivo é adquirir rapidamente um conjunto de dados de temperatura 
usando o DAQ Assistant. 

 O segundo objetivo é fazer uma análise nos dados e apresentar um sinal de alerta 
digital se a temperatura estiver acima de um nível de alerta ajustável. 
 

Parte A A parte A permite que você veja o que você fará na aplicação final desse exercício. Você 
também importará importantes elementos do ambiente LabVIEW. 
 

1. Se o LabVIEW não foi inicializado ainda, inicialize-o agora. Clique na aplicação do 
LabVIEW após navegar para Start » All Programs » National Instruments » 
LabVIEW 2014. Após iniciar o LabVIEW, aparecerá a janela Getting Started: 
 

 
Figura 1. A tela de inicialização do LabVIEW oferece diversos caminhos para 

aprendizagem, suporte e desenvolvimento. 

A janela Getting Started aparece cada vez que você inicializa o LabVIEW para ajudá-lo a 
criar novas aplicações ou abrir aplicações existentes. Além disso, você pode usar os links 
na janela Getting Started para localizar recursos de ajuda local e online ou abrir programas 
de exemplo para ter auxílio no projeto da aplicação. 
 

2. Selecione o Open Existing para abrir um projeto existente. 
3. Navegue para C:\Seminars\LV HO\Exercises\3 - Temperature e selecione o projeto 

Temperature.lvproj.  Quando o projeto estiver aberto, aparecerá a janela Project 
Explorer semelhante a essa: 



ni.com/daq  26 

 
Figura 2. O projeto do LabVIEW é uma ótima forma de organizar todas as dependências 

em sua aplicação. 
 
O Project Explorer oferece um local central para você incluir os diferentes elementos de 
uma aplicação incluindo o código do LabVIEW e outros arquivos como os documentos do 
Microsoft Word e Excel. Você pode incluir qualquer arquivo em uma aplicação do 
LabVIEW. Você pode criar pastas e subpastas para organizar os arquivos em uma 
aplicação. Aqui, algumas pastas foram criadas como parte do exemplo. 
 

4. Expanda a pasta Solutions no Project Explorer e abra o VI 5 - Write to File (Solution) 
clicando duas vezes nele ou clicando com o botão direito e selecionando Open.  
Cada aplicação do LabVIEW é feita no painel frontal e no diagrama de blocos. O 
painel frontal é a interface de usuário, ao passo que o diagrama de blocos contém 
o código que controla a funcionalidade da sua aplicação. Você pode alternar entre 
duas janelas selecionando Window » Show Block Diagram ou Window » Show 
Front Panel para ver a outra janela. Você também pode alternar entre as janelas 
pressionando <Ctrl+E> no teclado ou clicando em uma das janelas se elas 
aparecerem em seu monitor. 

 
Figura 3. O painel frontal da aplicação é a interface de usuário. 

 
Coloque o cursor sobre os diferentes objetos no painel frontal. Observe que o cursor se 
transforma em uma mãozinha quando está em cima do botão Stop e se tranforma em um 
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editor de texto quando está em cima de um campo de texto. Por padrão, a seleção 
automática de ferramenta do LabVIEW irá alterar o cursor dependendo de quais operações 
forem possíveis. Além disso, observe que conforme você passa o cursor sobre qualquer 
objeto, aparecem caixas de redimensionamento em suas bordas. Tente redimensionar o 
tamanho de alguns objetos. 
 

 
 

5. Veja a barra de menu na parte superior da janela. Discutiremos muitos de seus 
itens básicos nas páginas e exercícios mais adiante. Por enquanto, o botão mais 
importante para revisar é o botão de execução localizado na borda esquerda da 
barra de menu. 
 

 
Figura 4. Uma seta de execução quebrada (à esquerda) indica que há um erro de 

compilação na aplicação. 
 

Ao pressionar o botão de execução para inciar a aplicação do LabVIEW, se aparecer uma 
seta de execução quebrada ela estará lhe informando que há alguns erros não 
solucionados no código. Você pode pressionar a seta de execução quebrada a qualquer 
momento e aparecerá uma lista dos erros atuais. 
 

6. Verifique se seu chassi CompactDAQ está conectado ao seu PC via cabo USB e se 
os módulos estão conectados ao chassi. Agora pressione o botão de execução na 
aplicação do LabVIEW e observe a aplicação começar a gravar os dados de 
temperatura através do módulo conectado no primeiro slot do chassi 
CompactDAQ. Informe o instrutor se sua aplicação não estiver sendo executada da 
forma descrita. 
 

7. Segure o termopar e observe os valores subirem e descerem no gráfico de acordo 
com a temperatura. Altere o controle Alarm Level para valores diferentes e segure 
o termopar para que ele aumente e diminua o valor que você inseriu no painel 
frontal. 

 
Conforme a temperatura eleva e cai no Alarm Level, observe o módulo NI 9472 no chassi 
CompactDAQ. Uma linha da saída digital neste módulo foi programada para ter um sinal 
de 5V sempre que a temperatura for maior do que o valor do Alarm Level. Os LEDs do 
módulo indicam o status de cada linha digital. Essas linhas podem ser conectadas a outro 
hardware, como um alarme, luz ou outro dispositivo de 5V. 
 

8. Clique no botão Stop no painel frontal quando você estiver pronto para continuar. 
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9. Navegue para o diagrama de blocos selecionando Window » Show Block Diagram. 

 
Figura 5. O diagrama de blocos é o código fonte de uma aplicação. 

 
A programação gráfica do LabVIEW usa um fluxo de dados para controlar o fluxo da 
aplicação.  Nesse caso, nossa aplicação faz o seguinte: 
 

1. Adquire dados de temperatura com o DAQ Assistant e os exibe em um gráfico. 
2. Compara os dados adquiridos com o Alarm Level. 
3. Apresenta 0 V ou 5 V para o módulo de saída digital baseado na comparação do 

item 2. 
4. Escreve os dados adquiridos em um arquivo. 

 
10. Divida as janelas do painel frontal e diagrama de blocos para que as duas estejam 

visíveis em seu monitor. Navegue para Window » Tile Left and Right para organizar 
as janelas do painel frontal e diagrama de blocos em seu monitor ou pressione 
<Ctrl+T>. 
 

Veja que para cada objeto no painel frontal, existe um terminal com o mesmo nome no 
diagrama de blocos. As funções e fios no diagrama de blocos conectam as entradas 
("controles") e saídas ("indicadores") no painel frontal. Conforme você adicionar objetos no 
painel frontal nos exercícios mais adiante, observará que os terminais são criados 
automaticamente no diagrama de blocos. 
 
Passos Adicionais 

11. O sistema de ajuda do LabVIEW é uma ótima forma de aprender sobre o LabVIEW 
e responder as suas dúvidas de programação. Pressione <F1> no teclado para 
iniciar o sistema de ajuda. Você pode ter mais assistência no menu LabVIEW » 
Help. 

12. Dentro do sistema de ajuda do LabVIEW, expanda a janela Fundamentals » 
LabVIEW Environment e explore as informações disponíveis.  Fique à vontade para 
explorar e ver um conteúdo mais detalhado e como ele é organizado. 
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Figura 6. O help do LabVIEW é um recurso completo para criar aplicações. 
 

13. Reserve alguns minutos para explorar outros tópicos no sistema de ajuda.  

14. Clique na guia Search e tente localizar funções de análise para recursos que você 
talvez precise em suas aplicações. 

 

Parte B Esse exercício revisará os conceitos básicos do ambiente LabVIEW que você aprendeu até 
aqui. Você criará uma aplicação que simula um sinal dentro do LabVIEW e exibe esse sinal 
em um gráfico 
 
Seu projeto Temperature deve estar aberto e você trabalhará com ele nos próximos 
exercícios. 
 

1. Abra um VI em branco no Project Explorer Temperature clicando com botão direito 
do mouse na pasta de exercícios e selecionando New » VI.  

 
Figura 1. Você pode criar um novo VI diretamente de dentro de um projeto. 
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2. Pressione <Ctrl+T> para organizar as janelas do diagrama de blocos e do painel 

frontal. 

 
Figura 2. Muitas vezes ajuda muito visualizar a interface de usuário e o código fonte lado a 

lado. 
 

3. Salve esse VI na pasta \LV HO\Exercises\3 – Temperature\Exercises selecionando 
File » Save e nomeando-o 2 - Simulate Signal to Graph.vi.   

4. Clique com o botão direito do mouse um espaço vazio no diagrama de blocos para 
exibir a paleta Functions e, em seguida, navegue para Programming » Structures » 
While Loop. Clique com o botão esquerdo do mouse no loop While e ele será 
colocado automaticamente no seu cursor.  Lembre-se de que sua paleta pode não 
se assemelhar exatamente à figura abaixo.  

 
Figura 3. A paleta Functions é um organização hierárquica das funções do LabVIEW. 
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Clique e depois arraste diagonalmente para formar o loop While na área de interesse. Você 
pode redimensionar o loop While arrastando qualquer uma das caixas de 
redimensionamento que aparecer quando seu cursor for colocado sobre a borda do loop. 
 

1. Você também pode criar um loop While pressionando <Ctrl+Space> para exibir a 
caixa de diálogo Quick Drop. Comece a digitar 'While Loop' e aparecerá a lista de 
objetos possíveis. Clique duas vezes no nome e ele aparecerá no seu cursor para 
ser usado no diagrama de blocos.  Se você já tiver colocado o loop While, solte o 
loop While que você localizou usando a caixa de diálogo Quick Drop clicando com o 
botão direito para cancelar a operação. 
 

 
Figura 4. Se você souber o nome do que você está procurando, não há maneira mais 

rápida para programar do que usando a caixa de diálogo Quick Drop. 
 

5. Os loops While têm dois terminais em sua parte inferior e nos cantos direitos.  

 
Figura 5. Observe os dois terminais no loop While padrão do LabVIEW. 

 
O mais importante dos dois é a condição do loop. O terminal condicional está ao lado 
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direito inferior e, por padrão, se assemelha a um sinal de interrupção. Quando os loops 
While são executados até que sejam interrompidos, devemos aplicar um comando de 
interrupção (Booleano) para que o loop não seja executado indeterminadamente.  

Observe a seta de execução quebrada ( ) no canto superior esquerdo da tela. O 
LabVIEW não pode executar uma aplicação que contém um loop While com um terminal 
condicional desconectado. Para nossa aplicação, precisamos criar um botão Stop que o 
usuário irá pressionar para interromper o loop While e sair do programa. 
 

6. No painel frontal, clique com o botão direito em qualquer espaço vazio para exibir a 
paleta Controls e navegar até Silver » Boolean » Stop Button. Clique com o botão 
esquerdo e ele será colocado automaticamente em seu cursor. 

 

 
Figura 6. O LabVIEW contém dezenas de elementos de interface de usuário específicos 

para engenharia. 
 

7. Clique com o botão esquerdo onde você gostaria de colocar o botão no painel 
frontal. Se você preferir, amplie o botão Stop movendo seu cursor para uma das 
bordas do botão e arrastando e redimensionando as caixas.  

 
8. Veja novamente o diagrama de blocos. Observe que um terminal para o botão Stop 

desapareceu. Esse terminal funciona como o conector do painel frontal para a 
função do diagrama de blocos. Clique no terminal do botão Stop e arraste-o para o 

lado do terminal de condição do loop ( ) no loop While. 
 

9. Mova seu cursor para a borda direita do terminal do botão Stop e veja que a borda 
do terminal está piscando e agora o cursor se parece com uma bobina. Essa é a 
ferramenta de conexão que permite que você desenhe fios entre diferentes 
objetos no diagrama de blocos.  
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10. Clique com o botão direito na borda direita do terminal do botão Stop. 

 
11. Clique com o botão esquerdo na borda esquerda do terminal de condição do loop 

While. 

 
Figura 7. O fio transporta os dados entre o botão e o terminal condicional. 

 

Havendo agora uma forma de fechar o loop While, a seta de execução quebrada ( ) é 

substituída por uma seta de execução ( ). Sua aplicação está pronta para ser executada, 
mas você precisará adicionar mais códigos para concluir as tarefas desse exercício.  

O outro terminal no loop While, o contador de iteração do loop ( ), apresenta a 
quantidade de vezes que o loop While iterou. Essa informação pode ser útil dependendo 
da sua aplicação, mas não a usaremos hoje; não é necessário que façamos nada com ela 
para podermos executar nosso programa. 

 
12. Pressione <Ctrl+Space> para exibir a caixa de diálogo Quick Drop e comece a 

digitar 'Simulate Signal'. Clique duas vezes em Simulate Signal quando você vir a 
caixa de diálogo Quick Drop e automaticamente aparecerá o VI Expresso Signal  no 
seu cursor. 
 

 
Figura 8. A caixa de diálogo Quick Drop pré-indexa todas as funções do LabVIEW para 

uma busca rápida. 
 

13. Clique com o botão esquerdo para colocar o VI Expresso Simulate Signal dentro do 
loop While e sua caixa de configuração aparecerá automaticamente. 
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Figura 9. Todos os VIs Expressos do LabVIEW têm caixas de diálogo de configuração de 

fácil utilização. 
 

14. Tente alterar os valores de fase, tipo de sinal, amplitude, frequência e offset na 
parte Signal da caixa de diálogo e veja as alterações na parte Results Preview.  
 

15. Desfaça a seleção do quadro Use signal type name na seção Signal Name e insira 
Simulated Signal como o nome. 
 

16. Após escolher o sinal que você quer exibir, pressione OK. Agora o VI Expresso 
Simulate Signal foi customizado com base nas configurações que você forneceu. 

 
17. Alterne para o painel frontal e use <Ctrl+Space> para inicializar o Quick Drop. 

 
18. Digite a palavra chart.  Clique duas vezes no controle Waveform Chart (Silver).   

 
19. Coloque o controle Waveform Chart (Silver) no painel frontal em qualquer local que 

você quiser.  
 

20. Volte ao diagrama de blocos e mova o ícone do gráfico para o loop While (se ele 
ainda não estiver lá) para a direita do VI Expresso Simulate Signal.  
 

21. Use um fio para conectar a saída do VI Expresso Simulate Signal (“Simulated 
Signal”) à entrada do terminal Waveform Chart. Observe que o terminal do gráfico 
mudou de cor para refletir o tipo de dados recebido. 
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Figura 10. O VI Simulated Signal será exibido no Waveform Chart durante cada iteração do 

loop While. 
 

22. Retorne ao painel frontal e execute o VI pressionando a seta de execução ( ). O 
sinal simulado que você criou no VI Expresso está exibido agora no gráfico. Clique 
no botão Stop quando você estiver pronto para continuar. 
 

23. Clique com o botão direito em um espaço vazio no painel frontal para exibir a paleta 
Controls, localize o controle knob (Silver » Numeric » Knob (Silver)) e coloque-o no 
painel frontal. Clique duas vezes no rótulo do botão e altere-o para Amplitude. 
 

24. Repita o passo 23 para fazer outro botão. Altere seu rótulo para Frequency. Clique 
duas vezes no valor máximo na escala de frequência (padrão = 10) e altere-a para 
50. 
 

 
Figura 11. Painel frontal com controles para amplitude e frequência do sinal. 

 
25. No diagrama de blocos, mova os controles Amplitude e Frequency para dentro do 

loop While. 
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26.  Coloque o cursor do mouse sobre o lado direito dos terminais Amplitude e 
Frequency até que a ferramenta de conexão apareça no cursor.  Clique com o 
botão esquerdo e arraste a conexão para a entrada com o mesmo nome no VI 
Expresso Simulate Signal. Seu diagrama de blocos deve ser semelhante ao da 
imagem abaixo. 

 
Figura 12. Agora você pode alterar programaticamente a frequência e amplitude. 
 

27. Clique na seta de execução manipule os botões Amplitude e Frequency observe 
que a exibição do gráfico é modificada de acordo. O eixo Y do gráfico é escalado 
automaticamente para maximizar o tamanho do sinal na exibição. Para desativar 
esse recurso, clique com o botão direito no gráfico e desfaça a seleção no 
AutoScale Y.  

 

 
Figura 13. Algumas vezes você vai querer controlar manualmente a escala de um gráfico. 

 
Você pode alterar as faixas inferiores e superiores do eixo Y clicando nos números no eixo 
e digitando novos valores. 
 

28. Interrompa o VI clicando no botão Stop. 
 

Passos Adicionais  
O LabVIEW oferece diversas ferramentas para ajudá-lo a desenvolver suas aplicações. Os 
próximos passos mostrarão como usar algumas das ferramentas de assistência de 
programação mais importantes. 
 
Cleanup de diagramas de blocos 
 
Conforme você programa, e particularmente quando você aprende a programar no 
LabVIEW, nem sempre layout e legibilidade são levados em consideração. Isso pode 
resultar em um diagrama de blocos muito pouco organizado. 
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O Cleanup de diagramas de blocos do LabVIEW é uma ferramenta incorporada que 
organiza seu código, tornando mais fácil para você e outros o entendimento de como seu 
programa funciona.  
 

29. Pressione o ícone do Cleanup de diagramas de blocos localizado na barra de menu. 
 

 
Figura 14. O Cleanup de Diagrama de Blocos organizará automaticamente seu código. 

 
Agora, seu diagrama de blocos precisa ser organizado com fios mais limpos e uma 
distribuição uniforme dos elementos do código. 
 
Execução Highlight 

30. Clique no botão Highlight Execution na barra de ferramentas. Observe que agora o 
ícone de lâmpadas parece estar ligado. 
 

 
Figura 15. A execução Highlight faz seu código ficar mais lento para permitir que você 

visualize o fluxo de dados. 
 

31. Execute sua aplicação com a execução Highlight ligada. Clique na seta de 
execução e veja seu código ser executado passo a passo. Embora não seja sempre 
necessária para aplicações simples, a ferramenta Highlight Execution é um 
excelente recurso para solucionar problemas de programas complexos e 
determinar se seu código é executado conforme esperado. 
 

Context Help 
 

32. Clique no botão Context Help na parte superior do diagrama de blocos. 
 

 
Figura 16. A janela Context Help exibe um diálogo de ajuda com base no contexto. 

 
33. Com a janela Context Help ativa, passe seu cursor sobre objetos diferentes no 

diagrama de blocos e no painel frontal do VI Simulate Signal to Graph. Quando 
você fizer isso, a janela Context Help fornecerá detalhes incluindo diagramas de 
conexão e descrições. 
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Figura 17. O Context Help é um modo rápido de obter um panorama do VI, entradas e 

saídas. 
 

34. Clique com o botão direito no diagrama de blocos e navegue pelas paletas. 
Observe que a janela Context Help oferece detalhes sobre os objetos enquanto 
eles estão nas paletas. Note também que para alguns objetos, a janela Context 
Help oferece um link para o Detailed Help. Esse link abrirá o Help do LabVIEW  e 
oferecerá mais informações. 
 

35. Salve e feche o VI 2 - Simulate Signal to Graph.  
 

Parte C A finalidade deste exercício é usar o LabVIEW e o CompactDAQ para configurar 
rapidamente um programa para adquirir dados de temperatura. 

 
1. Clique com o botão direito na pasta Exercises e selecione New » VI. Quando 

estiver aberto, salve o VI na pasta Exercises com o nome 3 - Basic 
Measurement.vi. 
 

2. Pressione <Ctrl+T> para organizar as janelas do diagrama de blocos e do painel 
frontal. 

 
3. Abra a paleta Funtions clicando com o botão direito no espaço em branco na janela 

do digrama de blocos do LabVIEW. 
 

4. Mova seu cursor sobre a paleta Express » Input e clique no VI Expresso DAQ 
Assistant. Clique com o botão esquerdo no espaço vazio para colocá-lo no 
diagrama de blocos. 
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Figura 1. O DAQ Assistant é um modo de configuração para adquirir dados de um 

hardware real ou simulado. 
 

5. Em seguida, aparecerá a janela Create New…: 

 
Figura 2. As tarefas do NI-DAQmx são uma coleção de canais com propriedades de 

triggering e temporização homogêneas.  
 

6. Para configurar a aplicação de medição de temperatura com um termopar, clique 
em Acquire Signals » Analog Input » Temperature » Thermocouple.  
 

7. Clique no sinal + ao lado do módulo Temperature (NI 9213), destaque o canal ai0 e 
clique em Finish. Isso adiciona um canal físico a sua tarefa de medição. 
 

8. Dentro da caixa de diálogo de configuração DAQ Assistant, modifique o CJC 
Source para Built In e o Acquisition Mode para Continuous Samples.  
 

9. Modifique a configuração do Samples to Read para 100. 
 

10. Modifique a configuração do Rate (Hz) para 1k. 
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11. Clique no botão de execução. Você verá as leituras da temperatura do termopar na 
janela do painel de teste. 

 

 
Figura 3. Você pode configurar e testar sua medição de dentro da janela DAQ Assistant. 

 
12. Clique em Stop e OK para fechar a janela de configuração do bloco Expresso para 

retornar ao diagrama de blocos do LabVIEW.  
 

13. O LabVIEW cria automaticamente o código para essa tarefa de medição.  Como 
selecionamos uma medição de amostragem contínua, faz sentido que o código 
seja colocado dentro de um loop While informado pelo LabVIEW. Clique em Yes 
para criar automaticamente um loop While. 

 

 
Figura 4. O LabVIEW nos informa que o código deve ser colocado dentro de um loop. 

 
14. Clique com o botão direito na saída do terminal de dados ao lado direito do VI 

Expresso DAQ Assistant e selecione Create » Graph Indicator.  
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Figura 5. Você pode criar automaticamente um objeto do painel frontal no diagrama de 

blocos. 
 

15. Renomeie o indicador do Waveform Graph de Data para Temperature. 
 

16. Observe que um indicador gráfico correspondente é colocado no painel frontal. 
 

17. Agora seu diagrama de blocos deve se assemelhar a figura abaixo: O loop While 
adiciona automaticamente o botão Stop ao seu painel frontal para permitir que 
você pare a execução do loop. 

 
Figura 6. Aplicação totalmente funcional que adquire dados de temperatura. 

 
18. Sinta-se à vontade para executar o VI para testar suas funções.  Clique em Stop 

quando você concluir. 
 

19. Salve o VI. 
 

Passos Adicionais  
Os VIs Expressos facilitam a criação de aplicações básicas. Suas caixas de diálogo de 
configuração permitem que você configure os parâmetros e customize as entradas com 
base nos requisitos da sua aplicação. No entanto, para otimizar o desempenho de 
aquisição de dados da sua aplicação e permitir um melhor controle, você deve usar os VIs 
do driver DAQmx. O DAQ Assistant pode gerar automaticamente um código DAQmx 
padrão; nem todos os VIs expressos tem essa função. 
 
Antes de gerar o código padrão DAQmx do DAQ Assistant, você precisa remover qualquer 
código desnecessário que foi criado automaticamente pelo VI expresso.  
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20. Clique com o botão direito no loop While e selecione Remove While Loop. Em 

seguida, clique no botão Stop e pressione o botão <Delete> para remover o botão 
Stop. Repita essas ações no Temperature Graph bem como nos fios adicionais que 
podem permanecer. Você pode pressionar <Ctrl+B> para remover todos os fios 
desconectados de um diagrama de blocos. 

 
21. Quando você ficar apenas com o DAQ Assistant, clique com o botão direito no VI 

Expresso DAQ Assistant que você criou neste exercício e selecione Generate NI-
DAQmx Code. 

 

 
Figura 7. Gere o código NI-DAQmx a partir da configuração do DAQ Assistant. 

 
Agora, seu diagrama de blocos deve se assemelhar a esse: 
 

 
Figura 8. DAQmx de baixo nível equivalente à configuração do DAQ Assistant. 

 
O VI Expresso foi substituído por quatro VIs. Analisaremos suas funções nos passos a 
seguir: 
 

22. Abra a janela Context Help clicando no ícone do Context Help  ( ) no canto 
superior direito do diagrama de blocos.  
 

23. Passe seu cursor sobre cada VI e analise seus diagramas de conexão e descrições. 
 

24. O VI DAQmx Read lê os dados com base nos parâmetros que ele recebe do VI 
Untitled  à esquerda. 

 
25. Clique duas vezes no VI Untitled e abra o diagrama de blocos do VI (código 

ilustrado abaixo). 
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Figura 9. O VI Untitled contém todas as informações de configuração do canal incluindo o 

tipo medição, escala e temporização. 
 

Todos os parâmetros que são conectados como entradas aos VIs de configuração do 
DAQmx refletem as configurações que você configurou originalmente no VI Expresso 
DAQ Assistant. 
 
Observação: Ao mover esses parâmetros e VIs de configuração para o diagrama de 
blocos, você pode programaticamente modificar seus valores sem ter que parar sua 
aplicação e abrir a caixa de diálogo de configuração do VI Expresso. Isso pode economizar 
tempo de desenvolvimento e possivelmente otimizar o desempenho eliminando 
configurações desnecessárias dependendo da sua aplicação. 
 

26. Feche o VI Untitled .  Quando for solicitado não salve. 
 

27. Feche o VI 3 – Basic Measurement.  Quando for solicitado, não salve. 
 

Parte D A finalidade deste exercício é ampliar nossa aplicação para incluir valores limites que irão 
acionar um alarme definido pelo usuário. 
 

1. Dentro da pasta Exercises do projeto aberto Temperature, abra o VI 4 – Analysis 
and Output.  Esse VI é funcionalmente equivalente ao VI que criamos no exercício 
anterior, mas ele já oferece espaço adicional no diagrama de blocos para inclusão 
de um código adicional. 

 
2. Clique com o botão direito no painel frontal para abrir a paleta Controls e navegar 

para Controls » Silver » Numeric.  Selecione e coloque um Numeric Control no 
painel frontal. 
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Figura 1. Adicione um controle numérico no painel frontal para especificar o valor limite do 

alarme. 
 

3. Clique duas vezes no rótulo do controle numérico e renomeie o controle Alarm 

Level. 
 

4. Alterne para o diagrama de blocos; se não estiver ainda, arraste e solte o controle 
Alarm Level dentro do loop While. 
 

 
Figura 2. O loop While redimensionado permite que tenhamos mais espaço para 

adicionar o código. 
 

5. Pressione <Ctrl+Space> para iniciar o Quick Drop e digite “Comparison” para 
localizar o VI Expresso Comparison. 
 

6. Clique duas vezes no VI Comparison na lista de resultados do Quick Drop e 
coloque-o dentro do loop While.  
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Após colocado no diagrama de blocos, aparecerá a caixa de diálogo de configuração do VI 
Expresso Comparison. 

 
Figura 3. Caixa de diálogo de configuração do VI Expresso Comparison. 

 
7. Selecione > Greater na seção Compare Condition, Second signal input na seção 

Comparison Inputs e One result per channel na seção Result. Clique em OK. 
 

8. Coloque o cursor do mouse sobre a saída data do DAQ Assistant até que o ícone 
em forma de bobina apareça no seu cursor, em seguida, clique com o botão 
esquerdo e arraste o mouse para a entrada Operand 1 do VI Expresso 
Comparision. Da mesma forma, coloque o cursor, arraste e conecte o controle 
Alarm Level ao fio e a entrada Operand 2 no VI Expresso Comparison.  

 
9.  Agora seu diagrama de blocos deve se assemelhar a esse: 

 
Figura 4. Comparação dos dados adquiridos a um nível de alarme especificado pelo 

usuário. 
 

10. No painel frontal, clique com o botão direito e navegue para Controls » Silver » 
Boolean » LED (Silver).  Coloque o LED no painel frontal e redimensione o LED 
para que seja mais fácil vê-lo. 
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11.  Renomeie o LED Alarm. Seu painel frontal deve se assemelhar a esse: 
 

 
Figura 5. Agora a IU contém mecanismos para a exibição de dados e entrada do usuário. 

 
12. Se não tiver sido feito ainda, arraste e solte o indicador Alarm no loop While. 

 
13. No diagrama de blocos, conecte a saída do VI Expresso Comparison  à entrada do 

terminal do indicador Alarm.  
 

 
Figura 6. Nesse estágio, a aplicação notificará o usuário se a medição está excedendo um 

valor limite especificado. 
 

14. Clique no botão de execução e altere o controle Alarm Level para algum nível 
acima do atual sinal de temperatura adquirido. Segure o termopar até que a 
temperatura exceda o valor do Alarm Level. O LED do alarme liga quando o sinal 
de temperatura adquirido ultrapassa o nível definido no painel frontal.  Em seguida, 
atualizaremos uma linha digital dependendo do status do LED.  
 

15. Pare o VI usando o botão Stop no painel frontal. 
 

16. Alterne para o diagrama de blocos.  Clique com o botão direito para acessar a 
paleta Functions e selecione o VI Expresso DAQ Assisant em Functions » Express 
» Output.  Coloque o DAQ Assistant no diagrama de blocos dentro do loop While. 
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Figura 7. Adicionar outro DAQ Assistant permitirá que controlemos o módulo digital. 

 
17. Dentro da caixa de diálogo'Create New…', selecione Generate Signals » Digital 

Output » Line Output 

 
Figura 8. Uma linha digital nos permite gerar dados para uma única linha digital. 

 
18. Expanda o sinal + próximo ao módulo Digital_out na janela seguinte, selecione 

port0/line0 e clique em  Finish. 
 

19. Clique em OK na janela DAQ Assistant que aparecerá, se todas as configurações 
padrão estiverem corretas para a aplicação. 

 
20. Crie um fio adicional que conecte a saída Result do VI Expresso Comparision à 

saída data do novo VI Expresso DAQ Assistant2 .  
 

Aparecerá automaticamente a função Convert from Dynamic Data. O LabVIEW sempre 
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tentará coagir tipos de dados diferentes quando dois nós estiverem conectados juntos. 
Neste caso, a saída do VI Expresso Comparison é um tipo de dados dinâmico e a entrada 
do DAQ Assistant é um booleano. O LabVIEW colocou o nó Convert from Dynamic Data 
entre os dois nós para que eles possam ser conectados sem um erro de sintaxe. Agora 
seu diagrama de blocos deve se assemelhar a esse: 

 

Figura 9. O resultado de comparação do valor limite será apresentado no módulo digital. 

21. Clique no botão de execução. Observe que o banco de LED no módulo NI 9472 do 
CompactDAQ liga e desliga para corresponder ao valor do Alarm no painel frontal. 

 
22. Salve o VI. 

 

Parte E A finalidade desse exercício é salvar nossos dados adquiridos em um arquivo para 
processamento futuro, o que poderia incluir compartilhar com colegas, transformar em um 
relatório, executar análise adicional ou todos os citados. 
 

1. O VI 4 – Analysis and Output do exercício anterior deve estar aberto ainda.  Se não 
estiver, abra-o na pasta Exercises no projetoTemperature.  

 
2. Clique com o botão direito no diagrama de blocos e selecione Functions » File I/O 

» Write to Measurement File.  Coloque o VI Expresso dentro do loop While no 
diagrama de blocos. 
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Figura 1. O LabVIEW inclui dezenas de opções para ler e escrever arquivos. 
 

3. Como se trata de um VI Expresso, aparecerá a janela de configuração. Configure a 
janela conforme ilustrado abaixo, mas não se esqueça de anotar o local no campo 
Filename.  Quando tiver terminado, clique em OK. 
 

   
Figura 2. Essa configuração irá salvar um arquivo binário que pode ser processado 

posteriormente em um software comum, tal como o NI DIAdem ou Microsoft Excel. 
 

4. Conecte a saída do VI Expresso DAQ Assistant  à entrada do VI Expresso Write to 
Measurement File .  
 

5. Seu diagrama de blocos deve se assemelhar agora a figura abaixo: 
 

 
Figura 3. Essa aplicação concluída adquire dados de temperatura, apresenta um sinal 

digital se a temperatura exceder um valor limite e salva todos os dados em um arquivo. 
 

6. Execute o VI momentaneamente e clique em Stop para parar o VI. 
 

7. Seu arquivo será criado na pasta especificada. Se você não conseguir lembrar o 
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local do arquivo, clique duas vezes no VI Expresso Write to Measurement File. 
8. Usando o Windows Explorer, navegue para o local dos dados no disco.  

 
9. Clique com o botão direito no Windows Explorer e selecione Open With » Excel 

Importer para abri-lo no Microsoft Excel. Faça revisão dos dados de temperatura e 
do cabeçalho salvos no arquivo.  Observe que eles podem estar contidos dentro de 
diferentes planilhas do Excel (guias). 
 

 
Figura 4. Arquivo dos dados de temperatura resultante que foi salvo na aplicação 

concluída do LabVIEW. 
 

10. Feche o arquivo de dados se ele ainda estiver aberto. 
 

11. Feche o VI do LabVIEW se ele ainda estiver aberto. 
 

12. Feche o projeto de temperatura se ele ainda estiver aberto. 
 

<Fim do exercício> 
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Como combinar medições de temperatura e iluminação 
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Objetivo:  Neste exercício, você irá adquirir um sinal de luminosidade usando o NI-DAQmx. 

 Na segunda parte deste exercício, você modificará o exemplo para medir a luz 
ambiente na demo box de medição. 
 

Parte A Abra e execute nossa aplicação inicial  
Tempo estimado: 20 minutos 
 

O exercício de hoje começa com um sistema de medição pré-criado com um único canal 
que mede os dados de temperatura de um termopar. Ampliaremos esse sistema para 
adquirir dados de medição mistos de dois sensores (um termopar e uma célula solar) 
usando dois módulos diferentes e escrever dados em um formato de arquivo escalável. 
 

1. Inicialize o LabVIEW selecionando Start » All Programs » National Instruments » 
LabVIEW 2014 » LabVIEW se ele não estiver inicializado ainda. 

2. Abra o projeto Light Sensor. 

a. Na Janela Getting Started do LabVIEW, selecione Open Existing. 

b. Navegue até C:\Seminars\LV HO\Exercises\4 – Light. 

c. Selecione e abra o Light Sensor Project.lvproj. 

3. Abra e execute a aplicação inicial. 

a. No projeto do LabVIEW, clique duas vezes e selecione Exercises » 1 – 
Write Temperature to ASCII File (Original).vi. 

b. Execute a aplicação clicando na seta de execução ( ) no painel frontal 
conforme ilustrado na figura 1. 

c. Enquanto a aplicação estiver sendo executada, use seus dedos para 
aquecer o termopar anexado ao canal da entrada analógica (ai0) do módulo 
NI 9213.  

d. Verifique se o sinal de temperatura no gráfico do painel frontal do LabVIEW 
sobe e desce adequadamente, e que o indicador LED liga quando a 
temperatura excede a 26 °C. Quando o indicador LED ligar, o LED físico no 
módulo de saída digital NI 9472 também deve acender. 

e. Pare o VI selecionando o botão Stop no painel frontal do LabVIEW 
conforme ilustrado na figura 1. 
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Figura 1. Use a seta de execução para executar a aplicação do LabVIEW. 
 

4. Pressione <Ctrl+E> para visualizar o diagrama de blocos. 
 
Esse código do LabVIEW usa o DAQ Assistant para adquirir dados - um VI 
Expresso com etapas de configuração incorporadas que eliminam a necessidade 
de muitas das configurações mais comuns de dispositivos.  Por outro lado, o DAQ 
Assistant tem algumas limitações quando você precisa mais controle de seu 
dispositivo DAQmx, como sincronização ou parâmetros de dispositivos específicos 
que estão fora do escopo desse seminário.  Nos próximos exercícios, você 
aprenderá os conceitos básicos para usar o API NI-DAQmx padrão (não expresso).  
Esse método de programação de baixo nível abre os recursos do dispositivo e a 
logo prazo o transformará em um usuário melhor. 
 

 
Figura 2. Usar um DAQ Assistant é uma maneira fácil de obter e executar a 

aquisição de dados. 
5. Feche o VI. 
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Parte 
B 

Use o API NI-DAQmx de baixo nível 
Tempo estimado: 20 minutos 
 
Embora o DAQ Assistant usado no último exercício tenha concluído a tarefa, ele não é tão 
flexível ou escalável para aplicações de medições mistas. Neste exercício, substituiremos 
o DAQ Assistant e faremos medições equivalentes usando VIs NI-DAQmx de baixo nível 
mais flexíveis. 
 

1. Abra a aplicação do exercício. 

a. No projeto do LabVIEW, clique duas vezes e selecione  Exercises » 2 – Use 
the NI-DAQmx VIs (Original).vi. 

2. Analise o códido do NI-DAQmx de baixo nível.  
 

a. Selecione Window » Show Block Diagram ou pressione <Ctrl+E> para 
analisar o código do LabVIEW. 
 

b. Se ainda não estiver aberta, selecione Help » Show Context Help ou 
pressione <Ctrl+H> para abrir a janela Contex Help do LabVIEW. 

 
c. Navegue até a seção mais à esquerda do código do diagrama de blocos, 

conforme ilustrado na figura 3. 

 
Figura 3. O API de baixo nível NI-DAQmx segue um padrão lógico. 

 
d. Um por vez, passe o cursor do mouse sobre os VIs no diagrama de blocos e 

analise suas funções conforme descritas na janela Context Help, figura 4. 
 

 
Figura 4. A caixa de diálogo do Context Help lhe oferece informações detalhadas 

sobre cada VI, bem como seus valores de saída e entrada esperados. 
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Observe que o fluxo lógico do API NI-DAQmx começa configurando um canal de 
entrada analógica que corresponde a um canal físico de medição.  
 
A aquisição é inicializada antes do loop While. Dentro do loop, as amostras são 
lidas pelo buffer do NI-DAQmx repetidamente até que o usuário pare o loop, no 
momento em que a configuração da aquisição é excluída da memória. 
 

3. Adicione configuração de temporização ao código do NI-DAQmx de baixo nível.  
 

a. Clique com o botão direito no espaço em branco no diagrama de blocos 
para acessar a paleta Functions. 
 

b. Navegue até Measurement I/O » NI-DAQmx  e selecione o DAQmx 
Timing.vi. 
 

 
Figura 5. A paleta NI-DAQmx abriga todas as funções de aquisição de dados 

criadas no ambiente LabVIEW pelo driver NI-DAQmx. 
 

c. Clique com o botão esquerdo no VI DAQmx Timing entre o VI DAQmx 
Create Channel  e o VI Start Task, conforme ilustrado na figura 6. 
 

d. Clique com o botão direito no terminal de entrada Sample Mode do DAQmx 
Timing.vi e selecione Create » Constant clicando com o botão direito no 
menu de contexto. 

 
e. Em vez de Finite Samples, altere a entrada do Sample Mode para 

Continuous Samples. 
 

f. Clique com o botão direito na entrada Rate e selecione Create » Constant 
clicando com o botão direito no menu de contexto. Deixe o valor da faixa 
padrão em 1000 Hz. 

 
g. Clique com o botão direito na entrada Samples per Channel e selecione 

Create » Constant. 
 

h. Clique duas vezes na constante Samples per Channel e altere o valor para 
100. 
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i. Clique na entrada da saída Task Out do DAQmx Create Channel.vi e depois 
clique novamente na entrada Task/Channels In do DAQmx Timing.vi.  Isso 
conectará um fio entre os dois nós. 

 
j. De forma similar, conecte a saída Task Out do DAQmx Timing.vi à entrada 

Task/Channels In do DAQmx Start Task.vi. 
 

 
Figura 6. Configure o DAQmx Timing.vi conforme ilustrado. 

 
4. Execute o VI. 

a. Usando a seta de execução ( ), execute o VI e certifique-se de ele que 
esteja se comportando com os VIs NI-DAQmx de baixo nível exatamente 
como ele fez usando o DAQ Assistant. 
 

b. Pare o VI selecionando o botão Stop no painel frontal do LabVIEW. 
 

5. Selecione File » Save para salvar suas alterações. 
 

6. Deixe o VI aberto para o próximo exercício.  
 

Parte C Use o NI-DAQmx Task 
Tempo estimado: 20 minutos 
 
Os VIs NI-DAQmx de baixo nível oferecem maior flexibilidade na programação das 
aplicações de aquisição de dados do LabVIEW. Com os VIs de baixo nível, você pode 
controlar programaticamente o nível mais baixo dos detalhes para criar qualquer coisa 
desde uma simples aquisição ou geração de aplicações à aquelas com diversos canais 
simultâneos usando triggering e temporização complexa. 
 
Como um denominador comum entre o DAQ Assistant (que oferece máxima facilidade de 
uso enquanto sacrifica um pouco de flexibilidade relativa) e os VIs NI-DAQmx de baixo 
nível (que o oferecem máxima flexibilidade enquanto sacrificam um pouco da facilidade de 
uso), o NI-DAQmx Task combina a definição com base na configuração com o controle de 
baixo nível - uma abordagem "melhor dos dois mundos" que funciona bem para as 
aplicações escaláveis. 
 

1. Salve novamente o VI para usá-lo no exercício 3. 
 

a. Se não estiver aberto ainda, dentro do projeto Sensor Project, clique duas 
vezes e selecione o Exercises » 2 – Use the NI-DAQmx VIs (Original).vi. 
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b. Selecione File » Save As…  

 
c. Escolha Substitute copy for original e selecione Continue… 

 
d. Salve o VI no diretório <Exercises> como 3 – Use a NI-DAQmx Task.vi.  

 
2. Se não estiver aberto ainda, selecione Start » All Programs » National Instruments 

» Measurement & Automation Explorer para abrir o Measurement & Automation 
Explorer.  
 

3. Adicione um NI-DAQmx Task ao seu Data Neighborhood. 
 

a. Sob a árvore My System, clique com o botão direito no Data Neighborhood 
e selecione Create New…. 
 

b. Escolha NI-DAQmx Task e selecione Next. 
 

 
Figura 7. Use a seção Data Neighborhood da árvore My System para criar atalhos 

nomeados de forma descritiva para configurações de canais físicos. 
 

4. Adicione e configure um canal de entrada analógica. 
 

a. Selecione Acquire Signals » Analog Input » Temperature » Thermocouple 
conforme ilustrado na figura 8. 
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Figura 8. O NI-DAQmx facilita configurar as aplicações de aquisição de dados 

corretamente uma vez que todos os parâmetros de configuração estão agrupados 
por tipo de aquisição. 

 
b. Escolha Temperature (NI 9213) » ai0 e selecione Next para configurar a 

entrada do termopar no canal de entrada analógica 0 do módulo termopar 
NI 9213 da série C. 
 

c. Renomeie o NI-DAQmx Task para Measure Temperature and Light e 
selecione Finish. 

 
Observe que a caixa de diálogo da entrada de configuração que aparece é 
idêntica em todos os caminhos para o DAQ Assistant no LabVIEW. Como 
um driver totalmente integrado, a experiência do usuário será contínua 
esteja ele configurando o NI-DAQmx do LabVIEW, Measurement & 
Automation Explorer ou qualquer outro software da NI. Isso contribui para 
facilitar a flexibilidade e escalabilidade da aplicação.   
 

d. Em vez de 1 Sample (On Demand), altere a configuração do Acquisition 
Mode para Continuous Samples. 
 

e. Modifique a configuração do Samples to Read para 100. 
 

f. Modifique a configuração do Rate (Hz) para 1000. 
 

5. Adicione um segundo canal à tarefa para medir a luminosidade. 
 

a. Dentro da seção Channel Settings, use o botão Add Channel ( ) para 
selecionar Voltage, conforme ilustrado na figura 9. 
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Figura 9. Ambos os canais de aquisição podem ser parte do mesmo NI-DAQmx 
Task desde que ambos compartilhem as mesmas configurações de triggering e 

temporização. 
 

a. Dentro da caixa de diálogo Add Channels to Task, escolha Voltage_in (NI 
9215) » ai0 e selecione OK para configurar a entrada de tensão no canal de 
entrada analógica 0 do módulo de entrada analógica NI 9215 da série C. 
 

b. Clique com o botão direito no canal Voltage e selecione Rename… 
 

c. Renomeie o canal Voltage para Solar Energy e selecione OK. 
 

6. Configure um NI-DAQmx Custom Scale.  
 

a. Sob a árvore My System, clique com o botão direito em Scales e selecione 
Create New… 
 

b. Escolha NI-DAQmx Scale e selecione Next. 
 

c. Selecione Map Ranges conforme ilustrado na figura 10. 
 



ni.com/daq  60 

 
Figura 10. Existem diversas opções de escalas diferentes para o NI-DAQmx 

Scales. 
 

d. Nomeie a escala Solar Scale e selecione Finish. 
 

e. Configure a caixa de diálogo Map Ranges Scale conforme ilustrado na figura 
11. 

 

 
Figura 11. Guia de mapeamento NI-DAQmx Map Ranges entre duas faixas de 

valores. 
 

f. Salve as alterações no NI-DAQmx Scale selecionando Save. 
 

7. Aplique o NI-DAQmx Scale na tarefa. 
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a. Sob a árvovre My System, selecione NI-DAQmx Tasks » Measure 
Temperature and Light. 
 

b. Selecione o canal Solar Energy na tarefa. 
 

c. Altere a configuração Custom Scaling para Solar Scale. Se ela não aparecer 
na lista, significa que você não salvou sua escala neste exercício na parte C, 
passo 6F. 

 
d. Altere a configuração do Signal Input Range Min para 25. 

 
e. Altere a configuração do Signal Input Range Max  para 30.  

 
f. Salve a tarefa Measure Temperature and Light selecionando Save. O canal 

Solar Energy deve estar configurado conforme ilustrado na figura 12. 
 
As especificações para o sensor de célula solar determinam que ele 
apresente um valor de tensão entre 0 volts (sem iluminação) e 5 volts 
(plena luz solar). A iluminação na sala de seminário apresentará um valor de 
tensão pequeno, então nossa escala irá mapear valores de tensão mais 
altos. Embora o termopar também apresente valores nessa faixa de tensão 
(pequena), o tipo do canal do termopar na tarefa mapeia automaticamente 
os valores da saída do termopar em uma escala de graus Celsius (°C) entre 
0 e 1000.  
 
Aplicar nossa escala customizada à medição solar irá mapear os valores da 
luz solar na mesma faixa de valores que está sendo representada pelo canal 
do termopar na temperatura ambiente aproximada. 
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Figura 12. O canal de energia solar usa sua própria configuração de escala, mas 
compartilha parâmetros de temporização e triggering com todos os outros canais 

na mesma tarefa. 
 

8. Use o NI-DAQmx Task no LabVIEW. 
 

a. No VI 3 – Use a NI-DAQmx Task dentro do LabVIEW, clique e arraste para 
destacar todos os parâmetros da entrada e dos VIs para a esquerda do 
DAQmx Start Task.vi, conforme ilustrado na figura 13. 
 

 
Figura 13. Exclua todos os VIs de configuração e parâmetros da entrada à esquerda 

do DAQmx Start Task.vi. 
 

b. Usando seu teclado, pressione Delete para excluir o código à esquerda do 
DAQmx Start Task.vi.  
 

c. Pressione <Ctrl+B> para limpar quaisquer fios quebrados resultantes da 
remoção do código de configuração. 

 
d. Clique com o botão direito no espaço em branco no diagrama de blocos 

para acessar a paleta Functions. 
 

e. Navegue até Measurement I/O » NI-DAQmx e selecione a constante Task 
Name do DAQmx. 
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Figura 14. Selecione DAQmx Task Name Constant na paleta functions do DAQmx. 

 
f. Clique com o botão esquerdo para inserir a constante Task Name do 

DAQmx à esquerda do VI DAQmx Start Task. 
 

g. Usando o menu drop down, selecione a tarefa Measure Temperature and 
Light que você configurou no Measurement & Automation Explorer. 

 
h. Conecte a tarefa da saída do DAQmx Task Name Constant à entrada do 

Task / Channels In do VI DAQmx Start Task conforme ilustrado na figura 15. 
 

 
Figura 15. Substitua os VIs de configuração e os parâmetros da entrada pela 

constante Task Name do DAQmx. 
 

i. Clique com o botão direito no fio existente da saída Result do VI Expresso 
Comparison. 
 

j. Ao clicar com o botão direito no menu de contexto, selecione Insert » 
Signal Manipulation Palette » Split Signals, conforme ilustrado na figura 16. 
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Figura 16. Insira o nó Split Signals logo depois do VI Expresso Comparison. 

 
Devido à estreita integração entre o LabVIEW, hardware e driver NI-DAQmx, o 
LabVIEW reconhece a criação ou configuração das tarefas ou parâmetros no 
Measurement & Automation Explorer. Quaisquer tarefas criadas no Measurement 
& Automation Explorer são automaticamente preenchidas dentro do LabVIEW.  
 
Como a tarefa Measure Temperature and Light inclui dois canais, devemos dividir o 
sinal vindo do VI Comparison para que apenas os resultados do canal Temperature 
sejam apresentados ao DAQ Assistant da saída digital. 
 

9. Execute o VI. 

a. Usando a seta de execução ( ), execute o VI. 
 

b. Enquanto a aplicação está sendo executada, use seu dedo para aquecer o 
termopar e verificar se a temperatura sobre apropriadamente. 

 
c. Enquanto a aplicação está sendo executada, use suas mãos para proteger o 

sensor de célula solar da luminosidade e verificar se a tensão cai 
apropriadamente. Alternativamente, você pode oferecer luminosidade 
adicional usando um celular disponível e verificando se a tensão sobre 
apropriadamente. A célula solar não deve reagir tão drasticamente quanto o 
termopar. 

 
d. Pare o VI selecionando o botão Stop no painel frontal do LabVIEW. 

 
10. Salve o VI. 

 
11. Deixe o VI aberto para o próximo exercício.  

 

Parte 
D 

Salve um arquivo bem documentado  
Tempo estimado: 20 minutos 
 



ni.com/daq  65 

O projeto já escreve em um arquivo ASCII no formato de um arquivo do LabVIEW 
Measurement (*.LVM). Os arquivos ASCII são escolhas adequadas para aplicações únicas 
e pequenas, mas esse formato de arquivo não é uma escolha de armazenamento viável 
para aplicações que exigem escalabilidade devido a grande quantidade de processamento 
requerido para usar o formato ASCII.  
 
Este exercício substituirá o formato ASCII por um formato de arquivo mais escalável e 
flexível - o Technical Data Management Streaming (TDMS) - que também proporcionará 
benefícios futuros para extração e gerenciamento de dados. 
 

1. Salve novamente o VI para usá-lo no exercício 4. 
 

e. Se não estiver aberto ainda, dentro do projeto Sensor Project, clique duas 
vezes e selecione Exercises » 3 – Use a NI-DAQmx Task.vi. 
 

f. Selecione File » Save As…  
 

g. Escolha Substitute copy for original e selecione Continue… 
 

h. Salve o VI no diretório <Exercises> como 4 – Save a Well Documented File.  
 

2. Configure as opções de formato do VI Write to Measurement File. 
 

a. No diagrama de blocos, clique duas vezes no VI Expresso Write to 
Measurement File para abrir sua caixa de diálogo de configuração. 

 
b. Na seção File Format, selecione Binary (TDMS). 

 
c. Anote o local do diretório no Filename.  

 

 
Figura 17. Os novos arquivos de dados TDMS devem ser salvos no diretório do LabVIEW 

Data. 
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d. Na seção If a File Already Exists, selecione Use Next Available Filename. 
 
e. Faça uma descrição explicativa da finalidade do arquivo no campo File 

Description.  
 

f. Confira se a caixa de diálogo está configurada de forma semelhante às 
configurações na figura 18. 

 
Figura 18. O VI Expresso Write to Measurement File oferece máxima facilidade de 
uso, no entanto, como todos os VIs Expressos, sacrifica um pouco de flexibilidade. 

 
3. Escreva propriedades descritivas e customizadas na estrutura do arquivo TDMS. 

 
a. Na caixa de diálogo de configuração Configure Write to Measurement File, 

selecione Advanced…. 
 

b. Na guia TDM Properties, selecione Insert. 
 

c. Na coluna Hierarchy Level, selecione Channel Group. 
 

d. Na coluna Data Type, selecione STR (string). 
 

e. Na coluna Name, substitua o texto Untitled_0 pelo texto Author. 
 

f. Na coluna Value da propriedade Author, digite seu nome (ex: Jane Smith). 
 

g. Repita os passos 3B – 3F conforme desejado para documentar mais 
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propriedades customizadas. Fique à vontade para experimentar! Com o 
formato de arquivo TDMS, você pode documentar um número ilimitado de 
propriedades e quanto mais você adicionar, mais flexibilidade você terá ao 
tentar localizar ou gerenciar seus dados.  
 
Algumas propriedades opcionais que podem ser incluídas são local, tipo de 
teste e número de série. Você pode preencher essas propriedades com 
valores prontos. 
 

 
Figura 19. Com o formato de arquivo TDMS, você pode facilmente adicionar um 

número ilimitado de informações descritivas no arquivo. Fique à vontade para 
experimentar! 

 
4. Adicione o NI-DAQmx Properties ao arquivo TDMS. 

a. Na caixa de diálogo Configure User Defined Properties, selecione a guia 
DAQmx Properties. 
 

b. Marque o quadro da entrada analógica. 
 

 
Figura 20. Com o driver NI-DAQmx, você pode registrar automaticamente todas as 
configurações de aquisição de dados no TDMS properties para referência futura. 



ni.com/daq  68 

 
c. Selecione OK para fechar a caixa de diálogo Configure User Defined 

Properties. 
 

d. Selecione OK para fechar a caixa de diálogo Configure Write to 
Measurement File. 
 

5. Conecte o NI-DAQmx Task ao VI Expresso Write to Measurement File. 
 

a. Conecte a saída lilás Task Out do VI DAQmx Read à entrada DAQmx Task 
do VI Expresso Write to Measurement File conforme ilustrado na figura 20. 
 

 
Figura 21. O fio lilás do DAQmx Task contém todas as configurações de aquisição 

de dados da tarefa Measure Temperature and Light. 
 

Ao configurar o VI Expresso Write to Measurement File para escrever todas as 
propriedades da entrada analógica da tarefa, o driver NI-DAQmx salva 
automaticamente quaisquer propriedades da entrada analógica utilizadas na 
medição com o arquivo de dados. Essas propriedades incluem configurações 
descritivas, tais como informações customizadas de escala, unidades de medição 
ou tipo de termopar - todas são informações muito úteis para tê-las documentadas 
automaticamente! 
 

6. Notifique o usuário sobre a descrição do teste. 
a. Clique com o botão direito no espaço em branco no diagrama de blocos 

para acessar a paleta Functions. 
 

b. Navegue até Programming » Dialog & User Interface e selecione o VI 
Expresso Prompt User for Input. 
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c. Clique com o botão esquerdo para colocar o VI Expresso Prompt User for 

Input fora do loop While em algum local à esquerda do loop While conforme 
ilustrado na figura 21. 

 
Figura 22. O VI Expresso Prompt User for Input é colocado antes do loop While 

uma vez que a primeira coisa que queremos que aconteça quando a aplicação for 
executada. 

 
d. Na caixa de diálogo Configure Prompt User for Input que aparecer, digite 

Please Provide a Test Name: no campo Message to Display. 
 
e. Na seção de entrada Inputs, digite Response na coluna Input Name. 

 
f. Na seção de entrada Inputs, selecione Text Entry Box para a entrada Input 

Data Type of the Response. 
 

g. Confirme se a caixa de diálogo está configurada de forma correspondente à 
figura 22 e selecione OK para fechá-la. 
 

 
Figura 23. O VI Expresso Prompt User for Input é um modo fácil e rápido de obter 
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feedback do usuário. 
 

h. Conecte a saída lilás Response do VI Expresso Prompt User for Input no 
loop While à entrada lilás Comment do VI Expresso Write to Measurement 
File conforme ilustrado na figura 23. 
 

i. Conecte a saída amarela Error Out do VI Expresso Prompt User for Input ao 
terminal de entrada Error In do VI DAQmx Start Task, conforme ilustrado na 
figura 23. 

   

 
Figura 24. O VI Write to Measurement File tem entrada para diversas fontes. 

 
Ao conectar a saída Error Out do VI Expresso Prompt User for Input ao terminal de 
entrada Error In do VI DAQmx Start Task, garantimos que a aquisição de dados não 
seja iniciada até que o usuário termine de responder nossa solicitação.  Impondo 
uma ordem de execução dessa forma, usamos um recurso diferenciado do 
LabVIEW chamado fluxo de dados - literalmente controlamos o fluxo de 
temporização dos dados. 
 

7. Execute o VI. 

a. Usando a seta de execução ( ), execute o VI. 
 

b. Na caixa de diálogo Prompt User for Input, digite um nome de teste, tal 
como “Test 001-A.” 

 
c. Enquanto a aplicação está sendo executada, use seu dedo para aquecer o 

termopar; use suas mãos ou celular para alterar a quantidade de luz que 
chega à célula solar. 

 
d. Pare o VI selecionando o botão Stop no painel frontal do LabVIEW. 

 
e. Repita dos passos 7A – 7D conforme desejado para criar alguns conjuntos 

de dados diversificados. Algumas opções incluem: 
i. Durante um teste, interaja apenas com o termopar. 
ii. Em um segundo teste, interaja apenas com o a célula de teste. 
iii. Em um terceiro teste, interaja com os dois sensores começando ao 
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mesmo tempo. 
iv. Em um quarto teste, interaja com os dois sensores começando em 

tempos diferentes. 
 

8. Salve o VI. 
 

9. Usando o Windows Explorer, navegue no disco para o local onde os dados foram 
salvos.  Se você esqueceu onde os dados foram salvos, você pode clicar duas 
vezes no VI Expresso Write to Measurement File no diagrama de blocos e analisar 
o controle 'Filename'. 
 

13. Clique com o botão direito em um dos seus arquivos de dados no Windows 
Explorer e selecione Open With » Excel Importer para abrir o Microsoft Excel. 
Revise as informações do cabeçalho da planilha do Excel (guia) e observe todas 
suas propriedades descritivas customizadas. 
 

14. Revise as propriedades que foram adicionadas ao arquivo pelo driver DAQmx, tais 
como o nome do tipo de medição e escala customizada. 
 

15. Alterne para a segunda planilha do Excel (guia) no arquivo e observe os dados de 
energia solar, tempo e temperatura salvos no arquivo.  
 

 
Figura 25. O arquivo completamente documentado contém dados de medição e 

metadados. 
 

16. Feche o arquivo de dados se ele ainda estiver aberto. 
 

17. Feche o VI do LabVIEW se ele ainda estiver aberto. 
 

18. Feche o projeto Light Sensor, se ele ainda estiver aberto. 
 

<Fim do exercício> 
 



Medições de strain gage com indicação de LED para o usuário 
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Objetivo:  Na primeira parte deste exercício, você escreverá um programa para adquirir 
dados de um strain gage em uma configuração de um quarto de ponte.  

 Na segunda parte, você adicionará um código para indicar a deformação 
aproximada para um usuário com indicadores LED. 

 Os principais conceitos incluem:  
o Medições de deformação  
o Como usar o API NI-DAQmx 
o Como usar os subVIs 
o Como combinar tarefas de controle e medições 
o Como escrever em um arquivo quando ocorre um evento 

 

Parte A Dados de Medição de um Strain Gage 
Tempo estimado: 40 minutos 
 
Adquirir dados de deformação é uma das tarefas mais comuns em qualquer sistema de 
medição estrutural. A deformação é medida usando um strain gage, que é um pequeno 
elemento resistivo que altera a resistência quando é alongado. Como a resistência é 
modificada proporcionalmente com a alteração do comprimento do gage, você poderia 
excitar o strain gage com uma corrente e medir a alteração de tensão para calcular as 
variações na resistência.  No entanto, como a variação na resistência é muito pequena, 
uma melhor solução é usar a configuração de ponte de Wheatstone para medir as 
pequenas variações nela. 
 

 
Figura 1. Uma ponte de Wheatstone permite uma medição precisa de pequenas 

variações na resistência.  
 
Na figura 1, são usados quatro resistores na configuração da ponte de Wheatstone e uma 
fonte de excitação de tensão Vex.   Se os quatro resistores forem iguais, a ponte deve ser 
equilibrada e a tensão medida no Vo será igual a zero.  Ao usar uma ponte de Wheatstone 
para medir a deformação, o strain gage terá uma resistência nominal igual aos outros 
elementos da ponte, no caso deste exercício, 350 Ohms. Conforme o strain gage é 
flexionado, a resistência é alterada e, consequentemente, o Vo. Tendo isso em mente, 
podemos derivar a alteração proporcional (sem se ater a quaisquer detalhes), chegando a 
seguinte equação: 
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Figura 2. Em uma configuração de um quarto de ponte, podemos calcular a deformação 

com base na variação da tensão. 
 

Neste exercício, você usará um strain gage na configuração de um quarto de ponte, o que 
significa que apenas um dos gages está ativo.     
 
Os strain gages são particularmente delicados.  Antes de iniciar esse exercício, confirme 
se o strain gage está conectado adequadamente e se você consegue fazer a aquisição de 
dados básicos a partir do canal conectado ao strain gage.  
 

1. No chassi CompactDAQ, verique se os LEDs Power e Ready, verde e amarelo 
respectivamente, estão acesos para confirmar se o chassi está conectado via USB 
e ligado.  
 

2. Analise a conexão no módulo NI 9236 para confirmar se o strain gage está 
conectado adequadamente. 

 
3. Se não estiver aberto ainda, inicialize o Measurement & Automation Explorer 

selecionando Start » All Programs » National Instruments » Measurement & 
Automation Explorer.  

 
4. Clique com o botão direito no módulo NI 9236 e selecione Test Panels….  

 

 
Figura 3. Selecione Test Panels para abrir um utilitário simples para verificar a 

conectividade do sinal. 
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5. Quando o painel de teste abrir, modifique a entrada Samples to Read para 500 e a 

entrada Mode para Continuous.  
 

6. Clique em Start.  O painel de teste deve se assemelhar à figura 3.  
 

 
Figura 4. O painel de teste é usado para confirmar as conexões elétricas. 

 
7. Pressione a barra de deformação para baixo para confirmar se o gráfico reage a 

sua entrada.  Se você detectar que não há nenhuma alteração notável, informe 
seu instrutor. 
 

8. Clique no botão Stop e feche o painel de teste.  
 
Toda vez que você configurar uma nova medição ou sistema de medição, é uma 
boa prática confirmar se a conexão está correta e se todos os programas de 
software estão instalados e funcionando corretamente. O MAX proporciona 
percepção para seu sistema e configuração para ajudá-lo a eliminar os erros no 
início do seu processo de desenvolvimento.  
 

9. Após confirmar que o strain gage está funcionando adequadamente, minimize o 
MAX e selecione Start » All Programs » National Instruments » LabVIEW <Year> 
» LabVIEW para abrir o LabVIEW. 
 

10. Na janela Getting Started do LabVIEW, selecione Open Existing. 
 

11. Navegue até C:\Seminars\LV HO\Exercises\5 – Strain.  
 

12. Clique duas vezes no Strain Gage Exploration.lvproj para abrir o projeto strain 
gage.  Você deve ver a seguinte tela: 
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Figura 5. Use o LabVIEW Projects para organizar todos os seus VIs. 

 
Com o LabVIEW Project você pode organizar e visualizar facilmente todos os 
arquivos que são importantes para sua aplicação.  Neste projeto emparticular, as 
pastas como Exercises, Solutions e Support VIs foram configuradas para serem 
preenchidas automaticamente com os arquivos dentro delas.   
 

13. Expanda as pastas para visualizar os arquivos dentro delas. Você deve ver os 
seguintes VIs: 
 

 
Figura 6. Os VIs usados no seu projeto podem ser localizados nas pastas 

preenchidas automaticamente. 
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14. Comece abrindo o VI Solution.  No Project Explorer, expanda My Computer » 
Solutions e clique duas vezes no Strain_w_User_Feedback_Solution.vi. 
 

15. Clique na seta de  execução ( ) e depois pressione delicadamente a barra de 
deformação. Observe que os LEDs sinalizam a quantidade de deformação 
apresentada na barra de deformação.  
 

16. Feche  o VI.  Se for solicitado, não salve as alterações. 
 

17. Para iniciar este exercício, use o Project Explorer para navegar para My Computer 
» Exercises e clique duas vezes no Strain_w_User_Feedback_Exercise.vi. Você já 
criou o painel frontal anteriormente.  
 
Ao começar um novo programa, iniciar com um projeto do painel frontal é uma 
boa forma de organizar quais serão as entradas e saídas do seu programa.  
Quando você define como você quer que um usuário interaja com o código, você 
pode começar a escrever o VI para suportar essa função.  
 
Ao longo deste exercício, você projetará esse VI para adquirir dados de um strain 
gage e ascender uma série de LEDs para comunicar o nível de deformação ao 
usuário.  
 

 
Figura 7. O painel frontal é a interface de usuário do seu programa e contém todos 

os controles e indicadores para interagir com seu código. 
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Observe que a seta de execução no canto direito superior está quebrada ( ). 
Isso ocorre porque o código contém erros ou, neste caso, não está em um estado 
de execução. O LabVIEW compila continuamente no ambiente de edição, então 
você sempre saberá se seu código pode ser executado.   
 
Clicar na seta de execução quando ela está quebrada apresentará uma lista de 
erros. Clique na seta de execução quebrada para visualizar alguns erros presentes 
no nosso código.  Se você clicar duas vezes em um dos erros, o LabVIEW 
destacará a seção do código que contém o erro. 
Se eu código for compilado sem erros, a seta de execução não será quebrada 

novamente ( ).   
 

18. Feche a caixa de diálogo de erro e selecione Window » Show Block Diagram. O 
atalho do teclado para esse comando é <Ctrl+E>.  Use esse atalho para alternar 
para frente e para trás entre o painel frontal e o diagrama de blocos. Quando o 
diagrama de blocos abrir, você verá o seguinte código: 
 

 
Figura 8. O diagrama de blocos faz o trabalho do seu programa. É aqui que você 

escreverá o código para controlar o painel frontal. 
 

Como o código foi inicializado, o diagrama de blocos já inclui alguns elementos 
básicos.   Cada elemento no painel frontal tem um terminal correspondente no 
diagrama de blocos. Para localizar o elemento correspondente do painel frontal, 
você pode clicar duas vezes no elemento no diagrama de blocos para destacá-lo.   
 
Clique duas vezes no ícone  Strain Chart. Em seguida, clique no mesmo item no 
painel frontal.  Essa é uma forma prática de localizar os itens no painel frontal e no 
diagrama de blocos.  
 
Os quadros em amarelo claro são anotações. Você pode criar anotações no 
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diagrama de blocos clicando duas vezes em um espaço em branco.  É sempre 
uma boa prática documentar adequadamente seu código para que você (se voltar 
uma semana mais tarde) ou outra pessoa possa entender o que está acontecendo.  
 

19. Agora que você está familiarizado com os elementos do programa, você pode 
começar a criar o código para adquirir dados de deformação. Para começar, 
verifique se seu diagrama de blocos está visível. 
 

20. Neste exercício, uma grande parte do código virá da paleta DAQmx. Para acessar 
essa paleta, clique com o botão direito em qualquer espaço em branco no 
diagrama de blocos e navegue até Measurement I/O » NI-DAQmx, conforme 
demonstrado na figura 9.  
 

21. Clique na tachinha para deixar essa paleta visível (seta vermelha na figura 9). 
 

 
Figura 9. A paleta DAQmx inclui todos os VIs necessários para comunicação com 

seu chassi CompactDAQ. 
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Figura 10. Fixar a paleta permite que você clique em qualquer lugar no seu código 

com a paleta ainda visível.  
 

22. Para iniciar, arraste o NI-DAQmx Create Channel (seta vermelha na figura 10) e 
coloque-o na posição ilustrada na figura 11.  

 
Figura 11. O VI DAQmx Create Channel determina a comunicação com seu 

dispositivo de aquisição de dados. 
 

23. Por padrão, o VI está configurado para criar uma tensão de entrada analógica 
simples.  Para configurá-lo para deformação, clique na seta do menu drop down e 
selecione Analog Input » Strain » Strain Gage. 
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Figura 12. O VI DAQmx Create Channel é chamado polimórfico porque ele se 

modifica para se adaptar ao tipo de medição selecionado. 
 

24. Para obter mais informações sobre esse VI, exiba a janela Context Help 
pressionando <Ctrl+H>.  
 
O Context Help fornece uma breve descrição de todas as coisas nas quais você 
coloca o cursor do mouse. Coloque o cursor sobre o VI DAQmx Create Channel  
para ver as entradas e saídas do VI. 
 
Para um canal de deformação, precisamos oferecer os canais que você está 
medindo e as informações do strain gage. Para disponibilizar essas entradas, 
conecte o VI conforme ilustrado na figura 13 clicando na entrada de cada nó do 
diagrama de blocos e, em seguida, clique novamente no terminal de entrada do 
target do VI DAQmx Create Channel. 
 

 
Figura 13. Conecte as entradas ao VI DAQmx Create Channel. 

 
25. Arraste os seguintes VIs da paleta DAQmx e posicione-os conforme ilustrado na 

figura 14. 
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a) DAQmx Timing 
b) DAQmx Start Task 
c) DAQmx Read 
d) DAQmx Stop Task 
e) DAQmx Clear Task 

 

 
Figura 14. O fluxo do código DAQmx quase sempre segue o mesmo padrão. 

 
Se você se lembra dos programas de exemplo que você analisou nos primeiros 
exercícios, o padrão do DAQmx quase sempre segue o mesmo fluxo.  Um canal é 
criado, parâmetros como triggering e temporização são configurados, a tarefa é 
iniciada, o canal é lido e depois a tarefa para e o canal é apagado.  
 

26. O VI DAQmx Timing  configura a taxa de amostragem, o modo de amostragem e a 
fonte de clock para sua tarefa. Você fará amostragens contínuas usando a fonte de 
clock on-board. Conecte o VI DAQmx Timing da seguinte forma: 

 
Figura 15. O VI DAQmx Timing configura seus parâmetros do clock. 

 
27. O VI DAQmx Start Task  transita o código para o estado de execução. Quando seu 

código tiver passado por esse VI, você estará pronto par ler ou escrever dados. 
Para saber mais sobre esse VI, confira se a janela do Context Help ainda está 
visível, <Ctrl+H>, e passe o cursor sobre o VI DAQmx Start. 
 

28. Após a tarefa ser iniciada, o VI DAQmx Read extrai dados do buffer do dispositivo 
DAQ. Da mesma forma que o VI DAQmx Create Channel, o VI DAQmx Read é 
polimórfico. Para configurar esse VI para ler dados do strain gage, clique na seta 
do menu drop down e selecione Analog » Single Channel » Multiple Samples » 
Waveform.  
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Figura 16. Selecione um canal de medição de forma de onda para ler a partir do 

strain gage fornecido. 
 

29. Conecte a saída do VI DAQmx Read  ao Strain Chart. Isso permitirá que o usuário 
visualize os dados no painel frontal.  
 

30. Os VIsDAQmx Stop e DAQmx Clear garantem que seu programa encerre 
adequadamente a comunicação e libera o hardware antes de parar o código.  Para 
saber mais sobre esses VIs, passe seu cursor sobre eles com a janela do Context 
Help visível.  
 

31. Conecte os fios de erro e tarefa nos fios conforme ilustrado na figura 17. Isso 
passará os valores da tarefa e quaisquer erros que possam surgir no código. 
 

 
Figura 17. Para concluir o código de aquisição de deformação, conecte os fios de 

erro e tarefa no código. 
 

Como o LabVIEW usa um fluxo de dados para forçar a ordem de execução, você 
pode visualizar os dados passando por cada fio, de um VI para o outro. Cada VI só 
será executado quando todas as entradas conectadas tiverem sido atribuídas.  
 
Conectar o fio de erro ao código garante que quaisquer erros que passarem pelo 
código sejam informados ao usuário.  
 

32. Conecte o fio de erro do VI DAQmx Read à entrada do VI Compound Arithmetic. 
Esse VI colocará uma porta OR nas entradas para interromper a execução do loop 
While.  O código que você acabou de escrever irá parar se ocorrer um erro ou se o 
usuário clicar no botão Stop.  
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Figura 18. O Compound Arithmetic faz uma ligação OR das entradas, 

interrompendo o loop While se houver algum erro no código ou se o usuário clicar 
em Stop. 

 
33. Quando você conectar o fio de erro ao Compound Arithmetic, seu código deve 

estar pronto para ser executado. Verifique se a seta de execução está intacta (
). 
 

34. Pressione <Ctrl+E> para alternar para o painel frontal.  
 

35. Pressione a seta do menu drop down no DAQmx Physical Channel para selecionar 
o canal correto.  Neste exercício, o strain gage deve ser anexado ao canal 0 do 
módulo NI 9236. Se você renomeou seus módulos corretamente em um exercício 
anterior, selecione Strain/ai0. 

 
Figura 19. Selecione o canal ao qual seu strain gage está conectado. 

 
36. Configure Strain Sample Rate para 10000 Hz e Samples Per Channel para 1000, 

como na figura 20.  
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Figura 20. Um bom princípio básico é configurar o número de amostragens em 

1/10 da taxa de amostragem. 
 

A taxa de amostragem determina o quão rápido seu dispositivo de aquisição de 
dados faz amostragem do canal selecionado. As amostragens por canal 
determinam quantos dados são extraídos do buffer de aquisição de dados cada 
vez que o loop é executado. No exemplo acima, o VI DAQmx Read irá esperar até 
que haja 1000 amostras no buffer antes de extraí-las do dispositivo de aquisição 
de dados.  Isso se traduz em uma atualização a cada 1/10  de um segundo. Se 
você alterar o Samples Per Channel para 10000, seu código será atualizado uma 
vez a cada segundo. Se você tiver erros no transbordo de buffer, geralmente 
significa que seu loop não está sendo executado de forma rápida o suficiente para 
extrair dados do dispositivo de aquisição de dados antes que o buffer esteja cheio. 
Tente aumentar o número do Samples Per Channel se for esse o caso. Em alguns 
casos, você pode precisar dividir seu código em dois loops paralelos.  Para obter 
mais informações sobre esse tipo de arquitetura, pesquise Producer Consumer no 
ni.com. 
 

37. Clique na seta de execução. Observe que ao pressionar delicadamente o strain 
gage, você pode ver as inflexões no gráfico em forma de onda.  
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Figura 21. Você criou um programa para visualizar os dados do strain gage. Esses 
dados podem ser analisados, salvos em um arquivo ou usados para controlar uma 

entrada. 
 

38. Clique em Stop. Salve esse VI, pois você irá utilizá-lo na próxima parte do 
exercício. 
 

39. Para concluir essa parte do exercício, abra o LabVIEW Example Finder 
selecionando Help » Find Examples.  
 

40. Navegue até Hardware Input and Output » DAQmx » Analog Input » Strain – 
Continuous Input.vi.  
 

41. Modifique o Physical Channel para Strain/ai0 (ou o canal ao qual seu strain gage 
está conectado), o Strain Configuration para Quarter Bridge I e o Voltage Excitation 
Value para 3.3.  Veja a figura 22 como referência.  
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Figura 22. As amostragens do DAQmx são criadas para proporcionar um sólido 

ponto de partida para seus programas. Use-as como um ponto de partida. 
 

42. Clique no botão de execução. O gráfico deve reagir quando você pressiona 
delicadamente a barra de deformação, da mesma forma que no seu código. Clique 
em Stop.  
 

43. Pressione <Ctrl+E> para abrir o diagrama de blocos.  Esse código inclui muito 
mais configurações específicas para as medições do strain gage do que o código 
que você acabou de criar, mas permite seguir exatamente o mesmo fluxo do 
DAQmx.  Além disso, esse código inclui funções data logging e triggering. Elas 
poderiam ser facilmente adicionadas ao seu código por meio da inclusão dos VIs 
apropriados.  
 

44. Feche esse VI de exemplo.  Quando for solicitado, não salve as alterações.  
 

Parte B Como controlar os LEDs coloridos para feedback do usuário 
Tempo estimado: 30 minutos 
 
Para essa parte do exercício, você adicionará o código criado na parte A.  
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Muitas vezes, os usuários precisam de feedback imediato de um sistema de medição e 
um monitor de computador pode não ser prático para aplicações como os sistemas de 
medição embarcados, monitoramento industrial ou controle de processo. Uma forma 
comum de alertar um operador sobre a condição do teste é usar a sinalização dos LEDs. 
Para essa parte do exercício, você usará seu código para alertar um usuário sobre o nível 
de deformação na barra de alumínio.  
 
Antes de iniciar esse exercício, verifique se os LEDs estão conectados adequadamente e 
se você pode controlá-los no Measurement & Automation Explorer.  
 

1. Comece abrindo o MAX (Start » All Programs » National Instruments » 
Measurement & Automation Explorer). 
 

 
Figura 22. Começar com os painéis de teste garante que seus sensores estejam 

funcionando e que você não terá problemas com o hardware. 
 

2. Clique com o botão direito no módulo NI 9472 e selecione Test Panels. Será 
aberto o seguinte painel: 

 

 
Figura 23. Com o teste de painel do módulo NI 9472, você pode controlar os 

canais de entrada digital para garantir que eles estejam sendo operados 
adequadamente. 
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3. Clique em Start. 

 
4. Selecione o botão All High como um teste rápido de todas as entradas digitais. 

Você deve ver todos os LEDs em sua demo box acenderem. Observe que os 
LEDs no módulo NI 9472 também acendem. Você pode controlar cada LED 
individualmente, mas para testar a operacionalidade isso não é necessário.  
 

5. Clique no botão Stop e feche o painel de teste.  
 

6. Abra uma cópia do Strain_w_User_Feedback_Exercise.vi.  
 

7. Pressione <Ctrl+E> para abrir o diagrama de blocos. 
 
Nessa parte do exercício, você adicionará o código para controlar os LEDs 
proporcionalmente à deformação sofrida pela barra de alumínio. Para adicionar 
esse código, você seguirá muitos dos mesmos passos utilizados na aquisição de 
deformação, mas dessa vez você escreverá dados, em vez de lê-los.  Você deve 
ver algumas sobreposições nos passos realizados.  
 

8. Da mesma forma que na parte A, grande parte do código virá da paleta DAQmx. 
Para acessar essa paleta, clique com o botão direito em qualquer espaço em 
branco no diagrama de blocos e navegue para Measurement I/O » NI-DAQmx. 
 

 
Figura 24. A paleta DAQmx inclui todos os VIs necessários para comunicação com 

seu chassi CompactDAQ. 
 

9. Clique na tachinha para deixar essa paleta visível (seta vermelha na figura 24).  
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Figura 25. Fixar a paleta permite que você clique em qualquer lugar no seu código 

com a paleta ainda visível.  
 

10. Para iniciar, arraste o NI-DAQmx Create Channel (seta vermelha na figura 25) e 
coloque-o na posição ilustrada na figura 26. 
 

 
Figura 26. O código da saída digital será executado paralelamente à tarefa de 

deformação. 
 

11. Use o menu drop down sob o VI para alterar o VI DAQmx Create Channel para 
saída digital. 

 
Figura 27. Escolha a saída digital para controlar a sinalização dos LEDs. 

 
12. Conecte o controle LED Channel à saída Lines do VI. Pressione <Ctrl+H> e 

coloque o cursor sobre o VI se você precisar de um lembrete de onde fica essa 
entrada.  
 

13. Arraste os seguintes VIs da paleta DAQmx e posicione-os conforme ilustrado na 
figura 28. 

a) DAQmx Start Task 
b) DAQmx Write 
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c) DAQmx Stop Task 
d) DAQmx Clear Task 

 

 
Figura 28. Esses VIs devem parecer familiar - quase todos os programas de 

aquisição de dados seguirão esse padrão. 
 

14. Altere o novo VI DAQmx Write para Digital » Single Channel » Single Sample » 1D 
Boolean (N lines). 
 

 
Figura 29. Você pode escrever um array nas linhas digitais no módulo NI 9472 

usando o VI DAQmx Write. 
 

15. Conecte os fios de erro e tarefa em cada um dos VIs DAQmx, como na figura 30.  
 

 
Figura 30. Conectar os fios de erro e tarefa determina o fluxo do código.  

 
16. Para tratar os erros adequadamente, você precisa garantir que seu loop While pare 

se seu código digital tiver um erro.  Para fazer isso, inicie expandindo o Compound 
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Arithmetic. Passe o cursor do mouse sobre o VI e arraste a alça para expor outra 
entrada.  
 

 
Figura 31. Expandir o Compound Arithmetic faz uma ligação OR de todas as 

entradas. 
 

17. Conecte o fio de erro da saída do VI DAQmx Write à nova entrada do Compound 
Arithmetic.  

 

 
Figura 32. Agora o Compound OR considera todos os erros dentro do loop While. 

 
18. No final do seu código, você precisará combinar todos os fios de erro, alertando ao 

usuário sobre quaisquer erros no código. Para fazer isso, expanda a função Merge 
Errors para expor a nova entrada.  
 

 
Figura 33. Combine todos os fios de erro em seu código com o VI Combine 

Errors. 
 

19. Conecte o fio de erro da saída do VI DAQmx Clear Task inferior à nova entrada da 
função Merge Errors. Seu código deve se assemelhar ao da figura 34.  
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Figura 34. Todos os seus fios de erro são compatíveis então o VI Simple Error 

Handler pode exibir os erros ao usuário. 
 

20. Agora que você tem o código para escrever dados nas saídas digitais, você 
precisará criar um código para traduzir os dados analógicos do strain gage para um 
nível digital. Felizmente, esse código já foi criado para você como um subVI. Para 
adicionar o subVI, clique com o botão direito em algum espaço em branco no 
diagrama de blocos e clique em Select a VI… 
 

 
Figura 35. Clique em 'Select a VI…' para localizar um subVI que não esteja visível 

em suas paletas. 
 

21. Navegue para 5 – Strain\Support VIs e selecione LED_Scaled_Output.vi. 
 

22. Posicione o VI conforme ilustrado na figura 36. 
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Figura 36. O VI LED_Scaled_Output é um subVI para escalar a entrada de 

deformação para uma entrada de LED. 
 
Uma forma alternativa de colocar o subVI em seu diagrama de blocos é navegar 
nele no Project Explorer e arrastá-lo para o diagrama de blocos, como na figura 37.  
 

 
Figura 37. Você pode arrastar quaisquer VIs do seu projeto para o diagrama de 

blocos. 
 

23. Organizar seu código nos subVIs é uma forma de tornar seu código mais 
gerenciável e escalável. Para analisar esses conteúdos do subVI, apenas clique no 
ícone para abrir o painel frontal do subVI. Reserve alguns minutos para examinar 
os conteúdos do subVI.  
 

24. Feche o subVI.  
 

25. Conecte a chamada ao subVI como na figura 38.  
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Figura 38. Esse subVI apresenta um array booleano que pode ser produzido pelo 

VI DAQmx Write. 
 

26. Seu código está pronto para ser executado. Alterne para o painel frontal e clique 
no botão de execução. Você deve notar que os LEDs acendem proporcionalmente 
a quantidade de força aplicada no strain gage.  
 
Se a escala parecer desligada, pressione a barra e anote os valores mais altos e 
mais baixos do gráfico. Pare o VI, ajuste os valores Range High e Range Low de 
forma que correspondam à faixa de deformação. Reinicie o VI e você deve ver os 
LEDs reagindo à pressão na barra de deformação.  
 

27. Se você observar o painel frontal e os LEDs, eles devem ser revertidos na forma 
que são exibidos. O indicador do painel frontal e os LEDs físicos podem facilmente 
ter um código correspondente.  Para trocar a ordem do indicador do painel frontal, 
comece excluindo o fio entre o subVI LED e o indicador LED no diagrama de 
blocos. Clique uma vez no fio, conforme mostrado na figura 39, e pressione 
Delete.  

 

 
Figura 39. Exclua o fio entre o subVI LED e o indicador LED. 

 
28. Para alternar a ordem de um array 1D, use a função Reverse 1D Array. Clique com 

o botão direito em um espaço em branco no diagrama de blocos. Selecione 
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Programming » Array » Reverse 1D Array.  
 

 
Figura 40. A paleta Array inclui muitos VIs proveitosos para a manipulação de 

array. 
 

29. Coloque o VI entre o subVI LED Out e o indicador LED Out e conecte-o como na 
figura 41. 

 

 
Figura 41. Use o array 1D reverso para trocar a ordem na qual o array booleano é 

exibido. 
 

 

<Fim do exercício> 



 

 

Equalizador de áudio 
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Exercício 1: Aquisição de sinal de áudio 

Observação: Esse exercício presume que você já tenha instalado o software requerido e configurado o 

hardware conforme descrito nas seções anteriores.  Se você ainda não o fez, consulte a seção 

apropriada que trata esse assunto. 

Objetivo:  O primeiro objetivo é adquirir continuamente 40000 arrays de ponto de dados da fonte 
de áudio conectada ao módulo NI 9215 (ou entrada analógica similar). 
 

 O segundo objetivo é adicionar o data logging ao VI DAQmx Task. 
 

Parte A 1. Inicialize o LabVIEW navegando no diretório Start » All Programs » National Instruments 
» LabVIEW 2014 » LabVIEW. 
 

2. Crie um novo projeto do LabVIEW selecionando o botão Create Project na janela Getting 
Started.   

 
3. Selecione Blank Project e, em seguida, Finish para criar um arquivo de projeto para 

armazenar todos os arquivos e referências para a aplicação. 
 

 
 

4. No Project Explorer recém-aberto do LabVIEW, navegue até File » Save As… e salve o 
projeto como cDAQ Hands On.lvproj dentro da pasta C:\Seminars\LV HO\Exercises\6 – 
Audio Equalizer. 

 
5. Dentro da janela do projeto do LabVIEW, clique com o botão direito em My Computer e 

selecione New » VI para criar um LabVIEW Virtual Instrument (VI) para adquirir dados. 
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6. Selecione File » Save para salvar o VI recém-criado.  Nomeie o VI “Exercise 1a” e salve 
o VI dentro da mesma pasta do projeto do LabVIEW. 
 

7. Navegue para a janela do diagrama de blocos do Exercise 1a.vi.  Se você estiver na 
janela do painel frontal, pressione <Ctrl+E> para alternar entre o diagrama de blocos e o 
painel frontal. 

 
8. Clique com o botão direito em um espaço vazio na janela para exibir a pateta Functions 

e navegar para Functions » Measurement I/O » NI-DAQmx. Essa é a paleta DAQmx 
Functions.   

a. Selecione agora a primeira função, DAQmx Create Virtual Channel.  Clique com 
o botão esquerdo na função e, em seguida, clique com o botão esquerdo para 
colocá-la no diagrama de blocos.  Essa função abre uma referência e reserva um 
dispositivo de hardware de aquisição de dados. 
  

b. Quando a função estiver no diagrama de blocos, clique com o botão esquerdo 
na caixa de seleção polimórfica branca e navegue para Analog Input » Voltage.  
Embora estejamos adquirindo um sinal sonoro, ainda vamos usar uma tensão 
porque é isso que um MP3 player apresenta. 

 

 
 

c. Para ver a janela Context Help, pressione <Ctrl+H> e passe com o cursor do 
mouse sobre o VI Create Channel para ver todas as entradas e saídas. 
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d. Passe o cursor do mouse no canto superior esquerdo do VI Create Channel e 
observe que o cursor muda automaticamente para a ferramenta de conexão e a 
tip-strip é exibida indicando o terminal no qual seu mouse está. 

 

 
 

e. Clique com o botão direito no terminal Physical Channels – o segundo terminal 
da parte superior – e selecione Create » Constant.  Essa constante só estará 
visível no diagrama de blocos, e não há controle ou indicador correspondente no 
painel frontal. 
 

f. Clique com o botão esquerdo na seta na constante Physical Channels e navegue 
até o canal de interesse, Voltage_in/ai1.   

 
g. Clique com o botão direito no terminal Input terminal configuration e selecione 

Create » Constant.  Defina o valor dessa constante como Differential.  
 

h. A próxima imagem exibe um diagrama comum de configuração de sensor.  
Neste exemplo, um termopar está conectado a um dispositivo CompactDAQ.  
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Ruído e outros sinais podem entrar no sinal através dos fios entre o sensor e o 
dispositivo de aquisição de dados, uma vez que os fios agem como antenas.  
Blindagem e outras técnicas podem ajudar a reduzir essa ação.  
 
A configuração da entrada do terminal é a forma mais fácil de eliminar uma 
grande parte do efeito do ruído.  As medições single-ended (RSE e NRSE) 
registram apenas o sinal positivo do sensor (ai+) e depois elas fazem referência 
a ele para o sistema ou terra do chassi (GND).  O terra do chassi geralmente não 
tem nenhum ruído nele e é representado pela linha preta indicada abaixo.  
Geralmente a linha do sinal tem ruído nela.   
 
Com as medições single-ended, o ruído continuará a ser visto porque os dados 
adquiridos serão a diferença entre o sinal com ruído e a linha GND sem ruído. 
 

 
 
 Configuração diferencial significa que o ADC irá calcular a diferença entre os 
pinos ai1+ e ai1- no dispositivo de aquisição de dados, que é a forma mais 
precisa de fazer medição a partir de um sensor, uma vez que ele elimina o ruído 
que é comum em ambos os fios positivo e negativo. 
 
 Sempre use essa configuração se ela estiver disponível para a aquisição do 
sensor.  O diagrama de blocos resultante deve se assemelhar a esse: 
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9. Clique com o botão direito no VI Create Channel  e navegue para DAQmx – Data 
Acquisition Palette » DAQmx Timing. Esse é um atalho para colocar rapidamente outra 
função da mesma paleta, NI-DAQmx. 
 

a. Clique para colocar o VI DAQmx Timing  à direita do VI Create Channel. 
 

b. Para alinhar as funções no diagrama de blocos, selecione segurando o 
<Shift> e clicando com o botão esquerdo nas funções.  Em seguida, 
selecione o botão Align Objects na barra de ferramentas e escolha Align Top 
Edges. 

 

 
 

c. Agora conecte as saídas Task Out e Error Out do VI Create Channel às 
entradas Task In e Error In do VI Timing, respectivamente. 
 

d. Se seu diagrama de blocos estiver bagunçado ou confuso, clique no botão 

Clean Up Diagram   ( ) na barra de ferramentas ou simplesmente 
pressione <Ctrl+U> para que o LabVIEW organize o diagrama 
automaticamente. 

 
e. Crie uma constante para o terminal de entrada Sample Mode e selecione 

Continuous Samples, o que significa que você irá adquirir dados 
continuamente até que a tarefa seja apagada. 

 
f. Crie uma constante para o terminal de entrada Rate e insira 40k para o valor.  

O LabVIEW pode interpretar abreviações métricas para unidades como ‘ ‘k’ 
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para milhares ‘ e ‘m’ para milhões. 
 

g. Crie uma constante para a entrada Source  e selecione OnboardClock. Isso 
significa que a tarefa irá usar os mecanismos de temporização para entradas 
analógicas no módulo NI 9215 para adquirir dados a uma taxa de 40k de 
amostragens por segundo. 

 
h. Crie uma constante para o terminal de entrada Samples per channel e defina 

o valor para 4k.  Isso significa que você irá adquirir 4k de amostragens toda 
vez que o VI DAQmx Read  for chamado correspondendo a um segundo dos 
dados.  Isso irá configurar o buffer para a transferência de dados do 
dispositivo DAQ para a memória do sistema.    

 
i. Um bom índice de referência é adquirir 1/10 da quantidade de amostragens 

como taxa de amostragem.  Não é necessário, mas você pode fazer isso 
programaticamente usando uma função Divide no LabVIEW.  Essa função 
está localizada na paleta Programming »  Numeric. 

 

 
 

10. Coloque um VI NI-DAQmx Start Task à direita do VI NI-DAQmx Timing e conecte os 
fios de erro e tarefa juntos em cada VI.  Essa função começará a aquisição de dados a 
partir do dispositivo e começará a armazenar dados na memória on-board FIFO do 
dispositivo. 
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11. Coloque um VI NI-DAQmx Read à direita do VI Start Task e conecte os terminais de 

erro e tarefa juntos em cada VI. 

 
 

a. Por padrão, a instância do VI polimórfico é configurada para Analog » Single 
Channel » Single Sample » DBL. Como iremos ler 4k de amostragens por 
vez, precisaremos alterar isso para Analog » Single Channel » Multiple 
Samples » Waveform. 

 
b. Clique com o botão direito no terminal de saída Data do VI DAQmx Read e 

crie um indicador.   
 

 
 

c. Localize o indicador no painel frontal.  Esse é um indicador Waveform, um 
indicador adequado para o tipo de dados, mas seria melhor visualizar os 
resultados em um gráfico. 
 

d. Clique com o botão direito no indicador Waveform no painel frontal e escolha 
Replace » Silver » Graph » Waveform Graph.  Um Waveform Graph irá exibir 
uma forma de onda completa dos dados e redesenhar o gráfico cada vez que 
ele receber novos dados em forma de onda. 
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e. No diagrama de blocos, conecte a constante Samples per Channel do VI 
DAQmx Timing à entrada Number of Samples per Channel do VI DAQmx 
Read. 
 

12. Retorne ao diagrama de blocos e coloque um VI NI-DAQmx Clear Task à direita do VI 
Read e conecte os fios Error e Task.   Isso irá limpar e eliminar todas as referências 
para o hardware. 
 

13. Coloque um VI Simple Error Handler à direita do VI Clear Task.  Ele está localizado na 
paleta Programming » Dialog and User Interface, mas você também pode usar o botão 
de pesquisa da paleta Functions. 

 
a. Conecte o terminal Error Out ao terminal Error In do VI Simple Error Handler.   
 
b. Como você conectou todos os terminais de erro juntos, os erros passarão de 

um VI para outro e depois serão tratados no final. Depois de tratados, será 
apresentada uma mensagem de erro se houver erros detectados. 

 
 

14. Para adquirir continuamente, você precisará usar uma estrutura de execução para 
repetir o código continuamente até que seja encontrada uma condição; isso é chamado 
loop While. 
 

a. No diagrama de blocos, abra a paleta Functions e navegue até Programming 
» Structures » While Loop.  Isso transformará seu cursor do mouse em um 
cursor com loop While. 
 

b. Clique com o botão esquerdo e arraste tudo que precisar ser executado 
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continuamente neste VI, que é a função DAQmx Read.  Solte o botão do 
mouse para concluir o desenho do loop. 

 

 
 

c. Observe os quadros que são criados nas bordas do loop While; esses são os 
túneis e são usados para passar dados de fora do loop para dentro do loop 
antes dele iniciar e, depois, de dentro para fora do loop após uma condição 
ser encontrada e o loop ser fechado. 
 

d. Tente executar o VI clicando na seta de execução - observe que a seta de 

execução está quebrada ( ), mas continue o processo e clique nela.  O VI 
não será executado, mas apresentará os erros que precisam ser 
solucionados antes que você possa executá-lo.  Aparecerá a janela Error list, 
e você poderá clicar em Show Error para o LabVIEW te levar para a fonte do 
erro. 

 

 
 

15. Agora você precisar conectar o controle booleano (verdadeiro/falso) ao terminal 
Conditional  

  ( ) do loop (que se assemelha a um sinal de interrupção).  Clique com o botão direito 
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e selecione Create » Control para criar um controle interativo - um botão Stop no painel 
frontal. 

 

 
 

16. Para garantir que o VI DAQmx Read receba os valores dos fios Task and Error que são 
passados de uma iteração para outra, você precisará usar os shift registers para passar 
dados. 
 

a. Clique com o botão direito no túnel do fio DAQmx Task lilás e selecione 
Replace with Shift Register.  Isso modificará o túnel de entrada para um shift 
register e depois permitirá que você selecione o terminal de entrada 
adequado.  Clique com o botão esquerdo no túnel de entrada para o fio 
DAQmx Task. 

 

 
 

b. Repita os túneis para o fio de erro. 
 

17. Para garantir que o VI feche o loop caso ocorra um erro dentro do loop, é preciso 
desagrupar o cluster de erro que contém um booleano com status de erro, um 
numérico com código de erro e uma string com fonte de erro. 
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a. Selecione o loop While no diagrama de blocos e expanda-o verticalmente 
para baixo e depois mova o terminal condicional e botão Stop para a parte 
inferior novamente para deixar espaço para mais funções dentro do loop. 
 

b. Na paleta Functions, navegue até Programming » Cluster, Class, & Variant » 
Unbundle by Name e coloque essa função no espaço vazio que você acabou 
de criar. 

 
c. Conecte o fio de erro da saída do VI DAQmx Read à entrada da função 

Unbundle by Name.  Isso irá preencher automaticamente todos os 
elementos do cluster de erro, e você pode clicar com o botão esquerdo para 
selecionar o elemento que você quer desagrupar.  Selecione Status. 

 

 
 

d. Agora, coloque a função Compound Arithmetic com a função booleana da 
porta OR com várias entradas.  Ela está localizada na paleta Functions sob 
Programming » Boolean.  Esse procedimento irá criar uma função OR com 
múltiplas entradas que apresentarão um booleano Verdadeiro se uma das 
entradas for Verdadeiro, o que irá parar a execução do loop While.  
Observação: você pode usar uma função básica de um operador booleano 
OR para esse exemplo, mas a função Compound Arithmetic é usada para 
garantir que você desenvolverá a aplicação em exercícios posteriores. 
 

e. Conecte a saída da função Compound OR ao terminal condicional do loop 
While. 
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18. Salve seu VI pressionando <Ctrl+S>. 
 

19. Navegue até o painel frontal e pressione o botão de execução ou simplesmente 
pressione <Ctrl+R> para executar o VI.  Verifique se a fonte de áudio está tocando uma 
música - por exemplo, no seu celular ou da tomada de saída de áudio do laptop que 
você está trabalhando. 

 
a. Você deve ver um sinal sonoro no indicador Waveform Graph semelhante ao 

da imagem abaixo. 
 

 
 
 

Parte B Essa seção explicará como registrar dados usando o formato TDMS.  Esse formato permite 
fácil organização de dados, alta taxa de transmissão para o disco e outras ótimas qualidades 
para o armazenamento de dados de engenharia.  A NI oferece um programa dedicado a 
operar e manipular dados no formato TDMS, o DIAdem.  Se você tem mais de 30k de 
amostragens no seu registro, você está se aproximando das limitações do Microsoft Excel 
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e o DIAdem é a ferramenta certa para você.   
 

1. Para registrar os dados adquiridos no exemplo anterior, somente uma (1) função 
precisa ser adicionada à cadeia do código NI DAQmx.  A equipe de pesquisa e 
desenvolvimento do DAQmx da National Instrumenta já criou um exemplo que tem 
essa função adicionada. 
 

a. Dentro do ambiente do LabVIEW, navegue até Help » Find Examples….  
Quando o Example Finder estiver carregador, navegue até Hardware Input 
and Output » DAQmx » Analog Input » Voltage – Continuous Input.vi.  Clique 
duas vezes para abrir esse exemplo. 

 

 
 

b. Explore o painel frontal.  Isso foi feito usando os indicadores e controles e 
estilos do painel frontal do LabVIEW. 
 

2. Pressione <Ctrl+E> para abrir o diagrama de blocos.  Observe o código.  Se a 
solução do exercício 1a ainda estiver aberta, compare seu código do diagrama de 
blocos com esse código.  Existem algumas diferenças neste diagrama de blocos em 
comparação com seu diagrama de blocos. 
 

a. No VI Create Channel, todas as entradas estão configuradas para serem 
controles em vez de indicadores.  Isso permite que o operador modifique 
facilmente as coisas diretamente do painel frontal, em vez de ter que ir para 
o diagrama de blocos.  Além disso, os terminais de entrada Max e Min 
Voltage têm controles.  Isso permite que você especifique a faixa do sinal de 
entrada.  Existem limites para essa faixa, e você pode consultar o 
documento de especificações para verificar esses limites. 
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b. No VI  Timing, são usados controles em vez de constantes.  Há também uma 
função avançada chamada Property Node.  Abra a janela do Context Help, 
<Ctrl+H>, e passe o cursor do mouse sobre o Property Node para obter 
mais informações.  Esse Property Node é usado para ler a ‘faixa 'real' do 
clock de amostragem.  Alguns temporizadores só podem fazer amostragem 
em determinadas faixas; se você não especificar uma dessas faixas, serão 
consideradas essas faixas. 

 

 
c. Veja abaixo um VI totalmente novo, o DAQmx Configure Logging (TDMS).vi.  

Ele permite que você transmita (registre) automaticamente os dados 
adquiridos em seu dispositivo de aquisição de dados diretamente em um 
disco usando o formato de arquivo Technical Data Management (TDM).  Se 
você estiver usando um sensor como um acelerômetro ou termopar que tem 
uma escala customizada, ele irá registrar nas unidades de engenharia 
escaladas. 
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d. Explore as demais funções do VI, tais como funções Read and Boolean OR,  
para observar um pouco mais de alterações. 
 

3. Para explorar as funções do data logging, volte ao painel frontal.  Localize a seção 
Logging Settings no painel frontal. 
 

a. Passe com o mouse na seção da pasta à direita do TDMS File Path e clique 
com o botão esquerdo para navegar para a localização adequada do arquivo.  
Isso permite que você navegue para o local do arquivo, mas você também 
deve inserir o nome do arquivo a ser criado antes de selecionar OK na janela 
Open Dialog.  Insira 'Exercise 1b Data' como o nome do arquivo, coloque o 
arquivo dentro da pasta do projeto e depois continue. 

 

 
 

b. Altere os controles no painel frontal para que eles fiquem iguais ao da 
imagem abaixo. 
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c. Execute o VI por alguns segundos e depois clique no botão Stop no painel 
frontal para concluir a aquisição.  Como não foram localizados erros, agora os 
dados devem ser registrados no arquivo. 
 

4. Se você tem o Excel instalado, você deve poder localizar e clicar duas vezes no 
arquivo para abri-lo diretamente no Excel.  Se não conseguir, você pode tentar 
primeiro abrir o Excel e depois abrir o arquivo do ambiente do Excel. 
 

a. Após abrir o arquivo no Excel, a guia raiz será a guia padrão de abertura.  
Essa guia contém altos níveis de informações sobre o arquivo, mas na 
verdade não tem os pontos de dados. 
 

b. Para ver os dados, navegue até 'the _unnamedTask<1> tab'. Essa guia tem 
todos os pontos de dados que foram adquiridos, e a linha da parte superior 
tem o nome do canal físico. 
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c. Você pode escolher representar graficamente e manipular os dados da 
maneira que você quiser. 

 
5. Feche o VI DAQmx Example, mas deixe seu VI do exercício aberto para o próximo 

passo. 
 

<O exercício continua na próxima página> 
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Exercício 2: Filtragem e FFT  

Objetivo:  Adicionar uma transformada rápida de Fourier (FFT) ao sinal de áudio para visualizar 
o sinal no espectro de frequência. 

 Adicionar um filtro passa baixa para remover as altas frequências do sinal de áudio. 
 Adicionar um filtro passa alta e passa banda para dividir o sinal em baixo, médio e 

agudo, atenuar os sinais e misturá-los novamente. 

 Criar um subVI de forma que ele contenha todas as funções de processamento de 
sinais. 
 

Parte A 1. Antes de colocar as funções de processamento de sinais, crie um espaço vazio dentro 
do loop While para essas funções. 

 
a. Enquanto segura o <Ctrl>, clique com o botão esquerdo e arraste para 

colocar um espaço em branco no diagrama de blocos dentro loop While. 
 

b. Faça o mesmo processo algumas vezes para se acostumar a como ele 
funciona.  Se você não gostar do resultado, pressione <Ctrl+Z> para 
desfazer a última ação. 

 
c. Veja um exemplo de como essa função funciona. 

 

 
 

2. Abra a paleta Functions, navegue para Signal Processing » Waveform Measurements » 
Power Spectrum and PSD e coloque esse VI à direita e embaixo do VI DAQmx Read. 
 

a. Conecte a saída data do VI DAQmx Read à entrada Time signal do VI Power 
Spectrum.   
 

b. Essa função irá calcular uma transformada rápida de Fourier (FFT), e 
apresentar um Power Spectrum, que exibe a potência de cada sinal para 
cada banda de frequência. 
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c. Crie um Waveform Graph no painel frontal e conecte a saída Power 

Spectrum / PSD à entrada desse gráfico. 
 

d. Conecte o Error Out do VI DAQmx Read ao Error In do 'II Filter' e depois 
conecte o Error Output ao shift register e à função Unbundle by Name 
 

 
 

3. Salve o VI. 
 

4. Execute o VI para observar o espectro de frequência do sinal de áudio. 
 

 
 
 

Parte B 1. Abra a paleta Functions, navegue para Signal Processing » Waveform Conditioning » 
Digital IIR Filter e coloque o VI entre o VI DAQmx Read e VI Power Spectrum para que 
o sinal seja filtrado antes de ser transformado no espectro de frequência.  Faça a 
conexão de acordo com os fios de sinal e erro.  Expanda o loop While se você precisar 
de mais espaço. 
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a. Crie uma constante para a entrada IIR Filter Specifications para o filtro.  
Esse é um cluster de dados que contém muitos itens.  Passe o mouse 
sobre cada um deles com a janela Context Help aberta para saber o que 
cada um deles representa. 

 

 
 

b. Crie as seguintes entradas para as constantes: 
i. Topology = Butterworth 
ii. Type = Lowpass 
iii. Order = 10 
iv. Lower Fc = 600 

c. Clique com o botão direito na borda do cluster e selecione View Cluster as 
Icon para minimizar seu espaço no diagrama de blocos. 
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d. Mova a constante do cluster para a esquerda e embaixo do filtro.  Seu 
diagrama de blocos deve se assemelhar a esse: 

 

 
 

2. Para visualizar o efeito do filtro e para descobrir a frequência de corte ideal para o filtro, 
seria melhor poder controlar a frequência de corte enquanto o programa está em 
execução.  Isso é possível com o LabVIEW! 
 

a. Você precisará modificar o componente Lower Fc da IIR Filter 
Specifications.  Coloque uma função Bundle by Name embaixo e à 
esquerda da função IIR filter. 
 

b. Conecte a saída do cluster à entrada input cluster na parte superior da 
função Bundle by Name. 

 

 
 

c. Conecte a saída da função Bundle by Name à entrada IIR Filter 
Specifications da função IIR Filter. 
 

d. Crie um controle para a entrada Lower Fc da função Bundle by Name. 
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e. Navegue até o painel frontal para localizar o controle numérico e substituí-lo 
por um Silver » Horizontal Numeric Pointer Slide.  Clique duas vezes no 
valor mínimo e altere-o para 1 e depois clique duas vezes no valor máximo e 
altere-o para 20k.   
 

f. A frequência mínima sempre deve ser maior do que zero, e a frequência 
máxima sempre deve ser menor ou igual ao Nyquist Frequency, que 
corresponde a ½ da frequência de amostragem, 40kHz neste exemplo. 

 

 
 

3. Salve o VI. 
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4. Execute o VI e modifique a frequência de corte enquanto o VI estiver em execução.  
Você consegue ver o efeito na frequência? 
 

 
 
 
 

Parte C 1. Agora que você conhece o efeito do filtro, você não precisa mais ter o controle no 
painel frontal.   
 

a. Exclua o controle Lowpass Frequency e remova a função Bundle by Name 
do diagrama de blocos.   
 

b. Altere o valor do Lower Fc para 600 dentro do cluster. 
 

c. Conecte a saída do cluster novamente à entrada IIR Filter Specifications da 
função IIR filter. 

 
2. Adicione mais dois filtros 'Digital IIR', um filtro passa banda para as frequências médias 

e um filtro passa alta para as frequências agudas.  Você precisará adicionar mais 
espaço no loop While para colocar mais dois filtros. 
 

a. Selecione toda a configuração do filtro clicando e arrastando para selecionar 
e, em seguida, segure <Ctrl>clique-arraste-e-solte para copiar as funções 
para os filtros adicionais para economizar tempo.  Você também pode 
selecionar vários itens de uma vez segurando <Shift> enquanto os 
seleciona. 
 

b. Conecte o terminal Error Out do filtro passa baixa ao terminal Error In do 
filtro passa banda.  Conecte o terminal Error Out do filtro passa banda ao 
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terminal Error In do filtro passa alta.  Conecte o terminal Error Out do filtro 
passa alta ao terminal Error In da função Power Spectrum.  Você precisará 
ajustar o espaço do diagrama de blocos novamente. 

 
c. O valor do Lower Fc do filtro passa banda deve sempre ser maior do que 

zero e menor do que o valor do Upper Fc do filtro passa banda.  Abra o 
cluster clicando duas vezes nele e configure o Lower Fc para 800 e o Upper 
Fc para 3000.  Altere o tipo para Bandpass. 
 

d. Ao contrário do que seria intuitivo, o filtro passa alta usa o Lower Fc para a 
frequência limite, e não o terminal Upper Fc.  Configure-o para 5000.  Altere 
o tipo para Highpass. 

 
e. Agora os filtros são apresentados em série de cascata para os fios de erro, o 

que é aceitável.  No entanto, não queremos executar o filtro em série; o filtro 
deve ser executado em paralelo para permitir que cada filtro exiba o sinal de 
som original.  Faça uma derivação da saída Data do VI DAQmx Read e 
conecte-a ao sinal no terminal de cada filtro. 
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3. Com a configuração acima, apenas o sinal filtrado do passa baixa será exibido.  No 
entanto, o objetivo do equalizador de áudio é misturar os sinais novamente após filtrar 
e atenuá-los. 
 

a. Para atenuar os sinais, a operação precisa acontecer no array de dados 
numéricos dentro da forma de onda em vez de em toda forma de onda.  Use 
a função Get Waveform Components para cada um dos três clusters em 
forma de onda para desagrupar o array de dados Y.   
 

b. Essa função está localizada em Programming » Waveform da paleta 
Functions.  Coloque três dessas funções e conecte a saída do Waveform de 
cada filtro à função. 

 
c. Coloque a função Multiply em cada array da plaleta Functions em 

Programming » Numeric e conecte cada um dos três arrays à entrada 
superior da função. 

 
d. No painel frontal, crie três controles Silver Numeric Vertical Pointer, para 

sinais baixo, médio e agudo, respectivamente. 
 

e. Configure a faixa de entrada de 0 a 1.0 para cada um deles. 
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f. Coloque cada controle dentro do loop While e conecte-os às respectivas 
funções Multiply. 

 
 

4. Para colocar os arrays juntos novamente, use a função Compound Arithmetic da 
mesma forma que você fez colocando as funções booleanas juntas no terminal 
condicional. 
 

a. Você pode copiar e colar a função Compound OR e alterar o modo ou colocá-
la a partir da paleta Functions Programming » Numeric. 
 

b. Expanda as três entradas e conecte os arrays nelas apropriadamente. 
 

c. Para criar novamente os arrays em uma forma de onda use a função Build 
Waveform e faça uma derivação da forma de onda anterior para usá-la como 
referência para a entrada input cluster na parte superior da função.   

 
d. Conecte a saída do Compound Arithmetic ao terminal Y da função Build 

Waveform. 
 

e. Conecte a forma de onda resultante ao VI Power Spectrum.  O código do 
diagrama de blocos dentro do loop While deve se assemelhar a esse: 

 

 
 

5. Salve o VI. 
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6. Execute o VI e configure o nível de atenuação dos sinais no painel frontal para 

visualizar o efeito dos filtros. 
 

Parte D 1. Agora o diagrama de blocos está ficando um pouco desorganizado e seria uma boa 
prática se você tentasse limpá-lo.  No LabVIEW, é possível fazer um subVI que é uma 
função que você cria e usa dentro de um VI maior.  Neste exemplo, faremos um subVI 
para todo o processamento de sinais. 

 
2. Para preparar o diagrama de blocos para criar um subVI, você precisa alinhar os 

controles (entradas) à esquerda e os indicadores (saídas) à direita.  Tudo que você 
quiser ocultar dentro do subVI deve estar alocado no centro.  Veja um exemplo: 

 
 

 
 

A seção azul ficará dentro do subVI e os fios que estão envoltos na seção vermelha 
serão as entradas e saídas da função do subVI. 

 
3. Para criar o subVI, clique com o botão esquerdo e arraste uma seleção sobre toda a 

seção azul. 
 

 
 

a. Após ter selecionado os itens, navegue até Edit » Create subVI. 
 

b. Isso colocará todos os itens dessa seção dentro de um novo subVI e 
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automaticamente criará controles e indicadores. 
 

 
 

4. Você pode prosseguir editando o ícone para o subVI e alterando a conexão se for 
necessário.  Clique duas vezes no subVI para começar esse processo.  Isso irá exibir 
o painel frontal do subVI. 
 

a. No canto superior direito do painel frontal do subVI, você encontrará o editor 
de terminais e o ícone do subVI. 

 

 
 

b. Clique duas vezes no ícone padrão para abrir o editor de ícones. 
 

c. Navegue no ambiente e edite os ícones conforme desejar.  É melhor 
adicionar um texto e escolher o ícone para indicar a funcionalidade desse 
subVI.  Você pode arrastar e soltar glifos da biblioteca e também pode copiar 
e colar imagens da internet. 
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d. Veja um exemplo de um ícone que você poderia usar, mas fique à vontade 
para criar seu próprio ícone.  Selecione OK quando você terminar. 

 

 
 

e. Agora vamos alterar a conexão e o terminal padrão.  É melhor manter as 
entradas à esquerda e as saídas à direita.  As partes inferior e superior 
geralmente são usadas para entradas opcionais e especificações.  Isso 
significa que precisamos ter cinco entradas à esquerda e mover o terminal 
de controle Treble para o lado esquerdo. 
 

f. Clique com o botão direito no editor de terminais, selecione Patterns » e, em 
seguida, selecione o padrão com 3 terminais inferiores, 3 superiores, 5 
saídas e 5 entradas. 

 

 
 

g. Agora você precisa alterar os terminais que estão mapeados para os 
controles.  Clique com o botão direito na entrada inferior na cor laraja que 
corresponde ao controle Mid-tone e selecione Disconnect This Terminal.  
 

h. Agora você precisará conectar novamente o controle Mid-tone ao terminal 
de entrada central.  Clique com o botão esquerdo no terminal de entrada do 
meio.  Observe que ele altera o ponteiro do mouse para a ferramenta de 
conexão. 

 

 
 

i. Agora você precisar clicar com o botão esquerdo no controle que você quer 
que seja mapeado para esse terminal, Mid-tone. 
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j. Você pode clicar com o botão esquerdo em qualquer terminal que já esteja 

atribuído a um controle e que irá destacar o controle associado. 
 

k. Repita esse processo para mapear o controle Treble para o terminal de 
entrada logo acima da entrada Error in e embaixo da entrada Midle-tone. 

 
l. Retorne para o diagrama de blocos e clique com o botão direito no fio da 

forma de onda que é a entrada da função Power Spectrum e cria um 
indicador.  Mapeie esse indicador para o terminal de saída central.  

 

 
 

m. Veja como todos os controles e indicadores devem estar mapeados. 
 

 
 

n. Salve o VI como SubVI Signal Processing dentro da pasta no seu desktop. 
 

o. Feche o subVI. 
 

5. Abra o diagrama de blocos do seu código principal e observe que o subVI está 
desativado.  Isso ocorre porque você precisa conectar o subVI novamente após 
alterar os terminais de entrada. 
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a. Clique com o botão direito no subVI e selecione Relink to subVI. 

 
b. Verifique se todas as conexões estão corretas agora.  Limpe o diagrama de 

blocos e condense o tamanho do loop While.  Veja como ficou o diagrama 
de blocos após ser limpo. 

 

 
 

6. Salve o VI.  Execute o VI para verificar se as funções ainda estão corretas. 
 

<O exercício continua na próxima página> 
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Exercício 3: Sinal processado na saída 

Objetivo:  Criar uma tarefa de entrada analógica para emitir um tom simples. 
 Modificar o código para gerar e apresentar uma forma de onda continuamente. 
 Adicionar esse código ao código da entrada analógica e apresentar o sinal de áudio 

filtrado. 

 Modificar o código para permitir duas entradas analógicas e duas saídas analógicas, 
uma vez que se trata de um sinal stereo com sinais de áudio à esquerda e à direita. 
 

Parte A 1. Crie um novo VI. 
 

2. No diagrama de blocos do seu VI, crie uma saída de tensão analógica para o Global 
Virtual Channel do NI-DAQmx colocando um VI DAQmx Create Virtual Channel e 
depois selecionando o tipo para Analog Output » Voltage. 

 
a. Configure a entrada para Voltage_out/ao0 
b. Defina a configuração do terminal de entrada como default. 

 
3. Crie um VI DAQmx Timing. 

 
a. Defina a faixa para 40k. 
b. Configure o modo de amostragem para Continuous. 

 

 
 

4. Por padrão, as tarefas da entrada de tensão analógica são configuradas para terem 
uma forma de onda pré-carregada no buffer de saída antes de iniciarem e, depois, 
regenerarem a forma de onda continuamente até que o VI DAQmx Task esteja limpo.  
Então, você precisa criar uma forma de onda. 
 

a. Navegue até a paleta Functions e depois até Programming » Waveform » 
Analog Waveform » Waveform Generation » Basic Function Generator e 
coloque a função acima do VI Sample Clock Timing. 
 

b. Navegue pelas entradas usando a janela Context Help, <Ctrl+H>. 
 

c. Coloque uma constante para frequência, amplitude, tipo de sinal   e 
informações de amostragem. 

 
d. Insira 800 para frequência, 0.005 para amplitude e Sine Wave para o tipo de 

sinal.  Nas informações de amostragem, insira 40k para taxa de amostragem 
(Fs) e 40k para quantidade de amostras (#s).  Você pode passar o cursor do 
mouse sobre os itens em um cluster para visualizar seu rótulo na janela 
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Context Help, mas, neste caso, isso não é importante, uma vez que eles 
têm o mesmo valor. 

 
e. Agora essa função irá gerar um tom de 800 Hz por segundo que é 

amostrado a 40kHz. 

 
 

5. Crie um VI DAQmx Write e coloque-o à direita do VI Sample Clock. 
 

a. Conecte adequadamente os fios de erro e tarefa do VI Sample Clock. 
 

b. Na parte superior do VI há um terminal, Auto-start, que iniciará a tarefa 
automaticamente após o buffer ser carregado.  Crie uma constante para 
essa entrada e selecione F para impedir que ela seja iniciada 
automaticamente. 

 
c. Conecte o signal out do VI Basic Function Generator à entrada data do VI 

DAQmx Write. 
 
6. Coloque um VI DAQmx Start Task depois do VI DAQmx Write. 

 
7. Crie um loop While pequeno à direita do VI Start Task e passe os fios de erro e tarefa 

através dele para fazer túneis. 
 

a. Crie um controle Stop Button e desagrupe o fio de erro para parar o loop se 
algum erro for detectado. 

b. Substitua os túneis por shift registers. 
 
8. Limpe a tarefa e coloque um tratador de erro simples que está localizado sob 

Programming » Dialog & User Interface. 
 

9. Esse VI irá apresentar um tom de 800Hz continuamente até que o botão Stop seja 
pressionado.  Execute o VI para testá-lo. 
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Parte B 1. Para atualizar o Output Waveform enquanto estiver em execução, você precisará alterar 
o comportamento padrão de permissão de regeneração. 

 
a. Clique com o botão direito no VI DAQmx Write, navegue para o diretório 

DAQmx – Data Acquisition Palette » DAQmx Write Property Node e coloque 
esse Property Node entre os VIs Sample Clock e DAQmx Write. 

b. Conecte os fios de erro e tarefa apropriadamente. 
c. Para o Property Node, selecione Regeneration Mode para a propriedade de 

interesse e crie uma constante.  Selecione Do Not Allow Regeneration. 
 

 
2. Aumente o tamanho do loop While para permitir uma cópia do VI Basic Function 

Generator e de todas as constantes. 
 

a. Copie e cole o VI Basic Function Generator dentro do loop While. 
b. Altere a constante Frequency para um controle. 
c. Navegue até o painel frontal e altere o controle numérico por um controle 

Silver Numeric Horizontal Pointer Slide. 
d. Configure os limites para o controle em 1 a 20k. 

 
3. Copie e cole o VI DAQmx Write dentro do loop While e conecte os fios de erro e tarefa 

apropriadamente. 
 

a. Configure o terminal Auto-Start para F se não estiver configurado ainda. 
b. Conecte o signal out do VI Basic Function Generator dentro do loop à 

entrada data do VI DAQmx Read. 
 



ni.com/daq  132 

 
 

4. Execute o VI e modifique a frequência durante o tempo de execução enquanto observa 
o Output Waveform.  
 
 

Parte C 1. Para usar o código da entrada analógica para reproduzir a entrada de áudio processada, 
você precisará adicionar seus novos códigos da entrada analógica ao VI que você criou 
para ler o som.  
 

a. Copie todo o código do diagrama de blocos do seu VI de entrada analógica e 
cole-o no diagrama de blocos da entrada analógica, conforme ilustrado na 
figura abaixo.  Você também pode selecionar o código de um diagrama de 
blocos e arrastar e soltá-lo em outro. 
 

 
 

2. O objetivo agora é integrar os dois loops While.  Como a geração e aquisição são 
interligadas e os dados precisam ser compartilhados entre si, eles precisam estar no 
mesmo loop While. 
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a. Você tem duas opções: remover um loop e adicionar código no outro loop, 

ou remover ambos e adicionar um novo loop While.   
b. O resultado é o mesmo, e é apenas de uma questão de preferência.  Você 

também precisará remover um botão Stop, já que não precisa mais dos dois. 
c. Seu diagrama de blocos deve se assemelhar a esse: 

 

 
 
3. Remova o VI Function Generator e todos seus controles e constantes conectadas 

dentro do loop While. 
 
4. Conecte o terminal Output Waveform do subVI Signal Processing ao terminal de 

entrada data do VI DAQmx Write. 
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5. Altere a amplitude do VI Function Generator antes do loop While para zero (0) para que 

haja atraso de um segundo sem som em vez de um tom de um segundo no início da 
saída inicial. 
 

6. Exclua um dos VIs Simple Error Handler, uma vez que é melhor ter apenas um tratador 
de erro por VI. 

 
a. Coloque a função Merge Errors para interligar os dois fios de erro navegando 

no diretório Programming » Dialog & User Interface. 
b. Conecte a saída Error de cada VI DAQmx Clear Task nas entradas da função 

Merge Error e conecte a saída dessa função à entrada do VI Simple Error 
Handler. 

 

 
 

7. Salve o VI.   
 

8. Execute o VI com sua fonte de reprodução MP3.  Alterne a atenuação e filtre as 
frequências.  Você consegue ouvir o efeito? 
 
 

 <Fim do exercício> 
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Como medir a vibração de um acelerômetro 
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Objetivo:  Na primeira parte deste exercício, você escreverá um programa para controlar a 

velocidade de uma ventoinha e adquirir dados de acelerômetros acoplados à ventoinha.  

 Na segunda parte, você irá adicionar um código para analisar o sinal de vibração no 

LabVIEW e no MathScript. 

 Os principais conceitos incluem:  

o Medições de acelerômetro 

o Como usar o API NI-DAQmx 

o Como usar os subVIs 

o Como combinar tarefas de controle e medições 

o Processamento de dados com o LabVIEW e MathScript 

 
Parte A Como medir a vibração de um acelerômetro 

Tempo estimado: 60 minutos 
 
Muitos sensores usados para medir aceleração e pressão são baseados no princípio da geração 
piezoelétrica. O efeito piezoelétrico indica a capacidade de materiais cerâmicos ou cristais de 
quartzo gerarem potencial elétrico ao sofrerem esforços de compressão. Esses esforços 
mecânicos são disparados por forças tais como aceleração, deformação ou pressão.   
 

 
Figura 1. Um acelerômetro usa uma massa sísmica para criar um sinal elétrico pequeno com 

base na geração piezoelétrica. 
 
No caso dos microfones, ondas de pressão acústica provocam vibrações em um diafragma ou 
em uma membrana fina, que transfere esses esforços aos cristais piezoelétricos colocados ao 
seu redor. Os acelerômetros, por outro lado, contém uma massa sísmica que aplica forças 
diretamente nos cristais colocados ao seu redor em resposta aos choques e vibrações. A 
tensão gerada é proporcional aos estresses internos nos cristais. 
 
Uma classe particular de sensores piezoelétricos, conhecida como sensores piezoelétricos 
eletrônicos integrados (IEPE), incorpora em seu projeto um amplificador nas proximidades dos 
cristais piezoelétricos. Como a carga produzida por um transdutor piezoelétrico é muito 
pequena, o sinal elétrico produzido pelo sensor é susceptível ao ruído; dessa forma, precisamos 
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usar circuitos eletrônicos sensíveis para amplificar e condicionar o sinal e reduzir a impedância 
de saída do sensor. Dessa forma, o IEPE faz o lógico em integrar seus circuitos eletrônicos 
sensíveis o mais próximo possível do transdutor, para garantir uma melhor imunidade ao ruído e 
tamanho conveniente. Um sensor IEPE típico é alimentado por uma fonte de corrente 
constante externa e modula a sua tensão de saída conforme a variação de carga no cristal 
piezoelétrico. O sensor IEPE usa apenas um ou dois fios, tanto para a excitação do sensor 
(corrente) quanto para a saída do sinal (tensão).  O módulo NI 9234 da série C em seu chassi 
CompactDAQ oferece essa fonte de corrente constante aos acelerômetros e microfones IEPE.  
 
Neste exercício, você irá medir a vibração de uma ventoinha usando o acelerômetro no Sound 
and Vibration Signal Simulator.   O módulo NI 9234 apresenta quatro canais de amostragem 
simultâneos e pode medir sinais de acelerômetros e microfones IEPE ou de outros tipos.   
 
Antes de inciar esse exercício, confirme se o acelerômetro está conectado adaquadamente e se 
você consegue fazer a aquisição de dados básicos a partir do canal conectado ao acelerômetro.  
 

1. Verifique se os LEDs Power e Ready, verde e amarelo respectivamente, estão acesos 

para confirmar que o chassi está conectado via USB e ligado.  

2. Analise a conexão no módulo NI 9234 para confirmar se os cabos BNC estão 

conectados à 'Aceleração em X', 'Aceleração em  Y' e 'Tach Out' no Sound and Vibration 

Signal Simulator. 

3. Abra o Measurement and Automation Explorer selecionando Start » All Programs» 

National Instruments » Measurement and Automation Explorer ou clicando duas vezes 

no ícone no seu desktop.  

4. Clique com o botão direito no módulo NI 9234 e selecione Test Panels.  

 

 
Figura 2. Selecione 'Test Panels' para abrir um utilitário simples para verificar a conectividade do 
sinal.  
 

5. Quando o painel de teste abrir, altere o Samples to Read para 2560 e o Mode para 

Continuous, selecione o botão ao lado do IEPE Enable e altere o tipo Coupling para AC, 
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conforme ilustrado na figura 3. 

6. Clique no botão Start. 

 

 
Figura 3. O painel de teste é usado para confirmar as conexões elétricas. 

 
7. Bata de leve ao lado da caixa para confirmar se o sensor reage à sua entrada. 

8. Clique no botão Stop e feche o painel de teste.  

Toda vez que você configurar uma nova medição ou sistema de medição, é uma boa prática 
confirmar se a conexão está correta e se todos os programas de software estão instalados e 
funcionando corretamente. O MAX proporciona percepção para seu sistema e configuração 
para ajudá-lo a eliminar os erros no início do seu processo de desenvolvimento.  
 

9. Após confirmar que seus sensores estão funcionando, minimize o MAX e selecione 

Start » All Programs » National Instruments » LabVIEW <Year>  para abrir o LabVIEW.  

10. Selecione File » Open e navegue para o diretório prático. O ponto de partida para esse 

exercício está localizado no diretório Hands-On Exercises\Vibration\Vibration Project. 

11. Clique duas vezes no Vibration Exploration.lvproj para abir o projeto de medição com 

acelerômetro.  Você deve ver a seguinte tela: 
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Figura 4. Use o LabVIEW Project para organizar todos os seus VIs. 

 
Com o LabVIEW Project você pode organizar e visualizar facilmente todos os arquivos que são 
importantes para sua aplicação.  Neste projeto em partciular, as pastas como Exercises, 
Solutions e Support VIs foram configuradas para serem preenchidas automaticamente com os 
arquivos dentro delas. 
 

12. Expanda as pastas para visualizar os arquivos dentro delas.  Você deve ver os seguintes 

VIs: 

 
Figura 5. Os VIs usados no seu projeto podem ser localizados nas pastas preenchidas 
automaticamente. 
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13. Comece abrindo o VI Solution – expanda o diretório My Computer » Solutions e clique 

duas vezes no Vibration main_solution.vi. 

14. Durante o restante desse exercício, você irá criar o VI exibido na figura 6. Verifique se a 

chave no Sound and Vibration Signal Simulator está acionada manualmente para BNC. 

Clique no botão de execução. 

 
Figura 6. Esse VI irá adquirir sinais de vibração no domínio do tempo e calcular o conteúdo da 

frequência usando os VIs do LabVIEW e MathScript. 
 

15. Usando o botão no centro da tela, ajuste a velocidade da ventoinha e observe a reação 

no domínio do tempo e domínio da frequência. A análise do domínio da frequência é 

crucial para muitos tipos aplicações de monitoramento. 

16. Clique na guia do MathScript PS e veja que as informações do domínio da frequência 

são exatamente as mesmas.  

17. Pressione o botão Stop e feche 'Solution' sem salvá-la.  

18. Para iniciar o exercício, clique duas vezes no Vibration main_exercise.vi. O painel frontal 

já foi criado para você.  

Ao começar um novo programa, iniciar com um projeto do painel frontal é uma boa forma de 
organizar quais serão as entradas e saídas dele.  Quando você define como você quer que um 
usuário interaja com o código, você pode começar a escrever o VI para suportar essa função.  
 
Durante esse exercício, você irá arquitetar esse VI para controlar a velocidade de uma ventoinha 
e adquirir dados de um acelerômetro no Sound and Vibration Signal Simulator.  Além disso, 
você irá usar o LabVIEW e MathScript para calcular os componentes de frequência do sinal 
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adquirido.  

 
Figura 7. Começar com um projeto do painel frontal é uma boa forma de organizar quais serão 

as entradas e saídas do seu programa. 

19. Observe que a seta de execução no canto direito superior está quebrada ( ). Isso 

ocorre porque o código contém erros ou, neste caso, não está em um estado de 

execução. O LabVIEW compila continuamente no ambiente de edição, então você 

sempre saberá se seu código pode ser executado.  Clicar na seta de execução quando 

ela está quebrada apresentará uma lista de erros. Tente clicar na seta de execução. Se 

eu código for compilado sem erros, a seta de execução não será quebrada novamente (

). 

20. Feche a caixa de diálogo de erro e selecione Window » Show Block Diagram. O atalho 

do teclado para esse comando é Ctrl + E. Use o atalho para alternar entre o painel frontal 

e o diagrama de blocos. Quando o diagrama de blocos abrir, você verá o seguinte 

código: 
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Figura 8. O diagrama de blocos faz o trabalho do seu programa. É aqui que você escreverá o 

código para controlar o painel frontal. 
 
Como o código foi inicializado, o diagrama de blocos já inclui alguns elementos básicos.   Cada 
elemento no painel frontal tem um elemento correspondente no diagrama de blocos. Para 
localizar o elemento correspondente do painel frontal, você pode clicar duas vezes no elemento 
no diagrama de blocos para destacá-lo.  Tente clicar duas vezes no ícone do LabVIEW PS. Em 
seguida, clique duas vezes no mesmo item no painel frontal.  Essa é uma forma prática de 
localizar os itens no painel frontal e no diagrama de blocos.  
 
Os quadros em amarelo claro são anotações. Você pode criar anotações no diagrama de blocos 
apenas clicando duas vezes sobre ele.  É sempre uma boa prática documentar adequadamente 
seu código para que você (se voltar uma semana mais tarde) ou outra pessoa possa entender o 
que está acontecendo.  
 

21. Agora que você está familiarizado com os elementos do programa, você pode começar a 

criar o código para adquirir dados de deformação. Para começar, verifique se seu 

diagrama de blocos está visível. 

22. Neste exercício, uma grande parte do código virá da paleta DAQmx. Para acessar essa 

paleta, clique com o botão direito em qualquer espaço em branco no diagrama de blocos 

e navegue até  Measurement I/O » NI-DAQmx, conforme demonstrado na figura 9.  
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Figura 9. A paleta DAQmx inclui todos os VIs necessários para comunicação com seu chassi 

CompactDAQ. 
 

23. Clique na tachinha para deixar essa paleta visível (seta vermelha na figura 9).  

 
Figura 10. Fixar a paleta permite que você clique em qualquer lugar no seu código com a paleta 

ainda visível.  
 

24. Para iniciar, arraste o NI-DAQmx Create Channel (seta vermelha na figura 10) e coloque-

o na posição ilustrada na figura 11.  
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Figura 11. O VI DAQmx Create Channel determina a comunicação com seu dispositivo de 

aquisição de dados. 
 

25. Por padrão, esse VI está configurado para criar uma tensão de entrada analógica 

simples.  Para configurá-lo para medições com acelerômetro, clique na lista do menu 

drop down sob o VI e selecione Analog Input » Acceleration » Accelerometer. 

 
Figura 12. O VI DAQmx Create Channel é chamado polimórfico porque ele se modifica para se 

adaptar ao tipo de medição selecionado. 
 

26. Para obter mais informações sobre esse VI, exiba a janela Context Help pressionando 

<Ctrl+H>.  

O Context Help fornece uma breve descrição de todas as coisas nas quais você coloca o cursor 
do mouse. Coloque o cursor sobre o VI DAQmx Create Channel  para ver as entradas e saídas 
do VI.  
 
Para um canal do acelerômetro, precisamos apresentar a lista do canal que você está medido e 
as informações específicas do sensor. Para exibir essas entradas, conecte o VI conforme 
ilustrado na figura 13.  
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Figura 13. Conecte as entradas ao VI DAQmx Create Channel. 

 
27. Arraste os seguintes VIs da paleta DAQmx e posicione-os conforme ilustrado na figura 

14. 

a) DAQmx Timing 

b) DAQmx Start Task 

c) DAQmx Read 

d) DAQmx Stop Task 

e) DAQmx Clear Task 

 
Figura 14. O fluxo do código DAQmx quase sempre segue o mesmo padrão. 

 
Se você se lembra dos programas de exemplo que você analisou nos primeiros exercícios, o 
padrão do DAQmx quase sempre segue o mesmo fluxo.  Um canal é criado, parâmetros como 
triggering e temporização são configurados, a tarefa é iniciada, o canal é lido e depois a tarefa 
para e o canal é apagado. 
 

28. O VI DAQmx Timing  configura a taxa de amostragem, o modo de amostragem e a fonte 
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de clock para sua tarefa. Você fará amostragens contínuas usando a fonte de clock on-

board. Conecte o VI DAQmx Timing da seguinte forma: 

 
Figura 15. O VI DAQmx Timing configura seus parâmetros do clock. 

 
29. O VI DAQmx Start Task  transita o código para o estado de execução. Quando seu 

código tiver passado por esse VI, você estará pronto par ler ou escrever dados. Para 

saber mais sobre esse VI, confira se a janela do Context Help ainda está visível, 

<Ctrl+H>, e coloque o cursor sobre o VI DAQmx Start. 

30. Após a tarefa ser iniciada, o VI DAQmx Read retira dos dados do buffer do dispositivo 

DAQ. Da mesma forma que o VI DAQmx Create Channel, o VI DAQmx Read é 

polimórfico. Para configurar esse VI para ler dados do strain gage, clique na seta do 

menu drop down e selecione Analog » Single Channel » Multiple Samples » Waveform.  

 
Figura 16. Selecione um canal de medição de forma de onda para ler a partir do acelerômetro 

fornecido. 
 

31. Conecte a saída Data do VI DAQmx Read ao gráfico Time Domain. Isso permitirá que o 

usuário visualize os dados no painel frontal. Além disso, conecte o fio do Waveform à 

função Get Waveform Components - você verá essa função mais adiante durante esse 

exercício. 
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Figura 17. A função Get Waveform Components divide os dados de forma de onda no array de 

pontos (Y), no delta entre os pontos (dt) e no tempo de início (t0). 
 

32. Os VIs DAQmx Stop e DAQmx Clear garantem que seu programa encerre a 

comunicação adequadamente e libera o hardware antes de parar o código.  Para saber 

mais sobre esses VIs, passe seu cursor sobre eles com a janela do Context Help visível.  

33. Conecte os fios de erro e tarefa no código. Isso passará os valores da tarefa e quaisquer 

erros que possam surgir do código.   

 
Figura 18.  A tarefa e os erros dentro do seu código passarão pelos fios para caixa de diálogo de 

usuário no final do seu código. 
 
Como o LabVIEW usa um fluxo de dados para forçar a ordem de execução, você pode visualizar 
os dados passando por cada fio, de um VI para o outro. Cada VI só será executado quando 
todas as entradas conectadas tiverem sido atribuídas.  
 
Conectar o fio de erro ao código garante que quaisquer erros que passarem pelo código sejam 
informados ao usuário. 
 

34. Conecte o fio de erro do VI DAQmx Read à entrada do VI Compound Arithmetic. Esse VI 

colocará uma porta OR nas entradas para interromper a execução do loop While.  O 

código que você acabou de escrever irá parar se ocorrer um erro ou se o usuário clicar 

no botão Stop. 
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Figura 19. O Compound Arithmetic faz uma ligação OR das entradas, interrompendo o loop 

While se houver algum erro no código ou se o usuário clicar em Stop. 
 

35. Quando você conectar o fio de erro ao Compound Arithmetic, seu código deve estar 

pronto para ser executado. Verifique se a seta de execução está intacta ( ). 

36. Pressione <Ctrl+E> para alternar para o painel frontal.  

37. Pressione a seta do menu drop down no Vibration Channel para selecionar o canal 

correto.  Neste exercício, o acelerômetro está conectado ao canal 0 ou canal 1 do 

módulo NI 9234. Se você renomeou seus módulos, selecione Sound_Vibration/ai1. 

 
Figura 20. Selecione o canal ao qual seu acelerômetro está conectado. 

 
38. Configure o Sample Rate para 10000 Hz e Samples Per Channel para 1000, como 

ilustrado na figura 21.  
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Figura 21. Um bom princípio básico é configurar o número de amostragens para 1/10  da taxa 

de amostragem. 
 
A taxa de amostragem determina o quão rápido seu dispositivo de aquisição de dados faz 
amostragem do canal selecionado. As amostragens por canal determinam quantos dados são 
extraídos do buffer de aquisição de dados cada vez que o loop é executado. No exemplo acima, 
o VI DAQmx Read irá esperar até que haja 1000 amostras no buffer antes de extraí-las do 
dispositivo de aquisição de dados.  Isso se traduz em uma atualização a cada 1/10  de um 
segundo. Se você alterar o Samples Per Channel para 10000, seu código será atualizado uma 
vez a cada segundo. Se você tiver erros no transbordo de buffer, geralmente significa que seu 
loop não está sendo executado de forma rápida o suficiente para extrair dados do dispositivo de 
aquisição de dados antes que o buffer esteja cheio. Tente aumentar o número do Samples Per 
Channel se for esse o caso. Em alguns casos, você pode precisar dividir seu código em dois 
loops paralelos.  Para obter mais informações sobre esse tipo de arquitetura, pesquise Producer 
Consumer no ni.com. 
 

39. Clique no botão de execução. Agora você está adquirindo dados de vibração do 

acelerômetro no Sound and Vibration Signal Simulator.  Confira se a chave no Sound and 

Vibration Signal Simulator está configurada para DIAL e tente aumentar e diminuir a 

velocidade da ventoinha.  Observe a modificação do sinal na tela.  

Muitas vezes, os sinais do domínio do tempo de som ou sinais de vibração não podem lhe 
informar o que está acontecendo com o dispositivo que está sendo monitorado.  O FFT é talvez 
o processamento mais comum no domínio do tempo de som ou de sinais de vibração.  O 
próxima parte do exercício lhe mostrará como adicionar processamento de sinais usando o 
LabVIEW e o MathScript Node.  
 

40. Clique em Stop. Salve esse VI, pois você irá utilizá-lo na próxima parte do exercício. 

Parte B Como controlar a velocidade da ventoinha com a saída analógica 
Tempo estimado: 25 minutos 
 
Muitas vezes, o código de aquisição de dados precisa fazer mais do que simplesmente medir 
um sinal.  Adicionar um controle ao código permite que o operador use o software para 
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controlar algo.  Isso poderia ser uma entrada digital, como um alarme ou sinal de velocidade 
WM, ou uma entrada analógica, como uma forma de onda de estímulo.  Neste exemplo, você 
usará um sinal de tensão DC para controlar a velocidade da ventoinha que foi controlada com 
um botão externo na primeira parte deste exercício.  
 
Antes de iniciar este exercício, altere a chave do controle físico Fan Speed para BNC.  
 

1. Para iniciar este exercício, abra o diagrama de blocos do VI Vibration Main_Exercise. 

2. Nesse exercício, uma grande parte do código virá da paleta DAQmx. Para acessar essa 

paleta, clique com o botão direito em qualquer espaço em branco no diagrama de blocos 

e navegue até  Measurement I/O » NI-DAQmx, conforme demonstrado na figura 22.  

 
Figura 22. A paleta DAQmx inclui todos os VIs necessários para comunicação com seu chassi 

CompactDAQ. 
 

3. Clique na tachinha para deixar essa paleta visível (seta vermelha na figura 22).  
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Figura 23. Fixar a paleta permite que você clique em qualquer lugar no seu código com a paleta 

ainda visível.  
 

4. Para iniciar, arraste o NI-DAQmx Create Channel (seta vermelha na figura 23) e coloque-

o na posição ilustrada na figura 24. 

 
Figura 24. O mesmo VI para criação e aquisição de canal é usado para criar uma geração de 

canal, mas você pode alterar a instância polimórfica usando o menu drop down. 
 

5. Para configurar esse VI para geração, clique no menu abaixo do VI e selecione Analog 

Output » Voltage. 

 
Figura 25. O VI polimórfico DAQmx Create Channel pode ser configurado para criar um valor da 

entrada analógica. 
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6. Conecte o VI conforme ilustrado na figura 26.  

 

 
Figura 26. Neste caso, a única coisa que você precisa conectar é a entrada do canal à entrada 

dos canais físicos. 
 

7. Como no exercício anterior, arraste os VIs a seguir para o diagrama de blocos e 

posicione-os conforme ilustrado na figura 25.  

a) DAQmx Create Channel 

b) DAQmx Start Task 

c) DAQmx Write 

d) DAQmx Write 

e) DAQmx Stop 

f) DAQmx Clear 

 
Figura 27. Mais uma vez, o fluxo do DAQmx, até mesmo para a saída, segue aproximadamente 

o mesmo padrão. 
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Você deve ter notado que você colocou dois VIs DAQmx Write. Isso ocorre porque o último 
valor no buffer de saída persistirá mesmo após a tarefa ter sido interrompida ou limpa.  Neste 
exemplo, pode ser que você tenha uma ventoinha sendo executada após interromper o código, 
dependendo do último valor.  Para garantir que a execução da ventoinha seja sempre 
interrompida quando o código for parado, escreva o valor zero no buffer antes de parar e limpar 
a tarefa. 
 
Neste exercício, escreveremos uma amostragem simples no canal de entrada analógica do 
módulo NI 9263 cada vez que o loop for executado, então a instância padrão do VI DAQmx 
Write funcionará em seu programa. 
 

8. Conecte o controle Fan Speed à entrada Data do primeiro VI DAQmx Write. 

9. Conecte a constante 0 ao lado do segundo VI DAQmx Write conforme ilustrado na figura 

28. 

 
Figura 28. O segundo VI DAQmx Write escreve zero no buffer para garantir que a ventoinha 

seja desligada quando o VI é interrompido. 
 

10. Abra o VI Merge Errors para mostrar outra entrada.  O VI Merge Errors é o segundo VI 

da parte final, entre o Clear Task e Error Handler. 

11. Conecte os fios de erro e tarefa ao código, conforme visto na figura 29.  

 
Figura 29. Os fios de erro e tarefa comunicam as informações entre cada um dos VIs no código. 
 

12. Alterne para o painel frontal.  

13. Configure o Fan Speed Channel para Voltage_out/ao1. Esse é o canal para o módulo de 

saída de tensão conectado ao controle da ventoinha no Sound and Vibration Signal 

Simulator. 
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Figura 30. Usando uma saída analógica, você pode controlar a velocidade da ventoinha no 

Sounds and Vibration Signal Simulator. 
 

14. Clique no botão de execução. 

15. Ajuste a velocidade da ventoinha usando o botão do controle Fan Speed. Você deve 

observar que o sinal de vibração no domínio do tempo aumenta e diminui com a 

velocidade da ventoinha. 

16. Pare o VI e salve seu trabalho. Você irá configurar a próxima parte deste exercício. 

 
 

Parte C Como adicionar análise ao seu código de aquisição de dados 
Tempo estimado: 25 minutos 
 
Em aplicações reais, os sinais de tensão medidos são formas de onda complexas, que contêm 
diversos componentes de frequência. A análise do som e da vibração normalmente envolve 
identificação e análise desses componentes de frequência. Para fazer isso, precisamos 
converter matematicamente os sinais do domínio do tempo ao domínio da frequência, usando 
transformadas de Laplace, Z- ou Fourier. A análise de Fourier é a mais comumente usada para 
essa aplicação, porque obtém a magnitude e a fase associada para cada componente de 
frequência presente em um sinal.  
 
Na próxima parte do exercício, você irá calcular o espectro de potência usando dois métodos.  
O primeiro método usará os VIs do LabVIEW e o segundo irá integrar o.m script para calcular o 
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mesmo espectro de potência. Usando esse espectro, você pode calcular a frequência e 
amplitude da vibração para determinar o equilíbrio de uma ventoinha. 

1. Para iniciar esse exercício, abra o diagrama de blocos do VI Vibration Main_Exercise.  

2. Clique com o botão direito no diagrama de blocos e selecione Signal Processing » 

Waveform Measurements » FFT Power Spectrum and PSD, conforme ilustrado na 

figura 31. 

 
Figura 31. O LabVIEW contém muitas funções de análise integradas e muitas outras são 

suportadas através de kits de ferramentas e add-ons. 
 

3. Coloque o VI FFT Power Spectrum na posição mostrada na figura 22. 
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Figura 32. O VI FFT Power spectrum irá calcular o espectro de frequência durante a aquisição. 

 
4. Conecte as entradas do VI conforme ilustrado na figura 33.  

 
Figura 33. O Power Spectrum será calculado cada vez que o loop no código for executado. 

 
5. Para saber mais sobre esse VI, pressione Ctrl+H para exibir a janela Context Help e 

passe o cursor sobre o VI FFT Power Spectrum.  Se você quiser saber mais ainda sobre 

esse VI, clique no link Detailed Help.  

6. Com o VI FFT Power Spectrum conectado, abra o painel frontal e execute o VI. Você 

deve poder ver as informações sobre a frequência do acelerômetro on-board.   

7. Tente aumentar e diminuir a velocidade da ventoinha. Observe que o domínio do tempo 

e domínio da frequência são alterados. Tente mudar a chave no Sound and Vibration 

Signal Simulator de 'Balanced Fan' para 'Unbalanced Fan'.  Observe a alteração do sinal.  

Medições como essas são comumente usadas para diagnóstico da integridade da 

máquina. 
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Figura 34. A partir do sinal do domínio da frequência, você pode entender mais sobre o que 

está acontecedo em seu sistema. 
 
Enquanto o LabVIEW inclui funções de análise abrangentes, algumas vezes a situação pode 
exigir integração com outras linguagens, como .m script.  Na próxima parte do exercício, você 
fará a mesma análise usando o MathScript Node, que permite que você integre seus arquivos 
.m script no seu programa do LabVIEW. 
 

8. Pare o VI e abra o diagrama de blocos. 

9. Clique com o botão direito no diagrama de blocos e selecione Mathmatics » Scripts and 

Formulas » MathScript Node. 
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Figura 35. O MathScript Node integra o código gráfico do LabVIEW com o texto baseado no .m 

script. 
 

10. Arraste um pequeno quadro na posição mostrada na figura 36.  

 
Figura 36. Quando você colocar o MathScript Node, deixe um pouco de espaço para você 

digitar um texto pequeno. 
 

11. Neste exercício, você precisará usar os componentes da forma de onda do domínio do 

tempo. Para fazer isso, você usará o Get Waveform Attributes, que já foi colocado no 
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seu diagrama de blocos (seta vermelha na figura 36). Quando você passar o cursor do 

mouse sobre essa função, devem aparecer alças de redimensionamento.  Arraste as 

alças para baixo.   

 
Figura 37. Arraste o Get Waveform Attributes para baixo para adicionar o atributo dt. 

 
12. Clique na parte dos atributos e selecione 'dt'.  Agora você está separando os valores Y 

da forma de onda do domínio do tempo e a alteração do tempo entre cada um dos 

pontos de amostragem. 

13. Antes de você fazer referência aos dados do código do LabVIEW dentro do MathScript 

Node, você precisa definir os valores que serão entrada e saída do nó. Para fazer isso, 

clique com o botão esquerdo na borda do MathScript Node e selecione Add Input. 

Nomeie essa entrada como 'dt'.   

14. Clique com o botão direito no lado esquerdo novamente, selecione Add Input e nomeie 

essa entrada como 'Y'.  

15. Clique com o botão direito novamente na borda e selecione Add Input.  Nomeie essa 

outra entrada como 'dt'.  



ni.com/daq  160 

 
Figura 38. Adicione as entradas do MathScript Node clicando com o botão direito na borda dele. 
 

16. Abra o m script text.txt no diretório dos VIs de suporte no Project Explorer do LabVIEW. 

 
17. Quando o arquivo abrir, pressione Ctrl+A para selecionar todo o texto e, em seguida, 

pressione Ctrl+C para copiar. 
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Figura 39. O m script text.txt inclui todos os passos necessários para fazer a análise de 

frequência usando o MathScript. 
 

18. Navegue para o diagrama de blocos.  

19. Clique com o botão esquerdo no MathScript Node e depois pressione Ctrl+v para colar o 

texto. Seu MathScript Node deve se assemelhar ao da figura 40.  

 
Figura 40. Você pode colar quaisquer funções .m script no MathScript Node para fazer 

matemática textual in-line com seu código gráfico. 
 

20. Quando seu texto estiver inserido, você pode adicionar as saídas ao MathScript Node.  

para fazer isso, clique com o botão direito na borda do MathScript Node e selecione Add 

Output»df. 
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Figura 41. Clique com o botão direito na borda do MathScript Node para adicionar as entradas. 

 
21. Clique com o botão direito na borda novamente e selecione Add Output»freq.   

Ao introduzir a alteração na frequência (df) e a potência dessa frequência (freq), você pode criar 
um gráfico para representar visualmente o espectro de potência enquanto os dados estão 
sendo adquiridos. 
 

22. Conecte as saídas do VI Get Waveform Components nas entradas respectivas do 

MathScript Node (à esquerda do MathScript Node), conforme ilustrado na figura 41.  

 
23. Para criar o gráfico, você precisará agrupar os valores em um cluster (um cluster é uma 

forma de agrupar elementos de diferentes tipos de dados, que estão fora do escopo 

dessa aula, mas são integralmente abordados no treinando sob demanda).  Clique com o 

botão direito no diagrama de blocos e selecione Programming»Cluster, Class & 

Variant»Bundle, como na figura 42.  
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Figura 42. Use a função Bundle para combinar os elementos que você precisa para criar o 

gráfico. 
 

24. Coloque essa função no local mostrado na figura 43.  
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Figura 43. Coloque a função Bundle entre a entrada do gráfico PS MS e o MathScript Node. 

 
25. Para adicionar outra entrada, passe o cursor do mouse sobre a função Bundle e depois 

clique e arraste o puxador que aparecer.   

 
Figura 44. Arraste a entrada para baixo para adicionar outra entrada. 

 
26. Adicione a constante zero no diagrama de blocos clicando com o botão direito no 

diagrama de blocos e selecionando Programming»Numeric»DBL Numeric Constant e 

coloque-a na mesma posição indicada na figura 46. 
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Figura 45. A constante DBL Numeric é simplesmente uma constante numérica que você pode 

usar no diagrama de blocos sem precisar de nenhuma entrada do painel frontal. 
 

27. Conecte a função Bundle conforme ilustrado na figura 46.  

 
Figura 46. A função Bundle combina as funções que são tipos de dados diferentes. 

 
28. Alterne para o painel frontal e execute o VI.  

29. Tente alternar entre o domínio da frequência calculado do LabVIEW e o domínio da 
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frequência calculado do MathScript clicando entre as guias.   

 
Figura 47. Os códigos do MathScript e do LabVIEW calculam e exibem exatamente o mesmo 

domínio da frequência. 
 
O que você acabou de ver é a integração do código externo, baseado em texto ao ambiente 
gráfico do LabVIEW.  Com essas ferramentas, você pode escolher a abordagem mais eficaz 
para lidar com um problema, seja ela baseada em texto ou gráfica, todas no mesmo ambiente 
LabVIEW.  
 

30. Pare e salve o VI. Deixe esse VI aberto para o próximo exercício. 

Parte D Alarme baseado em vibração 
Tempo estimado: 20 minutos 
 
As medições com acelerômetros podem ser usadas para aplicações como teste estrutural, 
teste de ruído-vibração-desconforto ou diagnóstico da integridade da máquina. Para última parte 
desse exercício, você precisará medir a magnitude da vibração e alertar o usuário/operador 
quando o valor limite for excedido. Para obter informações mais detalhadas sobre a integridade 
da máquina e monitoramento de ativos, acesse ni.com/mcm. 
 

1. Para começar essa parte do exercício, navegue até o diagrama de blocos do VI Vibration 

Main Exercise. 

2. Neste exercício, você extrairá a frequência básica e fará um teste de um limite 

determinado pelo usuário.  Para extrair esse tom, clique com o botão direito no diagrama 
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de blocos e navegue até Signal Processing»Waveform Measurements»Extract Tone, 

conforme ilustrado na figura 48. 

 

 
Figura 48. Selecione Extract Tone para medir a amplitude do tom de potência mais alto no 

domínio da frequência. 
 

3. Coloque o VI no local indicado na figura 49 e conecte as entradas e saída conforme 

ilustrado.  Se você precisar de ajuda para saber sobre essas diferentes entradas, 

pressione Ctrl+h para abrir a janela Context Help e verifique o lembrete exibido.   
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Figura 49. Conecte a forma de onda do domínio do tempo ao VI Extract Tone para obter a 

frequência e amplitude do tom de potência mais alto. 
 

4. Alterne para o painel frontal. 

5. Se você executar o VI, você deve ver a amplitude e tom detectados nos indicadores do 

painel frontal.  

6. Pare a execução do VI. 

Com as informações da frequência e tom calculadas, tudo que está à esquerda é para adicionar 
uma comparação e alarme.  
 

7. Coloque a função Greater? da paleta Comparison (figura 50) no local indicado na figura 

51. 
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Figura 50. A função Greater? irá comparar dois números e apresentar um booleano Verdadeiro 

se o número superior for maior do que 
 

8. Conecte a função Greater? conforme ilustrado na figura 51. 
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Figura 51. A função de comparação Greater? compara a amplitude do maior tom de potência 

com um valor especificado pelo usuário. 
 

9. Abra o painel frontal e execute o VI. Verifique se a chave no Sound and Vibration Signal 

Simulator está configurada para Unbalanced Fan.  

10. Modifique a velocidade da ventoinha ajustando o botão no painel frontal.  Observe que 

em velocidades mais altas, o Fan Warning irá mostrar que há um problema na ventoinha.  

11. Se você não conseguir acender o alarme da ventoinha, tente reduzir a entrada Max Vib 

Level (figura 52).  
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Figura 52.  Esse VI deve se comportar como o 'Solution' que você abriu no início deste 

exercício. 
 

12. Pare e salve o VI.  

<Fim do exercício> 
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Como usar tablets com os sistemas de medição 
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Objetivo:  Na primeira parte deste exercício, você escreverá um programa para controlar a 

velocidade de uma ventoinha e adquirir dados de acelerômetros acoplados à ventoinha.  

 Na segunda parte, você usará um tablet para exibir e controlar remotamente o sistema 

de medição. 

 Os principais conceitos incluem:  

o Medições de acelerômetro 

o Como usar o DAQ Assistant  

o Comunicação de dados 

o Como combinar tarefas de controle e medições 

o Como integrar tablets para visualização e controle 

 
Parte A Como medir a vibração limite de um acelerômetro e alarme 

Tempo estimado: 20 minutos 
 
Neste exercício, você irá medir a vibração de uma ventoinha usando o acelerômetro no Sound 
and Vibration Signal Simulator.  O módulo NI 9234 apresenta quatro canais de amostragem 
simultâneos e pode medir sinais de acelerômetros e microfones IEPE ou de outros tipos.   
 

1. Selecione Start » All Programs » National Instruments » LabVIEW <Year> para abrir o 

LabVIEW, se ele não estiver aberto ainda.  

2. Na janela Getting Started, selecione o botão Create Project ou use o menu para 

selecionar File » Create Project. 

3. Na caixa de diálogo Create Project, selecione Blank Project e escolha Finish para criar 

um novo projeto em branco.  Você deve ver a seguinte janela: 

 
Figura 1. Use o LabVIEW Project para organizar todos os seus VIs. 

 
Com o LabVIEW Project você pode organizar e visualizar facilmente todos os arquivos que são 
importantes para sua aplicação incluindo VIs, documentação, arquivos de suporte e targets de 
desenvolvimento. 
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4. Dentro da janela Project Explorer, selecione File » New VI. 

5. Dentro da janela do painel frontal, clique com o botão direito em qualquer espaço em 

branco para acessar a paleta Controls.   

6. Dentro da paleta Controls, selecione Silver » Graph » Waveform Graph. 

 
Figura 2. A paleta Controls contém todos os elementos do controle e indicador usados para 

preencher a interface de usuário do VI. 

7. Clique com o botão esquerdo para colocar o Waveform Graph próximo à parte superior 

do seu painel frontal. 

8. Coloque o cursor do mouse sobre o Waveform Graph até a alça de redimensionamento 

aparecer. 

9. Clique e arraste a alça de redimensionamento para expandir o tamanho horizontal do 

Waveform Graph.  

 
Figura 3. Use as alças de redimensionamento para customizar o tamanho do Waveform Graph. 

10. Clique com o botão direito em qualquer local no Waveform Graph e use o menu de 

contexto para desfazer a seleção da opção Y Scale » AutoScale Y.  
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11. Clique duas vezes no valor máximo do eixo Y (por padrão, mais de 10) e use o teclado 

para alterar o valor para 0.1. 

12. Clique duas vezes no valor mínimo do eixo Y (por padrão, menos de 10) e use o teclado 

para alterar o valor para -0.1. 

 
Figura 4. Redimensione o eixo Y para se adequar melhor ao sinal que será adquirido. 

13. Dentro da janela do painel frontal, clique com o botão direito no espaço em branco para 

acessar a paleta Controls e selecione Silver » Boolean » Stop Button. 

14. Clique com o botão esquerdo no botão Stop abaixo do Waveform Graph. 

15. Dentro da janela do painel frontal, clique com o botão direito em qualquer espaço em 

branco para acessar a paleta Controls e selecione Silver » Numeric » Numeric Indicator. 

16. Clique com o botão esquerdo no indicador numérico abaixo do Waveform Graph.   

17. Clique duas vezes no rótulo do indicador numérico e use o teclado para renomear o 

indicador RMS Value.  O painel frontal deve se assemelhar ao da imagem abaixo: 

 
Figura 5. Painel frontal concluído do LabVIEW com todos os elementos da interface de usuário. 

18. Alterne da janela do painel frontal para o diagrama de blocos usando o mouse ou 
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pressione o atalho do teclado <Ctrl + E>. 

19. Dentro da janela do diagrama de blocos, clique com o botão direito em qualquer espaço 
em branco para acessar a paleta Functions e selecione Programming » Structures » 
While Loop. 

20. Clique com o botão esquerdo e arraste um retângulo em torno dos três terminais do 

diagrama de blocos (englobando-os) e solte o botão do mouse para colocar o loop While. 

 
Figura 6. Desenhe um loop While que englobe os terminais do diagrama de blocos. 

 
21. Clique com o botão direito no terminal do botão Stop próximo ao terminal condicional 

Stop do loop While. 

22. Coloque o cursor do mouse sobre a saída do terminal do botão Stop. 

23. Clique com o botão esquerdo na saída do terminal do botão Stop.  Clique novamente 

com o botão esquerdo na entrada do terminal condicional Stop do loop While.   

Isso irá conectar os terminais para que o loop While pare de ser executado quando o usuário 

pressionar o botão Stop no painel frontal. 

 
Figura 7. Conecte o botão Stop ao terminal condicional Stop do loop While. 

24. Dentro do diagrama de blocos, clique com o botão direito em qualquer espaço em 

branco para acessar a paleta Functions e selecione Measurement I/O » NI-DAQmx » 
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DAQ Assistant.  

25. Clique com o botão esquerdo no DAQ Assistant dentro e próximo à borda esquerda do 

loop While.  

26. Quando a caixa de diálogo 'Create New…' aparecer, selecione Acquire Signals » Analog 

Input » Acceleration. 

27. Selecione o canal físico ai1 do módulo Sound_Vibration (NI 9234) e selecione Finish.   

Esse canal é fisicamente conectado à Aceleração em Y do acelerômetro montado dentro do NI 

Sound and Vibration Signal Simulator. 

28. Dentro da caixa de diálogo de configuração DAQ Assistant, modifique o Sensitivity para 

175. 

29. Dentro da caixa de diálogo de configuração DAQ Assistant, modifique o Acquisition 

Mode para Continuous Samples. 

30. Dentro da caixa de diálogo de configuração DAQ Assistant, modifique o Samples to 

Read para 1k. 

31. Dentro da caixa de diálogo de configuração DAQ Assistant, modifique Rate (Hz) para 

10k. 

 
Figura 8. Customize as propriedades de temporização e sensibilidade de aquisição. 

32. Selecione o botão OK para fechar a caixa de diálogo. 
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33. Clique com o botão esquerdo do mouse na saída Data do DAQ Assistant.  Clique 

novamente com o botão esquerdo na entrada do Waveform Graph para conectar os 

dados adquiridos ao gráfico.  

34. Clique com o botão direito no diagrama de blocos para acessar a paleta Functions e 

selecione Express » Signal Analysis » Amplitude & Level Measurements. 

35. Clique com o botão esquerdo para colocar o VI Expresso à direita do DAQ Assistant no 

loop While. 

36. Dentro da caixa de diálogo de configuração Configure Amplitude and Level 

Measurements, coloque uma marca de seleção no quadro para medição de amplitude 

RMS. 

 
Figura 9. Adicione um cálculo para medição de amplitude RMS. 

37. Selecione o botão OK para fechar a caixa de diálogo. 

38. Clique com o botão esquerdo do mouse na saída Data do DAQ Assistant.  Clique 

novamente com o botão esquerdo na saída Signals do VI Expresso Amplitude and Level 

Measurements para conectar os dados adquiridos ao cálculo de análise. 

39. Clique com o botão esquerdo do mouse na saída RMS do VI Expresso Amplitude and 

Level Measurements.  Clique novamente com o botão esquerdo na entrada do teminal 

do indicador RMS Value para conectar o valor do RMS ao indicador do painel frontal.  

40. Agora o diagrama de blocos deve se assemelhar ao da imagem abaixo: 
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Figura 10. Diagrama de blocos para aquisição básica com acelerômetro e análise do RMS. 

41. Clique com o botão direito no diagrama de blocos para acessar a paleta Functions e 

selecione Measurement I/O » NI-DAQmx » DAQ Assistant. 

42. Clique com o botão esquerdo para colocar o DAQ Assistant2 à direita do VI Expresso 

Amplitude and Level Measurements no loop While. 

43. Quando aparecer a caixa de diálogo 'Create New…', selecione Generate Signals » 

Digital Output » Line Output. 

44. Selecione o canal físico port0/line7 do módulo Digital_out (NI 9472) e selecione Finish.   

Esse canal é fisicamente conectado ao LED vermeho, LED7, na demo box de medição do 

CompactDAQ. 

45. Dentro da janela de configuração DAQ Assistant, deixe tudo como padrão e selecione 

OK. 

46. Clique com o botão direito no diagrama de blocos para acessar a paleta Functions e 

selecione Programming » Comparison » Greater?. 

47. Clique com o botão esquerdo para colocar a função 'Greater?' à esquerda do VI 

Expresso DAQ Assistant2 Express. 

48. Clique com o botão esquerdo na saída RMS do VI Expresso Amplitude and Level 

Measurements.  Clique novamente com o botão esquerdo na entrada X da função 

'Greater?' para conectar o valor calculado do RMS ao cálculo de comparação.    

49. Clique com o botão direito na entrada Y da função 'Greater?' e selecione Create » 

Constant no menu de contexto.  

50. Usando o teclado, altere o valor da constante numérica para 0.015. 

51. Clique com o botão esquerdo na saída X > Y? da função 'Greater?'.  Clique com o botão 
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esquerdo novamente na entrada Data do VI Expresso DAQ Assistant2 para conectar o 

resultado booleano da operação de comparação à entrada digital. 

 
Figura 11. Se o valor do RMS for maior do que 0.015, será apresentado digitalmente um valor 

Verdadeiro. 

52. Mude da janela do diagrama de blocos para a janela do painel frontal usando o mouse ou 

pressione o atalho do teclado <Ctrl + E>. 

53. Na demo box de medição do hardware CompactDAQ, verifique se a chave do controle 

Fan Speed no Sound and Vibration Signal Simulator está configurada para Dial. 

54. Na demo box de medição do hardware CompactDAQ, verique se a chave do Fan 

Selection está configurada para Unbalanced Fan. 

55. Selecione a seta de execução ( ) para testar as funções do VI.  Enquanto o VI estiver 

em execução, ajuste a velocidade da ventoinha usando 'Dial' do controle da velocidade 

da ventoinha do Sound and Vibration Signal Simulator. 

Quando a ventoinha gira em velocidades baixas, observe como o sinal de Aceleração em Y 

detectado não exibe um padrão visível e o sinal é praticamente perdido no ruído.  Quando a 

ventoinha gira em altas velocidades, a amplitude da aceleração deve subir juntamente com o 

valor calculado do RMS e o sinal da Aceleração em Y deve se assemelhar a uma onda 

sinusoidal com 'ruído'.  Além disso, o LED7 do hardware deve indicar um alto nível da vibração 

medida. 

Na verdade, o sinal "com ruído' detectado é composto de duas ondas sinusoidais – uma 

representando a transformação da ventoinha e a outra representando as hélices da ventoinha. 
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Figura 12. A Aceleração em Y é claramente sinusoidal quando está em rotação do valor máximo 

do RPM. 
 

56. Selecione o botão Stop do painel frontal para parar a execução do VI.  

57. Na janela do painel frontal, selecione File » Save All.  

58. Quando for solicitado para nomear o projeto, use a caixa de diálogo do Windows 

Explorer para criar um novo subdiretório chamado 8 - Tablets localizado dentro do 

diretório C:\Seminars\LV HO\Exercises.  

59. Salve o projeto como Tablets.lvproj dentro do diretório C:\Seminars\LV HO\Exercises\8 - 

Tablets. 

60. Quando for solicitado para nomear o VI, salve o VI como Tablets.vi dentro do diretório 

C:\Seminars\LV HO\Exercises\8 - Tablets.  Deixe o VI aberto - você precisará dele para a 

próxima parte do exercício. 

 
 
Parte B 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Como integrar visualização móvel com tablets 
Tempo estimado: 20 minutos 
 
Neste exercício, você irá integrar um tablet para visualizar os dados da Aceleração em Y e LED 
Alarm.  Embora esse exercício tenha sido escrito usando imagens tiradas de um iPad, a 
funcionalidade será a mesma com um tablet Android.  No entanto, as aplicações parecerão 
visualmente diferentes devido às diferenças nos temas e controles nativos entre os sistemas 
operacionais iOS e Android. 
 
Esse exercício presume que seu tablet já esteja operando o aplicativo Data Dashboard for 
LabVIEW, versão 2.2 ou mais recente.  Se não estiver instalado ainda, faça o download 
gratuitamente na App Store do iOS ou no Google Play.   
 

1. Para começar essa parte do exercício, verifique se o projeto Tablets.lvproj ainda está 

aberto.  Se não estiver, localize e abra-o a partir do disco no diretório C:\Seminars\LV 
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HO\Exercises\8 – Tablets.  

2. Alterne para a janela Project Explorer do Tablets.lvproj usando o mouse. 

3. Clique com o botão direito na entrada do My Computer dentro da estrutura de hierárquia 

do projeto Tablet e selecione  New » Variable no menu de contexto. 

 
Figura 13. Adicione uma nova variável ao projeto Tablets. 

4. Na caixa de diálogo Shared Variable Properties, insira Fan Vibration no campo Name. 

5. Altere o tipo de dados para Array of Double. 

6. Selecione o botão OK para fechar a caixa de diálogo Shared Variable Properties, que 

adicionará a shared variable Fan Vibration ao projeto. 

 
Figura 14. A variável 'Fan Vibration' enviará os dados de vibração através da rede. 

7. Clique com o botão direito na entrada Untitled Library dentro da estrutura de hierarquia do 

projeto Tablets e selecione New » Variable no menu de contexto. 

8. Na caixa de diálogo Shared Variable Properties, insira Alert no campo Name. 

9. Altere o tipo de dados para Boolean. 

10. Selecione o botão OK para fechar a caixa de diálogo Shared Variable Properties, que 
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adicionará a shared variable Alert ao projeto. 

11. Clique com o botão direito na entrada Untitled Library dentro da estrutura de hierarquia 

do projeto Tablets e selecione New » Variable no menu de contexto. 

12. Na caixa de diálogo Shared Variable Properties, insira Fan Speed no campo Name. 

13. Altere o tipo de dados para Double. 

14. Selecione o botão OK para fechar a caixa de diálogo Shared Variable Properties, que 

adicionará a variável Fan Speed ao projeto.  Agora o projeto deve conter o seguinte: 

 
Figure 15. Agora o projeto Tables contém três shared variables. 

15. Usando o mouse, alterne da janela de projeto para o diagrama de blocos do VI Tablets.  

Se ele não estiver mais aberto, clique duas vezes no VI Tablets na janela do projeto, abra 

o VI e alterne entre as janelas do painel frontal e do diagrama de blocos pressionando o 

atalho do teclado <Ctrl + E>. 

16. Organize as janela do diagrama de blocos e do Project Explorer do LabVIEW para que 

você possa ver as duas janelas na tela ao mesmo tempo.   

17. Dentro da janela Project Explorer do projeto Tablets, clique com o botão esquerdo e 

arraste a variável Alert e solte-a no diagrama de blocos abaixo do DAQ Assistant2 dentro 

do loop While. 

 
Figura 16. Arraste e solte a variável Alert no diagrama de blocos. 
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18. Após colocar o terminal, clique com o botão direito no terminal da shared variable Alert 

no diagrama de blocos e selecione Access Mode » Write no menu de contexto. 

 
Figura 17. Alterar o Access Mode to Write permite que você envie dados à shared variable 

através da rede. 

19. Clique com o botão esquerdo na saída X>Y? da função 'Greater?'.  Clique com o botão 

esquerdo na entrada do terminal da shared variable Alert para conectar o resultado 

booleano da função 'Greater?' à shared variable para comunicar os dados através da 

rede. 

20. Dentro da janela Project Explorer do projeto Tablets, clique com o botão esquerdo e 

arraste a variável Fan Vibration e solte-a no diagrama de blocos abaixo do VI Expresso 

Amplitude and Level Measurements dentro do loop While. 

21. Após colocar o terminal, clique com o botão direito no terminal da shared variable Fan 

Vibration no diagrama de blocos e selecione Access Mode » Write no menu de 

contexto. 

22. Clique com o botão esquerdo na saída Data do DAQ Assistant.  Clique com o botão 

esquerdo na entrada do terminal da shared variable Fan Vibration para conectar os dados 

de vibração adquiridos à shared variable para comunicar os dados através da rede. 

23. Agora o diagrama de blocos deve se assemelhar ao da imagem abaixo: 
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Figura 18. Além de adquirir dados de vibração e alertar após um valor limite ser excedido, dados 

pertinentes são publicados através da rede. 

24. Dentro das janelas do diagrama de blocos e do Project Explorer, selecione File » Save 

All. 

25. Quando for solicitado para nomear a Variable Library, salve a biblioteca como Fan 

Variables.lvlib dentro do diretório C:\Seminars\LV HO\Exercises\8 - Tablets.  

26. Usando as funções de configuração de rede do seu laptop, confirme se você está 

conectado à rede WiFi ad hoc desse seminário.  Se tiver dúvidas em como fazê-lo, fale 

com seu instrutor. 

27. Usando as funções de configuração de dispositivo do tablet iPad ou Android, confirme 

se você está conectado à rede WiFi ad hoc desse seminário.  Se tiver dúvidas em como 

fazê-lo, fale com seu instrutor. 

Se não houver nenhuma rede ad hoc disponível, verifique se os dispositivos estão conectados  

à  mesma rede WiFi. 

28. No tablet iPad ou Android, abra o aplicativo  Data Dashboard for LabVIEW. 

29. Na janela Dashboards Overview, selecione o botão Add ( ) e escolha New Dashboard.  

Quando for solicitado, selecione o layout Landscape. 
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Figura 19. Com o aplicativo Data Dashboard for LabVIEW, você pode criar, gerenciar e 

compartilhar diversos dashboards ao mesmo tempo. 

30. Na barra de menu no canto superior direito do dashboard 'Untitled 1', selecione o botão 

Controls and Indicators ( ) para adicionar um novo elemento da interface ao 

dashboard. 

31. Na caixa de diálogo Controls and Indicators, selecione Indicators. 

32. Na caixa de diálogo Indicators arraste e solte um gráfico na parte esquerda da tela em 

branco do dashboard. 

 
Figura 20. Com o aplicativo Data Dashboard for LabVIEW, você pode criar seus próprios layouts 

customizados para visualização de dados. 
 

33. Usando as alças de redimensionamento no indicador Graph, arraste para expandir o 

tamanho do Waveform Graph para que ele ocupe aproximadamente a metade superior 

da parte em branco do dashboard. 

34. Toque uma vez com seu dedo para selecionar o Graph Indicator. 

35. Selecione o botão Properties ( ) e feche os eixos do gráfico.  
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36. Altere Y Scale » Y Minimum para -0.1 e Y Scale » Y Maximum para 0.1. 

37. Mude a chave de duas posições Y Scale » Y Autoscale para a posição Off. 

38. Na barra de menu no canto superior direito do dashboard 'Untitled 1', selecione o botão 

Controls and Indicators ( ) para adicionar um novo elemento da interface ao 

dashboard. 

39. Na caixa de diálogo Controls and Indicators, selecione Indicators. 

40. Na caixa de diálogo Indicators arraste e solte um LED na parte inferior esquerda da tela 

em branco do dashboard. 

41. Usando as alças de redimensionamento no indicador LED arraste para expandir o 

tamanho do LED. 

 
Figura 21. Adicione e redimensione um indicador LED na parte inferior esquerda da tela em 

branco do dashboard. 

42. Na barra de menu no canto superior direito do dashboard 'Untitled 1', selecione o botão 

Image ( ) para adicionar um novo elemento de imagem ao Dashboard. 

43. Na caixa de diálogo Photo, selecione Take Photo. 

44. Usando a câmera do tablet, tire uma foto da configuração do hardware físico. 

45. Na caixa diálogo Preview, selecione Retake se você quiser substituir a foto.  Quando 

você estiver satisfeito, selecione Use. 

46. Usando as alças de redimensionamento na nova imagem fotográfica, arraste para 

reduzir o tamanho da foto. 

47. Arraste a imagem fotográfica reorganizando-a no o canto direito inferior da tela do 

dashboard. 
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48. Agora seu dashboard deve se assemelhar à imagem abaixo: 

 
Figura 22. Adicionar uma foto da configuração do hardware físico é uma boa forma de lembrar 

como as coisas estavam conectadas quando você estiver usando um tablet para monitorar 
remotamente um sistema. 

 
49. Toque uma vez com seu dedo para selecionar o Graph Indicator. 

50. Selecione o Data Link Adorner ( ) que aparece logo abaixo do indicador Graph. 

51. Na caixa diálogo Connect, selecione Shared Variables. 

52. No computador, use o mouse para selecionar a janela Project Explorer do LabVIEW para 

o projeto Tablets. 

53. Clique com o botão direito na biblioteca da shared variable Fan Variables.lvlib e selecione 

Deploy All no menu de contexto. 

 
Figura 23. Implantar a biblioteca publica as shared variables para acesso na rede. 

54. Quando aparecer a caixa de diálogo Deployment Progress, permita que a shared variable 
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seja totalmente implantada. 

55. Anote o endereço IP apresentado dentro da caixa de diálogo Deployment Progress.  

Esse é o endereço IP do computador que você está trabalhando, que servirá de host 

para as shared variables.  Observação: o endereço IP será diferente daquele mostrado 

na figura 24. 

 
Figura 24. Seu computador é representado pelo endereço IP listado na caixa de diálogo 

Deployment Progress e servirá de host para as shared variables na rede. 
 
Se a caixa de diálogo Deployment Progress, for exibida, mas desaparecer rapidamente, pode 
ser que a caixa de seleção Close on Successful Completion esteja selecionada.  Se for esse o 
caso, determine o endereço IP do seu computador digitando o comando ipconfig dentro do 
Windows Command Prompt localizado em Start » All Programs » Command Prompt. 
 

56. No tablet, digite o tipo de endereço IP do seu computador no campo New Server dentro 

da caixa de diálogo Shared Variables. 

57. Selecione o botão Connect para conectar-se ao host da shared variable no servidor. 

 
Figura 25. Cuide para digitar o endereço IP do seu computador exatamente da mesma forma 

como ele aparece na caixa de diálogo Deployment Progress do LabVIEW. 
 

58. Quando o aplicativo Data Dashboard for LabVIEW se conectar com sucesso ao host da 
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shared variable em seu computador, selecione a biblioteca da shared variable Fan 

Variables. 

59. Dentro da biblioteca da shared variable Fan Variables, selecione a variável Fan Vibration. 

O aplicativo filtrará automaticamente as variáveis disponíveis dentro da biblioteca para exibir 
apenas as variáveis cujo tipo de dados corresponde ao elemento do controle e indicador que 
você está tentando conectar com uma fonte de dados.  Mesmo que haja três variáveis 
implantadas em sua biblioteca da shared variable Fan Variables, apenas a variável Fan Vibration 
– um array de tipo de dados numérico – pode ser exibida no indicador Graph. 
 

60. A caixa de diálogo Shared Variables irá fechar e o Data Link Adorner do indicador Graph 

ficará na cor verde indicando uma conexão bem sucedida com uma fonte de dados, 

conforme ilustrado na figura 26. 

 
Figura 26. Quando um elemento da interface é conectado com sucesso a uma fonte de dados, 

o Data Link Adorner fica verde. 
 

61. Toque com seu dedo uma vez para selecionar o LED Indicator. 

62. Selecione o Data Link Adorner ( ) que aparece logo abaixo do LED Indicator. 

63. Na caixa diálogo Connect, selecione Shared Variables. 

64. Na caixa de diálogo Shared Variables, selecione o endereço IP do seu computador. 

65. Quando o aplicativo Data Dashboard for LabVIEW se conectar com sucesso ao host da 

shared variable em seu computador, selecione a biblioteca da shared variable Fan 

Variables. 

66. Dentro da biblioteca da shared variable Fan Variables', selecione a variável Alert. 

67. Selecione o botão Run Dashboard ( ) para iniciar o dashboard. 

68. Observe que não há dados sendo exibidos  – a aplicação Tablets não está em execução. 
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Parte C 

69. No computador, abra a aplicação do VI Tablets e selecione a seta de execução ( ) para 

testar as funções do VI.  Quando a caixa de diálogo Deploy Progress aparecer, selecione 

Close. 

70. Observe que enquanto a aplicação está sendo executada, os dados aparecem com 

sucesso no tablet. 

71. Enquanto o VI estiver em execução, ajuste a velocidade da ventoinha usando 'Dial' do 

controle de velocidade da ventoinha do hardware Sound and Vibration Signal Simulator. 

72. Observe que enquanto a ventoinha está oscilando em baixa velocidade o LED Alert está 

desligado.  Quando a ventoinha está oscilando em altas velocidades, o valor do RMS 

calculado excede o valor limite configurado (0.015) e liga o LED Alert, conforme ilustrado 

na figura 27.  

 
Figura 27. Quando a ventoinha está oscilando a um RPM alto, o sinal exibe um padrão visível e 

o LED Alert é ligado. 
 

73. Pressione o botão Stop ( ) para parar a execução do dashboard.    

74. No computador, use o mouse para selecionar o botão Stop do painel frontal para parar a 

execução do VI.  

75. Na janela do painel frontal, selecione File » Save All.  Deixe o VI e o aplicativo Data 

Dashboard for LabVIEW abertos  - você precisará dos dois para a próxima parte do 

exercício. 

O aplicativo Data Dashboard for LabVIEW apresenta muitas oportunidades adicionais para 

customização.  Se você quiser explorar o aplicativo, fique à vontade para tentar customizar 

coisas como a aparência e layout do dashboard ou temas e propriedades do indicador. 
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Como usar um tablet para controlar remotamente um sistema de medição 
Tempo estimado: 10 minutos 
 
Neste exercício, você aumentará sua aplicação para usar o tablet para controle remoto do 
sistema de aquisição de dados.  Embora esse exercício tenha sido escrito usando imagens 
tiradas de um iPad, a funcionalidade será a mesma com um tablet Android.  No entanto, as 
aplicações parecerão visualmente diferentes devido às diferenças nos temas e controles 
nativos entre os sistemas operacionais iOS e Android. 
 
Esse exercício presume que seu tablet já esteja operando o aplicativo Data Dashboard for 
LabVIEW, versão 2.2 ou mais recente.  Se não estiver instalado ainda, faça o download 
gratuitamente na App Store do iOS ou no Google Play.   
 

1. Para começar essa parte do exercício, verifique se o projeto Tablets.lvproj ainda está 

aberto.  Se não estiver, localize e abra-o a partir do disco no diretório C:\Seminars\LV 

HO\Exercises\8 – Tablets.  

2. Alterne para a janela Project Explorer do Tablets.lvproj usando o mouse. 

3. Organize as janela do diagrama de blocos e do Project Explorer do LabVIEW para que 

você possa ver as duas janelas na tela ao mesmo tempo.   

4. Dentro da janela Project Explorer do projeto Tablets, clique com o botão esquerdo e 

arraste a variável Fan Speed e solte-a no diagrama de blocos abaixo do DAQ Assistant2 

dentro do loop While. 

 
Figura 28. Arraste e solte a variável Alert no diagrama de blocos. 

 
5. Clique com o botão direito no diagrama de blocos para acessar a paleta Functions e 

selecione Measurement I/O » NI-DAQmx » DAQ Assistant. 

6. Clique com o botão esquerdo para colocar o DAQ Assistant3 no canto direito superior 

dentro do loop While, à direita do terminal da shared variable Fan Speed. 

7. Quando a caixa de diálogo 'Create New…' aparecer, selecione Generate Signals » Analog 
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Output » Voltage. 

8. Selecione o canal físico ao1 do módulo Voltage_out (NI 9263) e selecione Finish.   

Esse canal é conectado fisicamente ao BNC de controle de velocidade da ventoinha do 

hardware Sound and Vibration Signal Simulator dentro da demo box de medição do 

CompactDAQ. 

9. Dentro da janela de configuração DAQ Assistant, altere o Timing Settings Generation 

Mode para 1 Sample (On Demand) e selecione OK para fechar a caixa de diálogo. 

10. Clique com o botão esquerdo no terminal da shared variable Fan Speed.  Clique com o 

botão esquerdo novamente na entrada do VI Expresso DAQ Assistant3 para conectar os 

dados da shared variable à entrada analógica para controlar a velocidade da ventoinha. 

11. Agora o diagrama de blocos deve se assemelhar a imagem abaixo: 

 
Figura 29. Diagrama de blocos finalizado para o projeto Tablets. 

12. Dentro das janelas do diagrama de blocos e do Project Explorer, selecione File » Save 

All. 

13. No tablet iPad ou Android, alterne para o aplicativo Data Dashboard for LabVIEW. 

14. Na barra de menu no canto superior direito do dashboard 'Untitled 1', selecione o botão 

Controls and Indicators para adicionar um novo elemento da interface ao dashboard. 

15. Na caixa de diálogo Controls and Indicators, selecione Controls. 

16. Na caixa de diálogo Controls arraste e solte um Slider na parte inferior esquerda da tela 

em branco do dashboard. 

17. Usando as alças de redimensionamento no controle Slider, arraste para expandir o 

tamanho do Slider para que ele ocupe a metade inferior esquerda da parte em branco do 

dashboard. 

18. Agora seu dashboard deve se assemelhar à imagem abaixo: 
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Figura 30. Arraste, solte e redimensione um controle Slider no dashboard. 

19. Toque uma vez com seu dedo para selecionar o Slider Control. 

20. Selecione o botão Properties ( ). 

21. Altere a chave de duas posições Update While Dragging para a posição On. 

22. Selecione Data Range. 

23. Altere o valor Maximum  para 5. 

24. Selecione o Data Link Adorner ( ) que aparece logo abaixo do controle Slider. 

25. Na caixa diálogo Connect, selecione Shared Variables. 

26. Na caixa de diálogo Shared Variables, selecione o endereço IP do seu computador. 

27. Quando o aplicativo Data Dashboard for LabVIEW se conectar com sucesso ao host da 

shared variable em seu computador, selecione a biblioteca da shared variable Fan 

Variables. 

28. Dentro da biblioteca da shared variable Fan Variables, selecione a variável Fan Speed. 

29. Selecione o botão Run Dashboard ( ) para iniciar o dashboard. 

30. Observe que não há dados sendo exibidos  – a aplicação Tablets não está em execução. 

31. No computador, abra a aplicação do VI Tablets e selecione a seta de execução ( ) para 

testar as funções do VI.  Quando a caixa de diálogo Deploy Progress aparecer, selecione 

Close. 

32. Observe que enquanto a aplicação está sendo executada, os dados aparecem com 

sucesso no tablet. 



ni.com/daq  195 

33. Enquanto o VI estiver em execução, ajuste a velocidade da ventoinha usando 'Dial' do 

controle de velocidade da ventoinha do hardware Sound and Vibration Signal Simulator.  

Observe que o dashboard ainda exibe dados no indicador Graph e no indicador LED.   

34. Na demo box de medição do hardware CompactDAQ, verifique se a chave do controle 

Fan Speed no Sound and Vibration Signal Simulator está configurada para BNC. 

35. Usando o controle Slider no dashboard de dados, ajuste remotamente a velocidade da 

ventoinha.  Observe que a velocidade da ventoinha reage apropriadamente.   

36. Pressione o botão Stop ( ) para parar a execução do dashboard.    

37. No computador, use o mouse para selecionar o botão Stop do painel frontal para parar a 

execução do VI.  

38. Na janela do painel frontal, selecione File » Save All.  Feche o VI e o aplicativo Data 
Dashboard for LabVIEW.    

  
 

<Fim do exercício> 

  
 


